servicenow.

Australia Build workAows

Last updated: 04/07/2026

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Some examples and graphics depicted herein are provided for illustration only.
No real association or connection to ServiceNow products or services is intended or
should be inferred.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks
are trademarks and/or registered trademarks of ServiceNow, Inc., in
the United States and/or other countries. Other company and
product names may be trademarks of the respective companies

with which they are associated.

Please read the ServiceNow Website Terms of Use at
www.servicenow.com/terms-of-use.html

Company Headquarters
2225 Lawson Lane
Santa Clara, CA 95054
United States

(408) 501-8550

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


http://www.servicenow.com/terms-of-use.html
http://www.servicenow.com/terms-of-use.html

servicenow.

Table of Contents

Build workHows 5
WVOTKAOW SEUTIO.....ccuiueeiurieerietnieineneisisieiseasieasesessessssssssssssssssssssssssssssssssssssasessssssssssssssssssssssssssssssssssssssssssssssses 8
EXPIOT ..ttt ettt sttt sttt Rttt s et aeseeen 9
CONFIGUIE...eeiiererireeetsteses sttt ss st e s st st s st s s s st s st ss st st s as sttt as s s st asssssssssssssssasssssssssssssssasssssans 17
PlAYDOOKS.....ccueuriieeririieerisiecisistessisteesstssessasssss s sssssssssss s sssssssssssasssssssssssesssssssssssssssssssssassssssssssssssssssens 18
AGENLIC PlayDOOKS.......crieriririririneirieinesiseisiseisesessssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssses 275
Flows, SUDAOWS, @Nd @CHONS........ccoverivriririrerieinicinesieisesisessssesssssissssssssssssssssssssssssssssssssssssssssssses 287
DECISION EADIES......eeeitctecreste sttt st ssse s ssssssssassssssasssssasessssasssssassssassasans 1006
Building spokes USING SPOKE GENEIALOL.........cccurueeurenrererererneeereneesensesesseesseasessssesssensassssessssenes 1038
Classic approvals 1072
APPIOVAL ENGINES......ooieuririieerinieeinistsessisiesessistsessssssssssssstsssssssssssssssssssssssssssssssssssssssssssssssssssssssssssess 1073
APPIOVAI TUIES......eeeeeereecrccets ettt ssssssssss e s s s s sssssssssssesssesssesssssssassssssssssssssesssesssesesssssssasesesns 1074
Approval SUMMAriZEr FOTMALLEN.........cveeeeeeeeeteeeee ettt ssss s sss st sss s sstsas e sesassasesanes 1081
APProval Wilh ©-SIGNALUIE........cccciuieeeetrteeestrecstrteesstsess st stess s ssses st sssssssssssassssssssssssssssssanes 1084
APPIOVAL SEALUS......ceeeeieeeeeereicneeseeeeseeecneeseeessa s ssestessastsesssseseessssesessssestacssssesessssastacssssesenssseeacns 1089
Generate an approval using approval rules 1089
Generate approvals using the approvers related liSt..........cvvveeveninenerneeeneninesesiseeeenns 1089
Generate approvals using WOrkAOW HOWS..........cccovererinerineinensinesinssisinesisessseessssssssssssssssnes 1090
MUILIPIE @PPIOVETS.......ceoeeeeetrieicctetsesiessstssssssesss s ssses s sssssssssssssassstesssassesessssssesasssssssassesessssssasans 1090
RECEIVE NOLIAICALIONS.....cuceierieeiciricieriesecnecisestseasesssesssestessssssessssesstssssssssssssssssssssssssssssasenssses 1090
DyNamiC apProVal FOIMS.......c.ccceereeerencenireneesenessecisessesessessssasessssessssesssssssessssesesssnssssssesssssasssasesess 1091
Scripts and enNgiNes EXECULION OFUE.......c.ccirieeeirieenirisesiniseestsessssasesssesssssssssssessssssssssssssns 1092
ClaSSIC BUSINESS TUIES ...ttt sessissssssstssssstsssssssssssssssssssssssssssasssssssssssssssassssssses 1094
HOW DUSINESS TUIES WOTK....uieiirieiiericsesiestesectsesise st ssss s sssssssessessssssssssssssssssssssssssssssssens 1094
SCOPING...ciuieirireirieisissieasieistessesstssss st ssssssssasssssssasssssstsssssssssssssasssssssssassssasssssssnssssssssssssssssssssssssssases 1096
Create @ DUSINESS FUI........ceeeierirsecieniesectseeisesste st seasassasesssssssssssssssssssssssassssssssssssassosas 1097
GlODAI VAIADIES.......ueceeteecrecstrtec sttt sttt s st sass s sstsssssssssssssssssssssssssssssssssssssssases 1100
Controlling field values With DUSINESS FUIES...........occerrieririecrieesseseesseeasisseessassssssasses 1101
DiISPIAY FUIES.....eeeteeeeeciriectstteeistseess sttt sssssts s bt s s sssss sttt assssstssassstsssssssssssassssssassssssssaes 1102
Task Active State ManagemMENL...........enerineninesisesiesisasssssssssssssssssssssssssssssssssssssssssees 1103
EXQMPIE SCHIPLS....cuctiiectrieecetrieeetstessstssssstesssststessssssssssassetesassssessssssasesassssessssssasessssssesnssssasssssssasans 1103
SYSEEM EVENLES......oeiieteetteceeeeessissssistssssssssssstsssssssssesesesssssssssssssssssssssssssssssssssssssesesssssesssssssssssssssns 1108
EXPIOING SYSLEM @VENES.......cuieieeceicerenreetseeisesiseasee s aseasessssesessessssesssssssssssssasssasessssesessansssen 1109
CONFIGUING SYSEEM QVENLS......uviirrriecrireecresesstsesessasesessssssssssstssssssssssssssssssssssssssssssssssssssssssssens 1113
MaNaGING SYSEEM EVENES.......c.ieeriierrerirtecisitsessistee st sstssssssstssssstsssssssssssassssssassssees 115
SYSEEM EVENES FEFEIENCE......ceeieetrieetreeestsee sttt tsessstss st sassasssasssssssssssssstssasans 1120
SEIVICE CrEALON ...ttt sesstssssts st tssssssssstasssssssssssssssssssssssssssssassssssssssssnsssssssssssssssssssson 1125
SEIVICE CrEALOI PrOCESS ...ttt sssssassssssssastesssssssesssassesssassssessssssasssssssssaes 1126
ACLIVALE SEIVICE CrEALON.....ecuiteeeeerteeeertriesstrtseestsesssssstsss s tssssssssessssssssssssssstssssssssssssssssssasssssssssssases 1126

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

MANAGE @ SEIVICE.....cuceieeeireciririeseeaseeeseusesesseesseastssssts st sstasessssessssesssssssssssssasssasssssstasssassssasessssen 1133
ClASSIC WOTKHAOW. ...ttt ssssssssssssssssssssssssssssssssssssssssssssssssessssssssssssssssssssssssssssssss 1139
Getting started With WOIKAOWS.........ccoiiririecritcrinecrtseestseesaseseesssstssesstssssssssssssssssssssaes 1140
WOTKHOW ©QIEON......uieeieirieisieirisiesieisesinessseessssssssssssssssissssssssssssssssssssssssssssssssssssssssssssssssssssssssssssees 1143
WOIKAOW MaNAGEMENLE......iiiiicrireeerteeereeeeeseeeastseeassseseesstseessssassassstssssasssassassssssasssssssassns 1155
VVOIKAOW CONCEPLES.....cuoeriririiiiiiieteeeseneesesesssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssssseses 1229
WOrkAOW adminNiSEratioN........ccvueieeierieierreesiristesstes st sss e sssssssssssssssssssssssssssssssssssssssssssssanes 1238
TroUDIESNOOL WOTKFAOWS.......ccuivriieeririciciniseesiseeetsissseasisssessssesessssssssesssssssssssssssssssssssssssssssssssssssssns 1268
Use the Workflow Operations Dashboard 1270
Workflow performance HMING.........cccocvenerinenineinisineninsnisissssssssssessesssssssssssssssssssssssssssssssssssses 1272
WOTKHOW @CHIVILIES.....ouciierieerieirecireisieisisisesisesteesesssessssessssssssssssssssssssssssssssssssssssssssssssssssssssssssssssnses 1273

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

iv



servicenow.

Build workAows

Transform manual tasks and mundane work into digital workflows. Modernize legacy processes
with automation. Enable app development at all levels — no-code, low-code, and pro-code —
from one platform.

Get started

Increase the impact of your cross-enterprise workflows by automating manual processes.
Transform business performance with automation. Optimize process efficiency and make work
Aow seamlessly.

WorkFfow Studio WorkHow Studio Alows WorkFfow Studio

playbooks
-0 0-+O
~0 o g 0

Access workflow Build multi-step Aows from
applications from reusable components Author cross-enterprise
a single interface. without having to code. workflows and create a
single, unified process.
WorkFfow Studio WorkFfow Studio Service Creator
playbook experience decision tables
S~ :.
\
Enables a department
Interact with a business Decouple decision logic to offer custom services
workfow in real time from code by creating and through the service catalog
from within Workspace. maintaining decision rules.
Workfow Studio

The ServiceNow® WorkFow Studio application provides a single location to access all process
automation applications.

WorkfAow Studio Aows

ServiceNow Workflow Studio flows are a ServiceNow Al Platform® feature that enables process
owners to automate work. Create end-to-end digital workflows. Automate any process—from
simple productivity to complex transformation—in a no-code, environment.
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WorkfAow Studio playbooks

ServiceNow® Workfow Studio playbooks enable process owners to author cross-enterprise
workAows and create a single, unified process. Build and manage multiple complex workflows
easily with no-code playbooks and the enterprise application development platform.

WorkAow Studio decision tables

Workfow Studio decision tables provides an intuitive interface to create and manage decision
tables, which store sets of decision rules. Decision tables in Decision Builder embed business
logic into a series of if-then decision rules. Decision tables read data from inputs. When all the
conditions for a decision rule are met, the decision table returns one or more results. Decision
Builder enables developers to decouple decision logic from the code base.

Playbook experience

Visualize complex processes in a simple and familiar task-oriented view built specifically for
agents. Agents can use Playbook to update records, upload attachments, and complete tasks
across multiple workflow activities.

Service Catalog item designer

The Service Catalog item designer enables non-administrators to create, maintain, and publish
catalog items. It uses a structured design and publishing process to ensure consistency of
usage.

Service Creator

Service creator enables a department to offer custom services through the service catalog, such
as the HR department offering tuition reimbursement for further education.

Classic workAow builder tools

The ServiceNow Al Platform supports these classic workflow builder tools.
Classic Approvals

Classic approvals are a legacy process to require authorization on tasks before
the work is done. In earlier releases, you could create approval records to define
approval tasks and associate users or groups to approve or reject them. You can
replace classic approvals with Workflow Studio flows or classic workflows.

Classic Business Rules @

A business rule is a server-side script that runs when a record is displayed, inserted,
updated, or deleted, or when a table is queried. You can replace classic business
rules with Workflow Studio Aows.

Classic Events

Events are special records that the system uses to log when certain conditions
occur and to take some kind of action in response to the conditions. You can
replace classic events with Workfow Studio flows or Playbooks processes.

Classic WorkHow

Workfow is a legacy application that provided a drag-and-drop interface for
automating multi-step processes across the platform. Each workflow consists of

a sequence of activities, such as generating records, notifying users of pending
approvals, or running scripts. The graphical Workflow Editor represents workflows
visually as a type of flowchart. It shows activities as boxes labeled with information
about that activity and transitions from one activity to the next as lines connecting
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the boxes. You can replace classic workfows with Workflow Studio flows or
Playbooks processes.

Applications and features
Workfow Studio

Integrate workflow authoring, configuring, and monitoring into a single page
experience. Consolidate Playbooks, Workflow Studio, Workflow Studio, Integration
Hub integrations, and Decision Builder into one design environment.

Workfow Studio playbooks

Playbook enable process owners to author cross-enterprise workflows and create a
single, unified process. Build the underlying processes for playbooks that Playbook
Experience agents and fulfillers use.

WorkHow Studio Aows

Flows automate a repeatable multi-step process. When the flow trigger conditions
are met, the flow runs a sequence of reusable actions and Aow logic to complete the
process.

Workfow Studio actions

Actions automate a repeatable task or operation within a flow. Flows run actions by
passing them data as inputs. Actions run a sequence of steps to complete the task,
and pass data to the Aow as outputs.

Workfow Studio decision tables

Workfow Studio decision tables enable developers to decouple decision logic from
their code by creating and maintaining decision rules.

Playbook experience

Interact with a business workflow in real time from within Workspace. Agents can
use Playbook to update records, upload attachments, and complete tasks across
multiple workflow activities.

Service Creator

Service creator enables a department to offer custom services through the service
catalog, such as the HR department offering tuition reimbursement for further
education.

Classic Approvals

Classic approvals are a legacy process to require authorization on tasks before
the work is done. In earlier releases, you could create approval records to define
approval tasks and associate users or groups to approve or reject them.

Classic Business Rules @

A business rule is a server-side script that runs when a record is displayed, inserted,
updated, or deleted, or when a table is queried.

Classic Events

Events are special records that the system uses to log when certain conditions
occur and to take some kind of action in response to the conditions.

Classic WorkfAow

Workflow is a legacy application that provided a drag-and-drop interface for
automating multi-step processes across the platform. Each workflow consists of

a sequence of activities, such as generating records, notifying users of pending
approvals, or running scripts. The graphical Workflow Editor represents workflows
visually as a type of flowchart. It shows activities as boxes labeled with information
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about that activity and transitions from one activity to the next as lines connecting
the boxes.

Related ServiceNow applications and features

App Engine Studio &

ServiceNow® App Engine Studio (AES) is a development tool for creators of varying
skill levels to build applications that meet the immediate needs of your organization.

Zero Copy Connector for ERP &

Work with remote tables in the ERP system of record, such as SAP, as well as APIs
and ETLs, to create ERP data models to use as data sources for ServiceNow Al
Platform applications.

ERP Customization Mining &

Identify ERP customization apps that are candidates to migrate to the ServiceNow
Al Platform. Use the ServiceNow Al Platform to build applications and features to
automate ERP processes and workflows.

Integration Hub &

Automate integration tasks using ServiceNow components for ServiceNow®

Workfow Studio, or develop custom integrations. A separate subscription is
required.

Integration Hub available spokes &

Activate spokes to enhance your Workflow Studio experience with integration-
specific content. Use prebuilt flows and actions to automate your integrations or
create your own integration automation.

MID Server &

The Management, Instrumentation, and Discovery (MID) Server is a Java application
that runs as a Windows service or UNIX daemon on a server in your local network.
The ServiceNow® MID Server enables communication and the movement of data
between a ServiceNow instance and external applications, data sources, and
services.

Robotic Process Automation (RPA) Hub &

Use the ServiceNow® Robotic Process Automation (RPA) Hub to enable end-
to-end automation for your organization. With a combination of Ul interactions,
element-based automations, and APlIs that interact between the various business
applications, you can emulate user actions and eliminate mundane and repetitive
human activities.

Virtual Agent Designer &

The Virtual Agent Designer is a diagram tool for creating and managing topics,
which are blueprints for conversations between a virtual agent and user. You can
design topics that help your users resolve common work issues or guide them
through self-service tasks.

WorkAow Studio

Integrate workflow authoring, configuring, and monitoring into a single page experience.
Consolidate playbooks, flows, actions, decision tables, and integrations into one design
environment.
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Get started
Explore Configure
Learn about Workflow Studio Configure workflow builders

concepts and features

Flows, subflows, and actions Playbooks

0O
(o)

Use flows to automate Use Playbooks to automate, streamline,
repeatable multi-step processes and standardize complex processes
Flow Assist Playbook Assist
Generate flows from text prompts Generate Playbooks and playbook

or images using Now Assist recommendations using Now Assist
a a

Troubleshoot and get help

« Workfow Automation product on the ServiceNow Community &
e Search the Known Error Portal for known error articles &

« Contact Customer Service and Support &

Exploring WorkAow Studio

Work with playbooks, flows, subfows, actions, data streams, and decision tables from a single
consolidated interface. See operational details of your workflow applications and configure
integration connections and credentials.

Homepage

The Workflow Studio homepage displays all the workflow applications available for authoring and
editing.
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Sample Workflow Studio homepage

© Workflow Studio +

2]

1

# Homepage

I Operations

& Integrations

=

5]

Playbooks Flows Subflows Triggers Actions Decision tables Pick up where you left off
Playbooks 3 o \QH@H@HY | C') My action
Last refreshed 2m ago Last updated: 20 min. ago by System Admi
[ Label Application Status Active Updated Updated by %—. My subflow
Last updated: 22 min. ago by System Admi
My Process Global Draft true 2023-11-20 09:13:56 admin
Incident Management for Service . .
Remediate device Operations Workspace Published true 2023-03-20 22:30:26 admin 33z My Pro:es.s
=% Lastupdated: 1h. ago by System Administr.
Remediate server Incident Management for Service Published true 2023-03-20 22:30:40 admin
Operations Werkspace
Latest updates
Showing 1-3 of 3 1 20~ rows per page 2 System Administrator modified My
action
20 min. ago

2 System Administrator modified My
" subflow
22 min. ago

)

System Administrator modified My
Process
1h. ago

System Administrator modified My
flow
244.ag0

)

<

System Administrator modified IP
Address Range Binding Policy
2 months ago

Resources o

@ Product Documentation
® ServiceNow Videos

s Community

= Centre of Excellence

i Developer Portal

The Workflow Studio homepage consists of these elements.
1. Homepage

Use the homepage to create and view workfows. You can see a list of workflows by
type, a list of workflows you last worked on, a list of recent workflow updates, and a
list of information resources.

2. Workflow types

Select a workflow type to see a list of available items you can edit. Options include
playbooks, lows, subflows, actions, data stream actions, and decision tables.

3. Create a workHow

Select a workflow component to create. Options include playbooks, Alows, subflows,
actions, data stream actions, and decision tables.

4. Current workfow list

See the list of workflow items available to edit. Each list shows the total number
of workflow items available, a set of list controls, and a separate list row for each
workflow item. List options include refresh list, list actions, copy URL, show filter
panel, and delete.

5. Pick up where you left off

See the list of workflow items that the current user last worked on. Quickly resume
working on a workflow item.

6. Latest updates

See the list of workflow items that have most recently been added or updated. See
who worked on an item and when the updates were made.

7. Resources

Learn more about Workflow Studio and its related workfow applications. Resources
include links to the product documentation, ServiceNow videos, the ServiceNow
Community site, the Centre of Excellence site, and the Developer Portal.
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Operations

The Workflow Studio operations page displays a usage dashboard and execution details for the
workflow components that are currently running and have completed running.

Sample Workflow Studio operations page

O Workflow Studio + @

M Homepage  lOperations & Integrations

Playbooks Flows e

~ Dashboards
Usage dashboard @ Playbook usage

~ Monitoring
Most executed playbooks (this month) s Playbook executions by state (this month)
All Executions
Today's executions
Active playbooks

30+ day playbooks COMPLETE &
v Setup

Activity definitions s

Trigger definitions

Data definitions

Playbook actions

Stage actions

Activity actions
> Activity Uls

Uls

Layouts

The Workflow Studio operations page consists of these elements.

8. Operations
Use the operations page to see dashboards and execution details by workflow type.
9. Workflow types

Select a workfow type to see available dashboards and execution details. Options
include playbooks and flows.

10. Dashboards, Monitoring, and Setup

Select a dashboard to see operational charts such as most executed playbooks
and playbook executions by state. Only users with the admin role can view an
operations dashboard. Select a monitoring option to see execution details. Select a
setup option to see settings and properties.

Integrations

The Workflow Studio integrations page displays connection details for Integration Hub spokes.
You can use this page to configure inbound and outbound spoke connections.
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Sample Workflow Studio integrations page

© Workflow Studio +

(2]

Connections

Spokes

@ AES Catalog Builder
Scope: sn_aes_cat_builder
@ AES Portal Ul Template
Scepe: sn_portal_starte_0
@ Benchmarks Spoke
Scope: sn_bm_spoke

Connect Spoke
Scape: sn_cannect_ah

@ Flow Templates for Access Ma...
Scape: sn_ft_app_access

@ Flow Templates for Document...
Scope: sn_document_mgmt

11

(yHomepage  k4Operations & Integrations

@ AES Decision Table Builder Te...
Scope: sn_dtbl_bldr_tmpls

@ AES Workspace Ul Template
Scope: sn_works| 3.0

@ Collaboration Request
Scope: sn_collab_requast

@ Continuous Integration and C...
Scope: sn_cicd spoke

@ Flow Templates for Cloud Serv...
Scope: sn_ft_cloud_mgmt

@ Flow Templates for HR Manag...
Scope: sn_ft_for_hr

@ App Engine Studio
Stope: sn_app_eng_studio

Collaboration Services for Ser...
Seop lab

@ Deployment Pipeline
Scope: sn_deploy_pipeline

Flow Templates for CRM

@ Flow Templates for Integratio...
Scope: sn_ft_enterprise

The Workflow Studio integrations page consists of these elements.

11. Integrations

co

New Spoke

AES Mobile Templates
Scope: sn_aes_mobile

Application Intake

Scope: sn_app_intake

Common Guidances
Scope: sn_guidances

Docker Spoke
Scope: sn_docker spoke

Flow Templates for DevOps
Scope: sn_ft_devops

Flow Templates for Notificati...
Scope: sn_ft_inc_ws_notif

1 to240f4s > PP

Use the integrations page to add, configure, or view available connections.

12. Integration types

See a list of available and configured spokes and connections. Configure or create
a spoke to integrate data. Use the connection card to configure a connection or
review its details.
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Create button

Create button and options menu

¢ Playbook
i Flow
L Subflow

X Trigger
88 Spoke
88 Action

B3 Decision table

Beginning with the Xanadu release, you can create new workfow items from any Workfow Studio
page rather than just the Homepage. Use the Create button on the tab header to display a list of
available workflow components.

 Playbook
 Flow

» Subfiow

« Action

« Data Stream

« Decision table

Choosing between playbooks and flows

Flows, subfows, and actions are the basic building blocks of a process automation. Playbooks
are built on Aows, subflows, and actions, and come with a set of out-of-the-box activities driven
by subflows that are already built. If you're trying to decide whether your automation should be a
playbook rather than just a flow, start by determining if your low needs user interaction.

« If your process automation requires user interaction, does it need manual user interaction?
Examples of manual user interactions are a user reading a knowledge base article, going
through a checklist, and gathering feedback.

o Ifyes, use a playbook.
o If no, does your process automation have several user interactions? Examples of user

interaction are changing record field values such as changing the incident state or adding
task work notes.
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» [fyes, consider using a playbook for a better user experience.
* |f no, use a flow. Flows use less data storage in your instance.
« If your process automation doesn't require user interaction, is it a sequence of subflow calls?
o Ifyes, is it hard to manage or difficult to view the Aow?

= |f yes, consider using a playbook for a better user experience. Stages in playbooks are
easier to view and also have additional configuration options.

* |f no, use a low. Flows use less data storage in your instance.

o If your process automation does not require any user interaction, keep it as a flow. Flows use
less data storage in your instance.

@ Note: You can also use flows that trigger a playbook just for interactive steps.
If you're trying to determine if a playbook should be a flow instead, start by determining whether
your playbook is triggered 10s, 100s, or even 1000s of times per second.

« If your playbook is triggered 10s, 100s, or 1000s of times per second, are there any user
interactions?

o If yes, do the user interactions happen during every single run?

= [fyes, use a playbook. Playbooks offer visibility into where you're at in a process,
particularly business processes with manual user steps.

* [f no, create a flow that triggers a playbook for the user interactions.
o If no, use a flow. Flows use less data storage in your instance.

« If your playbook is not triggered very often, keep it as a playbook. Playbooks offer visibility into
where you're at in a process, particularly business processes with manual user steps.

You can reference decision tables in flows, subflows, actions, and playbooks. Data streams are
not used in flows, subfows, actions, playbooks, or decision tables. To learn more about data
streams, see Data Stream actions and pagination &.

Differences from previous releases

Workfow Studio combines playbooks, flows, subflows, actions, decision tables, and Integration
Hub integrations into a single builder application. Each of the prior workflow applications retain
their functionality and their user interface to create and edit workflow objects. Workfow Studio
introduces these changes.

Access WorkFfow Studio from duplicate menu items

Workflow Studio uses the existing menu items for the separate workflow builder
applications to open the corresponding workflow object type. For example,
selecting the Process Automation Designer menu item opens the playbooks list
from the Workfow Studio homepage.

Configure integration connections

Workflow Studio enables you to configure integrations in the same user interface as
you build integration components. For example, you can create a data stream action
and also define its connection details.

Create workflow components from any page

Beginning with the Xanadu release, Workflow Studio allows you to create a workflow
component from any page rather than just the Homepage.

Display each workfow type in a separate tab
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Workfow Studio displays each workflow object type in its own tab. For example,
playbooks open in a playbook tab and flows open in a flow tab.

Edit different workAow types simultaneously

Workfow Studio combines all workflow object types into a single user interface. You
can work on related workflow objects simultaneously rather than switch between
separate workflow builder applications. For example you can create a flow that
includes the Make a decision flow logic and also create the decision table used by
that decision.

Set application specific settings from the existing property pages

Workfow Studio relies on the existing system properties pages to add and configure
setting for each workflow application. For example, open the flows properties page
to configure the behavior of flows, subflows, and actions.

View all available execution details

Workfow Studio contains execution details for all workflow object types. You no
longer have to switch between applications to see execution details for a particular
object type.

Getting started with process automation

®

Learn how process automation applications can help you use the ServiceNow Al Platform™ to

transform your manual business processes into digitized, automated workflows.

ServiceNow process automation applications help you digitize, visualize, and manage the
cross-enterprise workflows for your business. Digitizing your business processes with process
automation applications gives you these benefits:

« Management of process compliance
« Ownership of continual process improvement
« Collaboration across divisions and departments

« Visibility into process outcomes

Process automation applications
The ServiceNow process automation applications that you can use to digitize your business
processes into automated workfiows on the ServiceNow Al Platform include:

Flows

Flows enables process owners to automate approvals, tasks, notifications, and
record operations without having to code.

Playbooks

Playbook enable process owners to author cross-enterprise workflows and create a
single, unified process. Build the underlying processes for playbooks that Playbook
Experience agents and fulfillers use.

Roles involved in process automation

Depending on the process automation application that you use, you may need to coordinate with
other teams or individuals to ensure that your automated processes run smoothly. One possible
way in which you could organize the roles for process automation applications is:
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« A developer uses Workfow Studio to work on flows, actions, and activity definitions to
automate individual pieces of a business process.

« A playbook owner uses Playbooks to organize the pieces of the business process into a
digitized, cross-enterprise workflow.

« A Playbook Experience administrator configures the appropriate views of the business process
for the right system users in playbooks.

« A Playbook Experience agent, the end user in this case, works on and manages the individual
tasks of the business process in playbooks on the ServiceNow Al Platform.

Userroles

Developer Process Owner Workspace Admin Agent
Flow Designer Process Automation Designer Playbook Experience Agent Experience

Flow, actions, Activities shown in

’ " Processes Playbooks
m and activity definitions playbook cards
PP o Organize the pieces of the Configure the appropriate Complete individual tasks
In order to i business process into views of the business
the business process within the business process
a cross-enterprise workflow process for the right users

Many different user roles are involved in creating effective digitized, automated processes on the
ServiceNow Al Platform.

Learn more about process automation
To find out more about how you can use Workflow Studio and Playbooks to digitize your business
processes, try checking out these resources:

« Flow Designer fundamentals course &

» Exploring flows

« Building your first playbook

When to use Alows and Playbook

Use these general guidelines to determine when to create a flow or a playbook.

When to use Aows

Flows, subfows, and actions are the basic building blocks of process automation. Flows run
when their trigger conditions are met, and each flow in turn runs a sequence of actions, flow
logic, and subfows. The actions, flow logic, and subflows within a flow are what create and
update data.

A flow is a good fit for process automations that met these criteria.
Expect few to no manual user interactions

As long as a flow has the input data it needs, it can run to completion without any
user interaction. Some flow logic and actions require users to make record changes,
but a low can automatically pause until its wait conditions are met. Process
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automations that depend on user interactions such as reading a knowledge base
article, going through a checklist, and gathering feedback are harder to manage
with flows. Flows don't directly provide any Ul elements for users to interact with.
Flows depend on users knowing how to find an existing Ul and making any needed
changes. For example, a record-based flow depends on a user making a change in
a specific record such as a case or an incident.

Expect to run at high volumes

An instance can run hundreds to thousands of flows per second. With flow reporting
being disabled by default, an instance can run a high volume of flows before it sees
any performance impact. If you expect to run a process automation at high volumes,

a flow is a good fit over a playbook because it requires less overhead and system
resources.

Expect to run few to no subflows

The more subflows a flow calls, the more difficult it becomes to manage from the
flows interface. While you can use conditional low logic or a decision table to

choose a subflow to run, playbooks offer a better user experience for running a
sequence of subflows.

When to use Playbook

Playbook are built on activities, which use prebuilt lows, subflows, and actions as their building
blocks.
A playbook is a good fit for process automations that met these criteria.

Expect several manual user interactions

Playbooks provide Ul elements for users to interact with. The playbook experience
guides users to make any changes required to advance the playbook.

Expect to run at low volumes

Playbooks require more system resources to run because they generate Ul
elements and store more execution details.

Expect to run many subflows

Playbooks offer a better user experience for running a sequence of subflows.

Configuring Workfow Studio
Enable access to Workflow Studio and allow management of workflow applications.

The Workflow Studio application is a ServiceNow Al Platform feature that is active by default, and
that is also available for installation and update from the ServiceNow Store.

Each workflow application within Workflow Studio has its own installation and subscription
requirements.

Playbooks

Playbooks are included with Workflow Studio, which is a ServiceNow Al Platform
feature that is active by default, and that is available for installation and update from
the ServiceNow Store. However, you can only trigger playbooks off of platform and

application tables that you have access to. For activation information, see Activate
Playbooks.

Flows and subfows

Flows and subflows are included with Workflow Studio, which is a ServiceNow Al
Platform feature that is active by default, and that is available for installation and

update from the ServiceNow Store.
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Actions

Actions are included with Workflow Studio, which is a ServiceNow Al Platform
feature that is active by default, and that is available for installation and update from
the ServiceNow Store.

Data stream actions

Data stream actions require a separate subscription to Integration Hub. For
activation information, see Request Integration Hub &.

Decision Builder

Decision Builder is a ServiceNow Al Platform feature that is available for installation
and update from the ServiceNow Store. For installation and update information, see
Configuring decision tables.

Update to the latest version of WorkAow Studio

Workflow Studio is automatically installed on your instance. However, Workflow Studio is a
ServiceNow Store application, so to get the latest features, you must update your version
manually to the most recent version.

Before you begin
Role required: admin

About this task
Workfow Studio displays an information banner when a new version is available.

New version available information banner

@ New version available: Upgrade to get the latest Workflow Studio features. Learn more X

Updating Workflow Studio automatically updates all of its application dependencies such as
Flow Designer, Playbook, and Decision Builder.

You can also find and update each individual Workfow Studio application dependency from the
ServiceNow® Store or the list of plugins.

Procedure
1. Navigate to All > System Applications > All Available Applications > All.

2, Search for the Workfow Studio application using the search bar.
Check the Updates and Installed tabs to locate Workflow Studio (app id: sn_workflow_studio).

3. Select Workfow Studio.
4, Using the version list on the right, select the latest version of Workflow Studio.
5. Select Update.

WorkHow Studio playbooks

Workfow Studio playbooks streamline and standardize complex processes. Automate tasks,
ensure consistency, and enhance operational efficiency across your organization with intuitive,
low-code workflows.
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Get started
Explore Configure
Learn about playbooks Learn how to configure playbooks
Use Reference
(0] o)
Use playbooks Gelt details
Exploring Playbook

Playbook enable process owners to author cross-enterprise workflows and create a single,
unified process. Build the underlying processes for playbooks that Playbook Experience agents
and fulfillers use.

Playbooks benefits

Workflow Studio Playbooks enables you, as a business playbook owner, to organize Workflow
Studio content into unified and digitized cross-enterprise processes. With Playbooks, you gain
these benefits:

» Connect multiple Aows and actions into an end-to-end business workflow.
« Reuse existing Workflow Studio flows, subflows, or actions to automate playbook activities.
« Organize playbook activities in a digitized task board or diagram interface.

« Guide agents and fulfillers through complicated playbooks from start to finish, improving
customer experience and task resolution. Build your playbooks in Workfilow Studio, and then
design and embed your Playbook Experience in legacy workspace, Ul Builder, ServiceNow
Mobile Platform, Service Portal, and more.

« Consolidate separate business processes across the organization.

« Define a consistent record life cycle from creation to completion.

« Pass data between the activities and stages of a business process.

« Specify the conditions and the order in which activities and stages run.

« Visualize and manage the activities and stages of your process.

Creating a well-designed playbook

The automated business processes that you design guide your end users and help them focus
on the tasks and information that matter to them. A well-designed playbook can do these things:
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« Start up, or trigger, automatically for the types of records that your end users care about
 Reuse activities from existing Workflow Studio content
« Has well-defined stages that end users can follow for a record

« Clearly show the next steps that end users must take to move through a record's life cycle

Playbooks content
Playbooks has these components:

Playbooks

A playbook is a ServiceNow Al Platform® representation of a cross-enterprise
business process for your organization. A playbook owner is responsible for
creating and maintaining a playbook.

Triggers
A trigger specifies when to start running your playbook.
Stages

A stage is a grouped sequence of activities in a playbook. A playbook owner creates
a stage to specify a logical grouping of activities. A stage in your overall business
process.

Activities

An activity defines the Workflow Studio content that powers the playbook's
automation. An activity can also specify the user-facing experience that the
playbook produces when it runs.

For more information about how to use and navigate the Playbooks user interface, see Playbook
builder.

Playbook Experience

Guide agents and fulfillers through complicated playbooks from start to finish, improving
customer experience and task resolution. Build your playbooks in Workflow Studio, and then
design and embed your Playbook Experience in legacy workspace, Ul Builder, ServiceNow
Mobile Platform, Service Portal, and more.

To learn about designing Playbook Experience, see Designing Playbook Experience.

Getting started

Before you get started with Playbooks, familiarize yourself with any features that your business
uses to automate operations on the ServiceNow Al Platform, such as flows, subflows, and
actions.

If you're a playbook owner who wants to learn the basics of digitizing your business process,
check out the following resources:

- Get started with ServiceNow® Process Automation
« Gelt started with Playbooks

« Design your first automated process

« View your process executions

If you're a ServiceNow Process Automation administrator who wants to set up and customize
Playbooks, check out the following resources:
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« Triggers

« Activity definitions

Playbook across ServiceNow Al Platform®

Playbook capabilities are available in other ServiceNow® products and for specific industries.
You get the Playbook content when you subscribe to the ServiceNow Al Platform®.

To learn about activating Playbook other applications, see Activate Playbooks.

Integration

App Engine Studio &

Creator Studio &

Configure Playbooks for Customer Service
Management &

Field Service Management &

HR Service Delivery Playbook &

Software Asset Management Guided Experiences @

Healthcare and Life Sciences &

Playbooks for Financial Services Operations
applications &

Playbooks for Public Sector Digital Services &

Run actions to resolve alert issues in Service
Operations Workspace for ITOM &

Account onboarding &

Onboard Jira to DevOps Change Velocity —
Workspace &

Security Incident Response playbooks &

Working with Sourcing and Procurement Operations
playbooks in the Source-to-Pay Workspace &

Complete publishing checklist and request policy
approval &

Content available

Build playbooks from App Engine
Studio.

Create basic request and fulfillment
apps without code.

Create playbooks for Customer
Service Management.

Create playbooks for Field Service
Management.

Create playbooks for HR services.

Create playbooks for Software Asset
Management.

Create playbooks for Healthcare and
Life Science processes.

Create playbooks for Financial
Services Operations.

Create playbooks for Public Sector
Digital Services.

Create playbooks for IT Operations
Management.

Create playbooks for Account
Lifecycle Events.

Create playbooks for IT Service
Management.

Create playbooks for Security
Operations.

Create playbooks for Procurement
Service Management.

Create playbooks for Governance,
Risk, and Compliance processes.

Playbook builder

Playbooks is a component in Workflow Studio. Workflow Studio gives you a streamlined way to
author, configure, and monitor playbooks, flows, subflows, actions, and decision tables in one

place.
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WorkfAow Studio landing page

You can view the Workflow Studio landing page by navigating to Process Automation >
WorkHow Studio. The landing page opens to Playbooks by default, but you can easily navigate
to lows, subflows, actions, and decision tables. For more information on Workflow Studio, see
Workfow Studio.

Playbooks builder

The builder for Playbooks consists of the main header, design space, and side panel.
Main header

The main header displays information about the playbook that you're currently
designing. In the main header, you can:

« See the status and activation state of your playbook.
« Toggle between Diagram and Board view.

« Undo or redo your actions.

« See and navigate to your errors via the error tray.

« Turn Optional activities on or off.

« Test and activate your playbook so that it runs as expected when triggered. You
can also preview the Playbook Experience during testing. For more information,
see Playbook statuses and activation states.

« In the More actions menu, you can also deactivate or duplicate your playbook.

« Also in the More actions menu, access the properties of your playbook. You
can add or edit the name or description for your playbook, enable playbooks to
restart, and edit the behavior of your trigger.

Design space
Build your Playbook in either Diagram or Board view. You can perform most of the
same functions in either view.

Note: Decision activities are not available in Board view, and Optional
activities are not available in Diagram view.

Organize activities into stages to design your playbook.

« An activity represents one step within your overall business process. An activity
can automate operations on the ServiceNow Al Platform, such as creating or
updating records, displaying record information, and running automated actions
in the background.

» Organize a set of activities into stages within your business process.

For more information, see Stages and activities.
Side panel

The side panel lets you configure your activities, and stages. In the side panel, you
can:

« Add or edit the name and description for your stage or activity.
« Define the start rule for your stage or activity.
« Define what your activity or stage does when restarted.
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« Add or edit the inputs for your activity.
« Define additional properties for how your activity renders during runtime.

« Define if and how an Al agent performs the activity.
For more information on creating a playbook, see Building your first playbook.

Playbook builder components
Playbooks in Workflow Studio consists of these components:

Playbooks

A playbook is where a playbook owner configures and organizes multiple instances
of Workfow Studio content into a coherent business process. A playbook consists
of a trigger and a sequence of stages, which are made up of a sequence of
activities.

Trigger definitions

A trigger definition specifies the conditions that must be met to run a playbook. A
user with the admin, playbook.admin, or pd_trigger_author role typically creates and
configures a trigger definition that playbook authors can use as a template. A trigger
definition specifies the record operation and table conditions that must be met to
start running a playbook. A playbook owner typically selects a trigger template when
creating a playbook.

Trigger instances

A trigger instance is produced when you select a trigger template. The trigger
instance stores the conditions that a record must meet to start running the
playbook.

Stages

A stage is a logical grouping of activities in a playbook. A playbook owner creates
a stage to group activities and specify the start rule for when the stage should start
running. A stage in your overall business process.

Activity definitions
An activity definition maps subflow and action inputs and outputs to an activity
instance. An activity definition contains:

» The automation plan to map the triggering input record data to action or subfow
inputs

« The activity experience to map action or subflow outputs to a user-facing view of
the playbook

A user with the admin, playbook.admin, or pd_content_author roles typically
specifies the automation plan and activity experience when creating an activity
definition.

Activity instances
An activity instance is produced when you add an activity to a playbook. The activity
instance stores the automation plan data mappings from the activity definition. You

can change these data mappings when the default values do not fit your playbook.
The playbook can specify the start rules for when the activity should start running.

Start rules
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A start rule specifies when a stage or an activity starts running. A playbook owner
can use start rules to specify what parts of a playbook run simultaneously and what
parts run serially.
Playbook Experience
Understand how Playbook work in the ServiceNow Al Platform® to automate cross-functional
processes and consolidate them into task-oriented views for your end users.

All > Process Automation > WorkfAow Studio > Playbooks is the design environment where
playbook owners build playbooks. Meanwhile, the runtime experience is where end users, such
as playbook agents, follow the playbook to complete a business process. To learn more about
the Playbook designer, see Playbook builder.

Runtime experience
Workfow Studio produces these runtime components for Playbooks:

Process executions

A process execution stores the details of running a playbook in a context record.
You can use a process execution to troubleshoot and verify that playbooks run as
expected.

Activity executions

An activity execution stores the details of running an activity instance in a context
record. You can use an activity execution to troubleshoot and verify that playbooks
run as expected.

Playbook runtime

Playbook runtime is when a playbook runs for an agent or fulfiller. A playbook runs
for agents only after Playbook Experience administrators configure how and where
the playbook appears.

During runtime for a playbook, your instance:

1. Evaluates any conditions specified in the trigger definition and processes the trigger.

2. Processes the Events and starts running the playbook in the background.

3. Builds the automation plans from each activity into an entire process plan.

4. Runs the process plan for your playbook.

5. Stores the process execution information in the Process Execution [sys_pd_context] table.

6. Provides data for the running playbook view that agents and fulfillers experience.

Playbook processing

Provides

Builds Stores the

Processes the

Processes the T auvtomation Runs the process data to a
trigger e plans into a process plan execufion user-facing
q process plan details view

Your instance processes a playbook during runtime by evaluating trigger conditions, processing
the event in the queue, building and running a process plan, storing process execution details,
and providing data for the Playbook Experience.
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Data security and HTML sanitization

Playbooks protects against cross-site scripting and code injection by evaluating all string data
for HTML markup. The system only preserves HTML markup that is present in its inclusion list. All
other HTML markup is removed from string data.

The inclusion list supports these HTML elements and attributes, which cannot be modified.

HTML inclusion list

a class, href, target, title

abbr class, title

address class

area alt, class, coords, href, shape
article class

aside class

audio autoplay, class, controls, loop, preload, src
b class

bdi class, dir

bdo class, dir

big class

blockquote cite, class

br class

caption class

center class

cite class

code class

col align, class, span, valign, width
colgroup align, class, span, valign, width
dd class

del class, datetime

details class, open

div class

dl class

dt class

em class

emp class

font class, color, face, size

footer class

© 2026 ServiceNow, Inc. All rights reserved.
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.

25



servicenow.

HTML inclusion list (continued)

h1 class

h2 class

h3 class

h4 class

h5 class

hé class

header class

hr class

html

i class

img alt, class, height, src, title, width

input aria-label, class, type, value

ins class, datetime

li class

mark class

nav class

ol class

p class

pre class

S class

section class

small class

span class

sub class

sup class

svg class

strong class

style

table align, border, class, valign, width

tag class

tbody align, class, valign

td align, class, colspan, rowspan, valign, width

tfoot align, class, valign

th align, class, colspan, rowspan, valign, width
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HTML inclusion list (continued)

thead align, class, valign

tr align, class, rowspan, valign

tt class

u class

ul class

video autoplay, class, controls, height, loop, preload, src, width

Now Assist features for Playbooks

Now Assist provides Al-powered capabilities across the Playbook experience, from generating
and recommending playbooks to enabling autonomous, agentic execution.

Now Assist enhances Playbook with generative Al and agentic capabilities that help you build,
discover, and run playbooks more efficiently.

Feature Description Documentation

Playbook generation Generate a complete Playbook generation &
playbook automatically using
a natural language prompt.
Now Assist creates the
playbook structure, stages,
and activities based on your
input.

Playbook recommendation Get Al-powered Playbook recommendations &
recommendations for existing
playbooks based on the
current context, such as a
record or case, so the right
playbook is surfaced at the
right time.

Agentic Playbooks Enable Al agents to Agentic Playbooks
autonomously execute
playbook actions and
make decisions at runtime,
reducing manual intervention
for complex, multi-step
processes.

Domain separation in Playbooks

Data separation is supported for Playbooks. The domain value of the triggering input record
determines the domain context. Domain separation enables you to separate data, processes,
and administrative tasks into logical groupings called domains. You can control several aspects
of this separation, including which users can see and access data.

Support level: Basic
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« Business logic: Ensure that data goes into the proper domain for the application’s service
provider use cases.

» The application supports domain separation at run time. The domain separation includes
separation from the user interface, cache keys, reporting, rollups, and aggregations.

« The owner of the instance must set up the application to function across multiple tenants.

Sample use case: When a service provider (SP) uses chat to respond to a tenant-customer’s
message, the customer must be able to see the SP's response.

For more information on support levels, see Application support for domain separation @.

How domain separation works for Playbooks

The system domain separates Playbooks content according to these rules:
Playbooks content runs from the domain it is triggered from

Activities and Playbooks run from the domain of the record or user who initiates
them. For example, when a user from the child domain ACME triggers a playbook
belonging to the parent domain TOP, the playbook runs in the context of the child
domain ACME.

WorkHow Studio content runs in the domain of the calling Playbooks activity

Whenever an activity definition calls an action or flow, the system runs the Workflow
Studio content in the same domain context as the triggering Playbooks content. If
the Workflow Studio content has a matching domain-specific process override, then
the system runs the override version instead. While Playbooks does not support
process overrides, it uses any process overrides defined within Workflow Studio.

© Note:

« A process override refers to a type of override & in domain separation.

« Service providers (SPs) can use domain separation &, to logically separate
data, processes, and administrative tasks into defined groups.

Playbooks configuration files are visible to all domain users

Playbooks configuration files are not domain separated. Any user with the
appropriate roles can view all playbooks, trigger definitions, and activity definitions.

Related topics

Domain separation for service providers &

Configuring Playbooks

Set up and monitor Playbooks and Playbook Experience.

Configuration Overview

« You don't need to activate the core Workflow Studio Playbooks feature because it is already
part of the ServiceNow Al Platform, but many features are only available with application
updates from the ServiceNow Store.

Download the latest updates for Playbooks from the ServiceNow Store. To get started more
quickly, we recommend you download the Process Automation Demo Experience, Process
Automation Content, and Playbook Experience applications as well.
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« Configure Playbooks user access and properties.

« Configure accessibility preferences to make the Playbooks authoring experience more
accessible.

Activate Playbooks
Activate the Workflow Studio application to create flows, playbooks, and more for any of your use
cases.

Playbooks are included with WorkAow Studio, which is a ServiceNow Al Platform feature that is
active by default, and that is available for installation and update from the ServiceNow Store.
However, you can only trigger playbooks off of platform and application tables that you have
access to. These can be:

« Application tables
« Custom tables that extend the application tables

« Custom tables authorized by the application subscription

Each application subscription entitles you to create playbooks for its associated tables. Purchase
subscriptions to access any additional tables that you want to trigger your playbooks from. If

you already have a subscription to your application but you still can't create playbooks for your
application's tables, enable the appropriate plugin.

() Note: The plugins you enable determine which tables are available for you to create
playbooks.

See the following sections to learn how to activate Workflow Studio Playbooks for your
application.

Activate Playbooks for App Engine

Activate Playbooks on your instance to create playbooks in App Engine.

Before you begin
Role required: admin

About this task
In order to create playbooks in App Engine, you must purchase a subscription to the ServiceNow
Al Platform App Engine &.

To purchase this subscription, contact your ServiceNow account manager. Your account
manager can arrange to have the plugin activated on your organization's production and
subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to
evaluate the product on a subproduction instance without charge, follow these steps to enable
the Process Automation Designer for App Engine [com.glide.pad.license] plugin:

Procedure
1. Navigate to All > System Applications > All Available Applications > All.
2. Select Request plugin to open the Activate Plugin form on Now Support.

3. On the Activate Plugin form, provide the following information.
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Activate Plugin form

Field Description

What is your target instance Select the instance that you want to activate
the plugin on.

Which plugin would you like to activate Select the name of the plugin to activate.

© Note: If the system doesn't list the
plugin you want or if you're activating
the plugin on an OEM or on-premise
instance, select the Plugin I'm looking
for is not listed check box and then
enter the name of the plugin.

Select Maintenance Date and Time Select the date and time to activate the
plugin.

Example

For example, see the following form to activate the Event Management plugin on an instance
named SNC Instance.

4. Select Submit.
After the maintenance window, the system installs the plugin on your instance. To confirm the
installation, go to the Installed tab in the Application Manager.

Result

You can create triggers in Playbooks for custom tables that you create &. Enabling the Process
Automation Designer for App Engine [com.glide.pad.license] plugin lets you create playbooks
for these tables and their extensions &:

« Affected Cls [cmdb_outage_ci_mtom]

« Agent Capacity [awa_agent_capacity]

« Agent channel availability [awa_agent_channel_availability]
« Agent Presence [awa_agent_presence]

« Announcement [announcement]

» Assessment Category Result [asmt_category_result]

« Assessment Instance [asmt_assessment_instance]

« Assessment Metric [asmt_metric]

« Assessment Metric Template [asmt_template]

» Assessment Metric Type [asmt_metric_type]

» Assessment Metric Type Group [asmt_metric_type_group]
» Assessment Net Promoter Score [asmt_nps_result]

» Assessment Template Definition [asmt_template_definition]

« Assignment Eligibility [awa_eligibility_pool]
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« Assignment Rule [awa_assignment_rule]

o Audit [cert_audit]

« Audit Result [cert_audit_result]

« AWA Agent Presence and Capacity [awa_agent_presence_capacity]
« AWA Document Size [awa_document_size]

« Base Configuration Item [cmdb]

« Building [cmn_building]

« Business Calendar [business_calendar]

« Certification Template [cert_template]

« Cl Relation Filter [cmdb_rel_filter]

« Cl Relationship [cmdb_rel_ci]

« Cl Relationship Rollup [cmdb_rel_rollup]

« Cl Relationship Type [cmdb_rel_type]

« Cl/User Relationship Type [cmdb_rel_user_type]

« Cls Affected [task_ci]

« CMDB Group [cmdb_group]

« CMDB Group Event Queue [cmdb_group_event_queue]
« CMDB Group Type [cmdb_group_type]

« CMDB Health Configuration [cmdb_health_config]
« CMDB Health Metric [cmdb_health_metric]

« CMDB Health Result [cmdb_health_result]

« CMDB Health Scorecard [cmdb_health_scorecard]
« Company [core_company]

« Connection & Credential Aliases [sys_alias]

« Connection & Credential Templates [sys_alias_templates]
« Cost Center [cmn_cost_center]

« Country [core_country]

» Department [cmn_department]

« Direct Relationships [cmdb_related]
 [dms_document]

« Draft Document [draft_document]

« Follow On Task [cert_follow_on_task]

« Group [sys_user_group]

» Group Member [sys_user_grmember]

« Group Queue Priority [awa_group_queue_priority]
 Group Relationship [cmdb_rel_group]

« Group Role [sys_group_has_role]

« Group Skill [sys_group_has_skill]

» Guided Setup Task [gsw_task]
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« Holiday [sys_holiday]

« Impacted Cls [task_cmdb_ci_service]

« Inbox Layout [awa_inbox_layout]

« Interaction [interaction]

« IP Address Pool [cmdb_ip_address_pool]

« IP Address Range [cmdb_ip_address_range]
« IP Address to DNS Name [cmdb_ip_address_dns_name]
« IP Service [cmdb_ip_service]

« KB Submission [kb_submission]

« Knowledge [kb_knowledge]

» Knowledge Base [kb_knowledge_base]

« Knowledge Category [kb_category]

« Knowledge Feedback [kb_feedback]

« Knowledge Feedback Task [kb_feedback_task]
« Knowledge Use [kb_use]

o Location [cmn_location]

 Metric [metric_instance]

» Model Category [cmdb_model_category]

« Offer Details [awa_offer_details]

» OS User [cmdb_os_user]

« Outage [cmdb_ci_outage]

- Page [sp_page]

« Peer Relationships [cmdb_peer]

« People Relationship [cmdb_rel_person]

« Presence State [awa_presence_state]

« Private Task [vtb_task]

« Product Model [cmdb_model]

» Queue [awa_queue]

« Related Entry [cmdb_related_entry]

« Report [sys_report]

« Role [sys_user_role]

« Roster [cmn_rota_roster]

« Rotation Escalation [cmn_rota_escalation]
 Scheduled Suite Run [sys_atf_schedule_run]
« Service [cmdb_ip_service_ci]

« Service Portal [sp_portal]

« Shift [cmn_rota]

« Shift Escalation Set [cmn_rota_escalation_set]

« Shift Escalation Step Definition [cmn_rota_esc_step_def]
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« Skill Category [cmn_skill_category]

« Skill Level [cmn_skill_level]

o Skill Level Type [cmn_skill_level_type]

« Subscribers [cmdb_subscriber]

« Template [sys_template]

« Test [sys_alf_test]

« Test Results [sys_atf_test_result]

« Test Suite [sys_atf_test_suite]

« Test Suite Result [sys_atf_test_suite_result]
« Test Suite Test [sys_atf_test_suite_test]

« Test Template [sys_atf_test_template]

« Theme [sp_theme]

« Ticket [ticket]

o [universal_request]

« User [sys_user]

« User Skill [sys_user_has_skill]

« Vendor Type [vendor_type]

» Work Item [awa_work_item]

« Work Item Rejection [awa_work_item_rejection]
» Work Item Sizing [awa_work_item_sizing]

» Work Item Sort Order [awa_queue_item_sorting]

o Note: If you create a custom table such as My Table [x_my_table], you can create
playbooks that trigger from it. However, you cannot create a playbook that triggers from a
table belonging to another Process Automation Designer plugin.

Activate Playbooks for Customer Service Management (CSM)

Activate Workflow Studio Playbooks on your instance so that you can create Playbooks triggered
by CSM tables.

Before you begin
Role required: admin

About this task
In order to create Playbooks in Workflow Studio that are triggered by CSM tables and custom
tables that extend from them, you need to purchase a subscription to CSM @&.

To purchase this subscription, contact your ServiceNow account manager. Your account
manager can arrange to have the plugin activated on your organization's production and
subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to
evaluate the product on a subproduction instance without charge, follow these steps to enable
the Playbooks for Customer Service Management [com.sn_csm_playbook] plugin:
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Procedure
1. Navigate to All > System Applications > All Available Applications > All.

2. Select Request plugin to open the Activate Plugin form on Now Support.

3. On the Activate Plugin form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Select the instance that you want to activate
the plugin on.
Which plugin would you like to activate Select the name of the plugin to activate.

© Note: If the system doesn't list the
plugin you want or if you're activating
the plugin on an OEM or on-premise
instance, select the Plugin I'm looking
for is not listed check box and then
enter the name of the plugin.

Select Maintenance Date and Time Select the date and time to activate the
plugin.

Example

For example, see the following form to activate the Event Management plugin on an instance
named SNC Instance.

4. Select Submit.
After the maintenance window, the system installs the plugin on your instance. To confirm the

installation, go to the Installed tab in the Application Manager.

Resulit
Enabling the Playbooks for Customer Service Management [com.sn_csm_playbook] plugin

lets you create playbooks for these tables and their extensions @:
« Account [customer_account]

« Case [sn_customerservice_case]

» Change Request [change_request]. Requires Customer Service with Service Management
(com.sn_cs_sm)

« Consumer [csm_consumer]

« Contact [customer_contact]

« Escalation [sn_customerservice_escalation]

» Household [csm_household]

« Incident [incident]. Requires Customer Service with Service Management (com.sn_cs_sm)

« Interaction [interaction]

« Order [csm_order]. Requires Customer Service Management for Orders (com.snc.csm.order)
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« Order Line Item [csm_order_line_item]. Requires Customer Service Management for Orders
(com.snc.csm.order)

o Problem [problem]. Requires Customer Service with Service Management (com.sn_cs_sm)

» Request [sc_request]. Requires Customer Service with Request Management
(com.sn_cs_sm_request)

« Service Organization [sn_customer_service_organization]. Requires Service Organization
(com.snc.service_organization)

« Task [sn_customerservice_task]

() Note: If you create a custom table that extends a CSM table such as Case, you can create
playbooks that trigger from it.

Activate Playbooks for Field Service Management
Activate Workflow Studio Playbooks on your instance so that you can create Playbooks triggered

by tables.

Before you begin
Role required: Admin.

About this task
In order to create Playbooks in Workflow Studio that are triggered by Field Service Management
tables, you must purchase a subscription to Field Service Management &.

To purchase this subscription, contact your ServiceNow account manager. Your account
manager can arrange to have the plugin activated on your organization's production and
subproduction instances, generally within a few days.

If you don't have an account manager, decide to delay activation after purchase, or want to
evaluate the product on a subproduction instance without charge, follow these steps to enable
the Playbooks for Field Service Management [com.sn_fsm_playbook] plugin:

Procedure
1. Navigate to All > System Applications > All Available Applications > All.
2. Select Request plugin to open the Activate Plugin form on Now Support.

3. On the Activate Plugin form, provide the following information.

Activate Plugin form

Field Description

What is your target instance Select the instance that you want to activate
the plugin on.

Which plugin would you like to activate Select the name of the plugin to activate.

@ Note: If the system doesn't list the
plugin you want or if you're activating
the plugin on an OEM or on-premise
instance, select the Plugin I'm looking
for is not listed check box and then
enter the name of the plugin.
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Description
Select Maintenance Date and Time Select the date and time to activate the
plugin.
Example

For example, see the following form to activate the Event Management plugin on an instance
named SNC Instance.

4. Select Submit.
After the maintenance window, the system installs the plugin on your instance. To confirm the
installation, go to the Installed tab in the Application Manager.

Result
Enabling the Playbooks for Field Service Management [com.sn_fsm_playbook] plugin lets you
create Playbooks for these tables and their extensions @:

 Work Task Flow [sf_work_task]

« Work Order Flow [sf_work_order]

» Work Order Task [wm_Task]

» Work Order [wm_order]

» Work Order Model [cmdb_workorder_product_model]

« Work Task Model [cmdb_worktask_product_model]

» Work Type [wm_work_type]

« Agent Personal Schedule [agent_events]

 Appointment Booking [sn_apptmnt_booking_appointment_booking]
 Questionnaire [wm_questionnaire]

« Service Order Task [sm_task]

« Service Order Task Template Dependency [sm_m2m_task_template_dependency]
« Asset Usage [sm_asset_usage]

« Part Requirement [sm_part_requirement]

« Service Management Incidentals [sm_incidentals]

Administering Playbooks

Monitor and troubleshoot issues by reviewing playbook executions.

These modules are provided for admins to monitor and manage Playbooks.
Today's Executions
Displays a list of records for Playbooks runs today.
Active Processes
Displays a list of all active Playbooks.
30+ Day Processes
Displays a list of all active Playbooks that are 30 days or older.
Activity Definitions

View or create activities.
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Asset Configuration

View or create automation assets like flows, subflows, and actions.
Trigger Definitions

View or create triggers.
Data Definitions

View or create data definitions. Data definitions are pieces of information that you
only reuse in a specific playbook, and are stored in the sys_flow_data_definition
table.

User access to Playbooks in Workflow Studio

Administrators can grant users access to Playbook by assigning delegated development
permissions or directly assigning a user role. Administrators can also specify which features and
content a user can access based on user roles.

Access by user role

Administrators can grant access to Playbook in Workflow Studio by directly assigning users the
pd_author user role, which includes the role to view activity definitions.

Roles for Playbook in Workflow Studio

Role Description Contains Roles

playbook.admin Enables users to: « pd_author

* C.reate, up.dgt.e, and delete « pd_content_author

trigger definitions.

e Launch Workflow Studio to * pd_trigger_author
create, activate, edit, and » pd_operator

delete playbooks. « pd_cancel

« Create, edit, and delete
activity definitions.

« View the Experience activity
types (sys_pd_activity)
and Experience
activity properties
(sys_pd_activity_type_prop)
tables that are shared by
Playbooks and Playbook
Experience.

pd_author Enables users to: « pd_shared.user

e Launch Workfow Studio to
create, activate, edit, and
delete playbooks. « playbook.activity_def_read

« playbook.write

« View all activity definitions.

« View the Experience activity
types (sys_pd_activity)
and Experience
activity properties
(sys_pd_activity_type_prop)
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Roles for Playbook in WorkAow Studio (continued)

Role Description Contains Roles

tables that are shared by
Playbooks and Playbook
Experience.

pd_content_author Enables users to: « pd_trigger_author

« Create, edit, and delete « od shared.user
activity definitions. pd ’
. Create, edit and delete « playbook.activity_def_read

trigger definitions.

« View the Experience activity
types (sys_pd_activity)
and Experience
activity properties
(sys_pd_activity_type_prop)
tables that are shared by
Playbooks and Playbook

Experience.
pd_trigger_author Enables users to create, none
update, and delete trigger
definitions.
pd_operator Enables users to view none

process executions, activity
executions, and execution
logs only.

pd_shared.user Enables users to view none
the Experience activity
types (sys_pd_activity) and
Experience activity properties
(sys_pd_activity_type_prop)
tables that are shared by
Playbooks and Playbook
Experience.

pd_shared.admin Enables users to edit the pd_shared.user
Experience activity types
(sys_pd_activity) and
Experience activity properties
(sys_pd_activity_type_prop)
tables that are shared by
Playbooks and Playbook
Experience.

pd_cancel Enables users to cancel none
running playbooks without the
playbook.admin role or write
access to the parent record.
For example if you want to
grant an agent manager the
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Roles for Playbook in WorkAow Studio (continued)

Role Description Contains Roles

ability to cancel playbooks,
but not an agent.

pd_restarter Enables users to restart active none
playbooks.
playbook.write Enables users who have pd_shared.user

content filtering restrictions to:

e Launch Workfow Studio to
create, activate, edit, and
delete playbooks.

« View the Experience activity
types (sys_pd_activity)
and Experience
activity properties
(sys_pd_activity_type_prop)
tables that are shared by
Playbooks and Playbook
Experience.

To learn more about content
access filtering, see Content
filtering for Playbook.

playbook.designer_access Enables users who have pd_shared.user
content filtering restrictions
to launch Workflow Studio
to view playbooks. To learn
more about content access
filtering, see Content filtering
for Playbook.

playbook.activity_def_read Enables users to view all none
activity definitions as long as
there aren't Required Roles.

A visual representation of where roles are contained:
« playbook.admin
© pd_content_author
= playbook.activity_def_read
* pd_shared.user
* pd_trigger_author
o pd_operator
o pd_cancel
o pd_restarter

© pd_author
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= playbook.write
= playbook.designer_access
= pd_shared.user
= sn_workflow_studio.workflow_studio_read

(] Note: This role allows users to launch Workflow Studio, and is not managed by
playbook administrators.

= sn_diagram_builder.db_read

(] Note: This role allows users to view playbooks in the diagram view in Workfow
Studio, and is not managed by playbook administrators.

= playbook.activity_def_read
© pd_shared.admin
* pd_shared.user

» delegated_developer

Delegated development access

Administrators can grant users access to Workflow Studio playbooks by creating an application
and assigning users as developers with the playbook delegated development B permission.
Delegated development allows administrators to control whether playbook authors can access
features normally restricted to admin users. For more information, see Developer permissions &.

Role-based content filtering

Specify the user roles necessary to access Workflow Studio playbook content. For example,
activity definitions and process definitions. Manage content filtering by creating content
definitions and content filtering rules. For more information, see Content filtering for Playbook.

Role-based activity definition access

Manage activity definition access by specifying the Required Roles to access an activity
definition. Users who can view the playbook but who do not have the required role to access
activities with this activity definition will have a read-only view of the playbook.
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To learn more about activity definitions, see Create an activity definition and Activity definitions.

Note: Both playbook.admin and pd_content_author roles can edit activity definitions, but
only the playbook.admin role can edit the Required Roles field.

Content filtering for Playbook

Specify which content a user can access based on the user's role.

Display only content that is relevant for a particular user, hiding content that is unnecessary
or sensitive. Specify the Workflow Studio playbook content that you want to control

access to and the role that a user must have to access it. For example, if a user with the
guided_decision_builder role is creating a playbook, show only a relevant set of activities.

To implement content filtering, you need:
« Content definitions to specify types of content.

« Content filtering rules and roles to determine who can access the content.

There is one content definition for Playbook by default, the Playbooks - All Activity Definitions
content definition. The Playbooks - All Activity Definitions content definition has two content
filtering rules by default:

« (Default) Playbook - Users with delegated_developer role can access all activity definitions

« (Default) Playbook - Users with playbook.activity_def_read role can access all activity
definitions

This means that users with the roles delegated_developer or playbook.activity_def_read role can
access all activity definitions. Get started with content filtering by using default definitions and
rules, or create your own.

Content definitions

Content definitions specify a type of Workfow Studio resource. Resources are key elements

of Workflow Studio components, such as activity definitions for playbooks. Create content
definitions to include an entire resource, or use a condition builder to refine your definitions. For
example, the content definition for playbook activity definitions includes all activity definitions,
but you could create a content definition that includes only the activity definitions that contain
Guided Decision in the Name or Package.
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You can further refine content definitions through tagging. Add resource tags to itemsin a
resource list, then design your content definition to only include resources with that tag.

Content filtering rules

Content filtering rules specify the role that a user must have to access the content in a particular
definition. Each rule associates user roles with a single content definition. When a user accesses
Playbook in Workflow Studio, content filtering rules determine what activities the user may
access based on the user's role.

Role-based activity definition access

Manage activity definition access by specifying the Required Roles to access an activity
definition. This overrides any content access filtering. To learn more about roles, see Playbooks
roles. To learn more about activity definitions, see Activity definitions.

Required Roles

Select target record Q |

() Note: Both playbook.admin and pd_content_author roles can edit activity definitions, but
only the playbook.admin role can edit the Required Roles field.

Read-only playbooks

Users have a read-only view of playbooks with:
« activities they do not have access to,

« process definitions [sys_pd_process_definition] they don't have write access to.

Access summary
filtered
Activity - AT . S
Definiti » The activity definition is visible to » The activity definition is hidden and cannot
ennition select when building a playbook. be selected when building a playbook.
» The activity definition can be « Playbooks with the activity definition are
copied. read-only.

» The activity definition can be
modified.

Design considerations

Content definition roles for activity definitions
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Give users access to the subset of activity definitions in a content definition by
assigning the playbook.write role, not the pd_author role.

Configure content filtering definitions for Playbook

Specify which content a user can access by creating content definitions.

Before you begin
Content filtering requires some familiarity with user roles and Workflow Studio tables and
records.

Role required: admin, playbook.admin

About this task
Filter Workflow Studio playbook content based on user role. Filtering content requires you to set

up:
1. Content definitions describe the content that you want to filter. Content definitions specify
types of Workflow Studio resources, such as activity definitions.

2, Content filtering rules to state the role a user must have to access the resource in a particular
definition.

There is one content definition for Playbook by default, the Playbooks - All Activity Definitions
content definition. The Playbooks - All Activity Definitions content definition has two content
filtering rules by default:

« (Default) Playbook - Users with delegated_developer role can access all activity definitions
« (Default) Playbook - Users with playbook.activity_def_read role can access all activity
definitions

This means that users with the roles delegated_developer or playbook.activity_def_read role can
access all activity definitions. Get started with content filtering by using default definitions and
rules, or create your own.

Procedure

1. To modify or create a content definition, navigate to Process Automation > Flow
Administration > Content Definitions.

() Note: If you don't have access to Flow Administration, the Content Definitions module is
directly under Process Automation instead.

2, Select the definition that you want to modify or click New to create one.
3. On the form, fill in the fields.

WorkfAow Resources form

Field Description

Name Name for the content definition.

Application Application scope to which the content definition applies. This field is
automatically set to the currently selected application scope. If no application
scope is selected, the field is set to Global. If you set a specific application
scope, then the content definition only applies to that application scope. If you
select the Global application scope, then the content definition applies to all
applications.
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Field Description

Table Table containing the resource type that you're defining. For example, the Activity
Definitions [sys_pd_activity_definition] table includes all the activity definitions
available on your instance.

Conditions Conditions used to filter the records in the table. For example, creating a
condition where [Name] [contains] [Guided Decisions] returns only the
activities that include the term Guided Decisions in the name.

Resource  Tags used to filter the resources in the table.
Tags

4. Click Submit.

Configure content filtering rules for Playbook
Use content filtering rules to specify the role a user must have to access content.

Before you begin
Role required: admin, playbook.admin

Content filtering requires some familiarity with user roles and playbook tables and records.

About this task
Filter Workflow Studio playbook content based on user role. Filtering content requires you to set

up:

1. Content definitions describe the content that you want to filter. Content definitions specify
types of Workflow Studio resources, such as activity definitions.

2, Content filtering rules to state the role a user must have to access the resource in a particular
definition.

There is one content definition for playbooks by default, the Playbooks - All Activity Definitions
content definition. The Playbooks - All Activity Definitions content definition has two content
filtering rules by default:

« (Default) Playbook - Users with delegated_developer role can access all activity definitions
« (Default) Playbook - Users with playbook.activity_def_read role can access all activity
definitions

This means that users with the roles delegated_developer or playbook.activity_def_read role
can access all activity definitions, unless Required Roles is configured. Get started with content
filtering by using default definitions and rules, or create your own.

Procedure
1. To modify or create a content filtering rule, navigate to Process Automation > Flow
Administration > Content Filtering Rules.

O Note: If you don't have access to Flow Administration, the Content Filtering Rules
module is directly under Process Automation instead.

2, Select the rule that you want to modify or click New to create one.
3. On the form, fill in the fields.
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WorkHow Resources Filter Rule form

Field Description

Name Name for the content filtering rule.
User Role The role a user must have to access the content in the Resource Definition
field.

Delegated The specific Resource Path that the user is a delegated developer for.
Development Configure the Resource Path in the [sys_development_permission_set] table.
Permission

Active Option to enable the rule.

Application  Application scope to which the content filtering rule applies. This field is
automatically set to the currently selected application scope. If no application
scope is selected, the field is set to Global. If you set a specific application
scope, then the content filtering rule only applies to that application scope. If
you select the Global application scope, then the content filtering rule applies
to all applications.

Resource The name of the content definition that specifies the resource to filter.
Definition

4. Click Submit.

Archive process contexts
Improve database query performance by archiving unneeded records for playbooks that are in a
Complete, Error, or Cancelled state.

Before you begin
Role required: admin or playbook.admin

About this task

Depending on how many playbooks you have run, you may have hundreds or thousands of
records in your database that aren't used anymore. Reduce the number of records that your
database queries have to search through by archiving the records for playbooks that are in a
Complete, Error, or Cancelled state.

By default, context records are automatically archived for process executions that are:
« In Complete, Skipped, or Cancelled state
« For a playbook that hasn’t been edited within 14 days.

() Note: You can adjust the number of days. To learn more about configuring archive
settings, see Configure archive settings for process contexts.

If you don't want context records to automatically be archived, see Turn off automated archiving.

Contexts for process executions that are in an Error state must be archived manually.

o Note: If you no longer need logs for a process execution that ended in an error, archive
the context records.

When you archive context records for a process execution, the following records are compressed
into a single JSON record:
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« Element mapping [sys_element_mapping]

« Contextlog[sys_pd_context_logs]

« Variable value [sys_variable_value]

« Activity context [sys_pd_activity_context]

« Stage context [sys_pd_lane_context]

The JSON record can be viewed, but not edited. To learn more about viewing the JSON record for
archived context data, see View archived process contexts.

A Warning: Archiving cannot be undone. If you need context logs or reports that use these
records, don’t archive. If automated archiving creates report problems, turn off the feature.
To learn how to turn off automated archiving, see Turn off automated archiving.

Agents can still open playbooks to see historical data, such as why a playbook was canceled or
who an activity was assigned to.

Flow context (sys_flow_context)records are also deleted automatically 2 weeks after
completion. For more information about flow data retention, see Flow execution details retention.

Procedure
Manually archive context records for a process execution

1. Navigate to All, and enter sys_pd_context.list in the Filter field to open the [sys_pd_context]
table.

2. Select the check boxes next to the executions that you want to archive context records for.
3. In the upper right corner, select Archive Process Contexts from the action menu.
4. Confirm that you want to archive the process contexts.

Resulit
The context records are archived for your selected process executions.

Trouble?
If you have a large number of context records to archive, records are archived in limited batches

on an hourly basis, to avoid slowing down the instance.
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Example: Archive context records for an execution

Servicenow Al Favorites History ~ Workspaces  § Q, Search

Welcome to Admin Home, Service-now: Jacqueline Haddenham [maint,admin,itil]!

Manage, monitor, and discover all your day to day administrative actions and tools across the platform. 4

Track what'’s important to you

.
Shared admin dashboard - b (]
Open incidents O i Open request items O i Pro... i Hardening compliance s... i
) ] 0,
OO) Oy) (o]
No data available. No data available.
There is no data available for the selected criteria. There is no data available for the selected criteria
. Ch... i (=) Critical Updates
.., Open P1 . Aging Request Request
incidents ) (o) incidents i () items over i .., items

over 24 hrs 24 hrs : awaiting :
0 approval 8 9 2

Get information about vour instance

What to do next
Configure the form layout for process executions so that you can see the archived data. To learn

more about configuring the form layout for a process execution, see View archived process
contexts.
Configure archive settings for process contexts

Change the default settings for the automated archiving feature for process contexts.

Before you begin
Role required: playbook.admin

If you want to turn off automated archiving instead, see Turn off automated archiving.

Procedure

1. Navigate to All > System Properties > All Properties.

2, Search for and open the sn_pa_designer.data_retention_policy property.
3. Select the here link in the warning message to edit the record.

4. Change the Value to the number of days a complete or cancelled playbook must be unedited
before the context records for it can be archived.
The default value is 14. If you want context records for executions to be archived as soon as a
playbook is complete or cancelled, you can set the value to O. If you want to wait longer before
context records can be archived, enter a greater number.

A Warning: Changing other fields in this record could potentially break automated
archiving.

5. Select Update.
Your change is saved.
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Example: Change the wait period to 30 days

SerVicenﬁw All  Favorites History Admin Home 77 Q_ Search

Welcome to Admin Home, Service-now: Jacqueline Haddenham

[maint,admin,itil]!

Manage, monitor, and discover all your day to day administrative actions and tools across the platform.

Track what’s important to you

Shared admin dashboard - (@] B

Open incidents @ i Open request items @ Pr.. i Hardening complianc... }
= E= 1. 89%
= =
O x) OO ) sea (0]
No data available. No data available.
There is no data available for the selected criteria. There is no data available for the selected criteria.
) C.. i =) Critical Updates
., openP1l Aging Request Request
“incidents  ° ., incidents i} items over § ., items .
" over 24 ' 24 hrs " awaiting )
hrs approval eea

0
o |9 o |

Turn off automated archiving
Turn off the automatic archiving of context records for your complete and cancelled playbooks.

Before you begin
Role required: playbook.admin

If you want to change the number of days to before a playbook is archived instead, see Configure
archive settings for process contexts.

Procedure

1. Navigate to All > System properies > All Properties.

2. Search for and open the sn_pa_designer.enableDataRetentionFeatures property.
3. Select the here link in the warning message to edit the record.

4. Set the Value to false.

A Warning: Changing other fields in this record could potentially break automated
archiving.

5. Select Update.
Automated archiving is turned off.
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Example: Turn off archiving

Servicen le)'."A All  Favorites  History = Workspaces Home 1% Q. Search

Welcome to Admin Home, Service-now: Jacqueline Haddenham [maint,admin,itil]!

Manage, monitor, and discover all your day to day administrative actions and tools across the platform. a

Track what's important to you

H —~ -~ .
Shared admin dashboard - o ;
Open incidents [0 Open request items @ Pro... i} Hardening compliance s...
== = 14 89%
= =
S x) ) (0]
No data available. No data available.
There is no data available for the selected criteria. There is no data available for the selected criteria.
N Ch.. & | | = Critical Updates
) Open P1 . Aging Request Request
~incidents o] e incidents H (=} items over i items

over 24 hrs 24 hrs awaiting ;
0 sorovs 89 2

at infarmatinn shanik vanir inctanca

View archived process contexts

Configure the form layout for a process execution so that you can see the JSON record for
archived context records.

Before you begin
Role required: admin or playbook.admin

About this task

To view the archived context records for a process execution record, you must configure the
Form Layout for process execution records. If you haven't archived any context records for a
process execution and want to, see Archive process contexts.

Procedure

1. Navigate to All, and enter sys_pd_context.list in the Filter field to open the [sys_pd_context]
table.

2. Open any process execution.

3. Open the form context menu ( =),
4. Select Configure > Form Layout.

5. In the Available list, double-click Archive to move it to the Selected list.
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Awvailable Selected
Archive |- begin_split -|
Created by Label
Domain [+] Created
Domain Path |- split -|
Execution index Input Record
Execution stack State

Flow Context [+] |- end_split -|
Input Table

MName

Process Definition [+]

Process Variant
Updated
Updated by
Updates

|- begin_split -|
|- split -|

6. Select Save.
The Archive field appears in all process execution records.

7. Open a process execution with archived process context records.

You can view the JSON record of the archived context records for the process execution in the
Archive field.

Example: Add the Archive Feld to the form

SEI'ViCEnOW All  Favorites  History Admin i Home <% Q_Search

Welcome to Admin Home, Service-now: Jacqueline Haddenham

[maint,admin,itil]!

Manage, monitor, and discover all your day to day administrative actions and tools across the platform.

Track what'’s important to you

Shared admin dashboard - B

Open incidents @ i Open request items @ i Pr.. & Hardening complianc... i
= = 1 89%
=) O x) sea 0
No data available. No data available.
There is no data available for the selected criteria. There is no data available for the selected criteria
) C. & = Critical Updates
" Open P1 . Aging Request Request
incidents  * " incidents iei items over i i items

over 24 ) 24 hrs v awaiting :
O hrs approval 8 00 2

Create a Data Definition

Use data definitions to collect and use pieces of information later in a playbook.
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Before you begin

© Important: As of the 261 release, the Collect user data activity is no longer available
in the activity picker. The activity will continue to function wherever it is used, but for new
activities use the Questionnaire activity instead. The Questionnaire activity does not
require you to create a data definition. To learn more about the Questionnaire activity, see
Questionnaire activity.

Role required: admin, low_designer

You will be working in the ServiceNow Al Platform to complete this task.

About this task

A data definition is the information that you want an agent or fulfiller to collect during a playbook
run, and is the key input of the Collect user data activity. Playbook authors define the data they
want an agent or fulfiller to collect in the sys_flow_data_definition table. Whenan
agent or fulfiller collects the information, the information is stored in the sys_flow_data table
for use later during the playbook run, instead of in the record table.

Only use a data definition if:

« The data is only needed downstream during a single playbook run. It's collected, used, and
never needed again.

 You don't need to run any reports on the collected data. If you need any metrics or reports on
the collected data, create a table and use the User Form activity instead.

For example, you may have multiple teams that perform activities. One team enters the inputs
for a created data definition when they perform a Collect user data activity, and then a second
team uses the collected inputs to complete the playbook, and the information is not needed
afterwards.

Procedure

1. Navigate to All > Process Automation > Process Automation Administration > Data
Definitions.

2. Select New to create a new data definition.

3. Give your new data definition a name.

(; ) Note: Data definitions have the same scope as other metadata tables, by default.

4, Right-click in the record header to Save.
If you select the Submit button, you are taken back to the Data Definitions list and will need to

select your new data definition to re-openit.
5. Add fields for information that you want an agent to collect.
a. In the Flow Data Variables table, select New.

b. Enter the required fields.

The type of input the agent is collecting for a

Type field. For example, string, reference, integer,
etc.
Label The label of the field in the Ul, during the play
book run. The label can consist of any text.
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The name of the input being collected.

Column name Spaces cannot be used to delimit words.

The maximum length a string value can be
Max Length entered for a string type of field. The variable
can store longer strings than it can display.

The application scope for the data variable.
Application It is always set to Global, and cannot be
changed.

Optional configurations

6. Optional: Under the Default Value tab, specify the value used when a playbook does not
provide a value.

7. Right-click in the record header to Save.

Result
The data definition can now be used when configuring activities in Playbooks in Workfow Studio.

Example:
During a playbook run, you can use data definitions to potentially:

« Collect a shipping address, then reference the address when generating a shipping label.

« Ask the user "yes" or "no" questions, and determine subsequent activities based on the user's
responses.

What to do next
Configure a Collect user data activity in Workflow Studio Playbooks to use your new data
definition.

Configure accessibility preferences

View all buttons in a playbook diagram by default, without the need to hover or select any
element.

Before you begin
Role required: none

About this task

When you hover over or select an element in the playbook diagram, buttons such as Edit, Delete,
and others become visible. You can configure the user preferences to make the buttons visible
by default, without hover or select.
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1. Getting Started withl/

>
1.3 Identity the
Users with...
>
Procedure

1. Navigate to User menu > Preferences > Accessibility.

2. Enable the option Show all buttons without the need to hover.
To learn more about how you can make the Ul most accessible for you, see Configure Next
Experience accessibility preferences &

Building Playbooks

Playbooks are ServiceNow Al Platform® representations of cross-enterprise processes for your
organization. Create and activate a playbook to run your digitized business process on the
ServiceNow Al Platform.

Each playbook that you design in Workfow Studio has a trigger, a sequence of stages, and

a sequence of activities. To learn about the building blocks of a playbook and how you can
create an manage a playbook, see Understanding the playbook components and Creating and
managing Playbooks.

Building your first playbook

Learn the basics of designing an automated process for your organization. Get an overview of
how Workflow Studio Playbooks work in the ServiceNow Al Platform®.

Playbooks

Playbooks in Workflow Studio are ServiceNow Al Platform representations of your manual cross-
enterprise workflows. By creating a Workflow Studio playbook on the platform, you're digitizing
these workfows. A playbook in WorkAow Studio has two dimensions: the playbook and their
associated process executions.

Playbooks

A playbook is where a playbook owner configures and organizes multiple instances
of Workflow Studio content into a coherent business process. A playbook consists
of a trigger and a sequence of stages, which are made up of a sequence of
activities.

Process executions

A process execution is a single, runtime instance of a playbook.
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Building a playbook
When you design your business process in Playbooks, you're creating a playbook.

Each playbook consists of a trigger as well as stages and activities. Triggers define the
conditions that, when met, start running your playbook. Stages and activities represent stages
and individual steps in your overall business process. In the Playbooks design environment,
you can organize these stages and Playbooks into a sequence that reflects how your business
process runs.

When you're done creating your playbook, activate it so that it runs when triggered.

Process Definition

Business Process i Customer Support Escalation 4

a’ b B =

s ke & Analysis Follow-up | omsse

What happens when a playbook runs

When your activated playbook is triggered, the system creates a process execution, which
represents a single, running instance of your playbook.

When your playbook starts running, a process execution is created. The system runs each
activity in your playbook until the process execution is complete. As each activity runs,
automated record operations occur on the ServiceNow Al Platform.

If an administrator has set up Playbook Experience for your playbook, then agents and fulfillers
can run the playbook. Agent or fulfillers go through each activity in the playbook, which is
associated with a record in a Workspace.

In summary, your playbook runs when:

1. The system creates a process execution.

2, Playbook Experience is configured and the playbook is rendered for agents.

3. Automated operations on records that are associated with your process execution occur on
the ServiceNow Al Platform.
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Process Execution record
/ Activated Process Defintion \ ' = ==

1 Customer Support Escalation =

_ ) Trigger Playbook

\ / I Associated records on Now Platform

Learn more about Playbooks

If you're ready to start digitizing your business process with Playbooks in Workflow Studio, try
checking out these resources:

» Create a sample playbook

« Create a playbook

Create a sample playbook

Create a sample playbook to standardize and automate how Service Desk agents handle chat
interactions with VIP users.

Before you begin

« Enable the Process Automation Designer for App Engine [com.glide.pad.license] plugin with
a subscription to the ServiceNow Al Platform App Engine. For more information, see Activate
Playbooks.

« Ensure that your current application is set to Global. For more information, see Application
picker &.

« Role required: admin or playbook.admin

About this task

In the following procedure, you can step through an example of how to digitize a manual
business process on the ServiceNow Al Platform using Playbooks in Workflow Studio to
standardize and automate how Service Desk agents handle chat interactions with VIP users.

The manual business process for this example consists of the following stages:

1. Identify and Log: A Service Desk agent learns of an issue that a VIP user is facing
while chatting with the user in a messaging application. The Service Desk agent creates an
interaction record to track this issue.

2, Classify and Diagnose:The Service Desk agent associates an incident record with the
interaction and sets the incident's priority to High. The agent then enters the Assigned To user
for the incident.
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3. Communicate Work in Progress: The assignee updates the incident record's state to
Work in Progress and emails the VIP user when progress is made on the incident.

4, Resolve: When the incident is resolved, the assignee emails the resolution information to
the VIP user.

Procedure
1. Create a playbook named Handle Interactions with VIPs.

a. Navigate to Process Automation > Workflow Studio > Playbooks.
b. In the main header, click Create a new process.

c. On the form, fill in the fields.

Field Action

Label EnterHandle Interactions with
VIPs.
Description Enter This process defines how

Sexvice Desk agents can handle
interaction records that are
created for VIP users.

Application Select Global.

d. Click Select a trigger.

e. Click the Define your own trigger conditions for when your process runs option.
f. From the list of trigger options, select Record Create.

g. Click Set your trigger conditions.

h. In the Table list, select Interaction [interaction].

i. Use the condition builder & to add the following condition to your trigger:
[Opened for->VIP] [is] [True].

J- Click Go to Designer.
The Playbooks design environment appears.
2. Add a stage for each stage in your process.

a. Click + Add stage to add the first stage to your process.

b. In the stage properties panel's Label field, enter Classify and Diagnose.

() Note: Because the Identify and Logstage triggers this process, don't add it as
a stage.
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c. In the Description field, enter Associate an incident with the interaction.
d. In the When to start field, leave Immediately selected, and then click Save.
e. Click + Add stage to add another stage to your process.
f. In the stage side panel's Label field, enter Communicate Work in Progress.
g. In the Description field, enter Notify VIP of work in progress.
h. In the When to start field, leave After Previous selected, and then click Save.
i. Click + Add stage to add the final stage to your process.
Jjo In the stage side panel's Label field, enter Resolve.

k. In the Description field, enter Resolve incident and share resolution
details.

I. In the When to start field, leave After Previous selected, and then click Save.

3. Addthe Create incident from interactionactivity to the Classify and Diagnose
stage.

a. Under the Classify and Diagnose stage, click + Add an activity.

b. In the activity picker, select Common Activities, and then select Automated Create Record
under Non-Interactive.

c. In the activity properties panel's Label field, enter Create incident from
interaction.

d. In the When to start field, leave Immediately selected, and then click Save.
e. Click the Create incident from interaction activity card.
£ In the activity properties panel, click Configure activity.
g. On the Configure your activity screen, locate the Variables section under Inputs.
h. In the Table Name list, select Incident [incident].

i. From the Fields list, select Assigned To.

jo Next to the Assigned To field, select the data pill picker icon (‘34‘).

k. Dot-walk to the Interaction record's Assigned To field by selecting Context > Input Record -
interaction > Assigned To.

I. In the Fields list, select Impact and then select 2 - Moderate.
m. Under Fields, select Urgency and then select 1- High.
n. In the Fields list, select Short Description.

o. Dot-walk to the Interaction record's Short description field by selecting Context > Input
Record - interaction > Short Description.

p. In the Fields list, select Caller.
q. Dot-walk to the Interaction record's Opened for field by selecting Context > Input Record -
interaction > Opened for.
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r. In the Wait for user input field, leave No selected.
s. In the Fields to show after creation field, enter priority.

t. Click Update to finish updating the inputs for the activity.
The Create incident from interaction activity automatically maps the Assigned To and Short
Description fields from the interaction record to the incident record when your process runs.

4. Add the Wait for assignee to update activity to the Communicate Work in Progress stage.
a. Under the Communicate Work in Progress stage, click + Add activity.

b. In the activity picker, select Common Activities, and then select Wait For Condition under
Interactive.

c¢. In the activity properties panel's Label field, enter Wait for assignee to update.
d. In the When to start field, leave Immediately selected, and then click Save.

e. Click the Wait for assignee to update activity card.

F. In the activity properties panel, click Configure activity.

g. On the Configure your activity screen, locate the Variables section under Inputs.

h. Next to the Record field, select the data pill picker icon (‘i,‘).

i. Dot-walk to the Create incident from interaction activity's record output by selecting
Activities > 1:1 - automated_create_record > Outputs > record.

J- In the Table list, select Incident [incident].

k. Use the condition builder @ to add the following condition to your activity:
[Updated by] [is] [Activities > 1:1 - automated_create_record > Outputs > record >
Assigned to].

I. Click Update to finish updating the inputs for the activity.
The Wait for assignee to update activity pauses the process until the Assigned To user for the
Incident record updates the record.
5. Add the Send update to VIPactivity tothe Communicate Work in Progress stage.
a. Under the Communicate Work in Progress stage, select + Add activity.
b. In the activity picker, select Common Activities, and then select Instruction under Default.
c. In the activity properties panel's Label field, enter Send update to VIP.
d. In the When to start field, leave After Previous selected, and then select Save.
e. Click the Send update to VIP activity card.
£, In the activity properties panel, select Configure activity.
g. On the Configure your activity screen, locate the Variables section under Inputs.

h. In the Message field, enter Notify the VIP user that work on their issue
is in progress.
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i. Leave the Wait for user input field's value as Yes.

j- Click Update to finish updating the inputs for the activity.
The Send update to VIP activity prompts the agent to send an email to the VIP user when the
assignee for the incident record makes an update.

6. Addthe Wait for incident resolutionactivity to the Resolve stage.
a. Under the Resolve stage, select + Add activity.

b. In the activity picker, select Common Activities, and then select Wait For Condition under
Interactive.

¢. In the activity properties panel's Label field, enter Wait for incident resolution.
d. In the When to start field, leave Immediately selected, and then click Save.

e. Click the Wait for incident resolution activity card.

f. In the activity properties panel, click Configure activity.

g. On the Configure your activity screen, locate the Variables section under Inpults.

h. Next to the Record field, select the data pill picker icon (‘i,‘).

i. Dot-walk to the Create incident from interactionactivity'srecord output by
selecting Activities > 1:1 - automated_create_record > Outputs > record.

j- In the Table field, select Incident [incident].

k. Use the condition builder @& to add the following condition to your activity:
[State] [is] [Resolved].

I. Select Update to finish updating the inputs for the activity.
The Wait for incident resolution activity pauses the process until the Incident's state becomes
[Resolved].
7. Add the Share resolution details with VIPactivity to the Resolve stage.
a. Under the Resolve stage, select + Add an activity.
b. In the activity picker, select Common Activities, and then select Instruction under Default.

c. In the activity properties panel's Label field, enter Share resolution details with
VIP.

d. In the When to start field, leave After Previous selected, and then click Save.
e. Click the Share resolution details with VIP activity card.
£, In the activity properties panel, click Configure activity.
g. On the Configure your activity screen, locate the Variables section under Inputs.

h. In the Message field, enter Provide the Resolution Notes from the
Incident record in an email to the VIP user.
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i. Leave the Wait for user input field's value as Yes.

j- Click Update to finish updating the inputs for the activity.
The Share resolution details with VIP activity prompts the agent to send the issue resolution
details to the VIP user.

8. In the main header, click Activate so that your process runs when triggered.

9. View your activated process as a playbook.

a. Close the Playbooks tab and navigate to Playbook Experience.

b. In the side menu, click the lists icon (E).
c. In the Lists tab under Interactions, click My Interactions.
d. In the form header, click New.

e. On the form, fill in the fields:

Field Action

Type Select Chat.

Opened for Select a VIP user.

Assigned to Select a user that can make updates to
Incident records.

Short description Enter Testing out the Handle
Interactions with VIPs
playbook.

f. In the form header, click Save.

g. In the Contextual side panel, click the playbook icon ( = ).

Result

Your process appears in as a playbook. Here, agents and fulfillers can get a task-oriented view of
the automated business process. Agents can step through the activities that you set up to see
where the record is in the overall process.

What to do next
Customize the Playbook layout for deployment. To learn more, see Customizing the Playbook
Experience

Understanding the playbook components
Understand the building blocks of a playbook and how to configure them when you create a

playbook.

Each playbook consists of the triggers, stages, and activities. You can use variants to use one
playbook for multiple scenarios.
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Triggers

A trigger is an operation that tells your playbook to start a run. Each trigger has a type and
conditions that must be met. Triggers only fire for record operations that are interactive or made
by users. For more information, see Triggers.

Stages and activities

An activity represents one step in your business process, and the record for an activity is called
an activity definition. Group activities by the stages of your business process, and sequence
activities in an order that makes sense for your cross-enterprise workflow. For more information
on stages, see Stages and activities.

Variants

Create different variations on top of a base playbook for multiple use cases instead of
duplicating and modifying playbooks, or relying on one-time workarounds that use complex run
conditions and branching. For more information about variants, see Playbook variants.

Triggers
Triggers specify when to start running your playbook.

In Playbooks, triggers indicate when your playbook should start running. Each trigger has a type
and conditions that, when met, start running your activated playbook.

You choose one or more triggers when you create a playbook in Workflow Studio. To add a
trigger, start by choosing the trigger type. Then, set conditions and other options to refine your
trigger so that it fires in a way that makes sense for your business process. Repeat if you want
your playbook to run based on multiple triggers. For more information, see Create a process
definition.

@ Note: You can also configure and activate a playbook without any trigger, if you're
planning to only trigger the playbook via API.

If you don't see a trigger that fits your use case, you can also create your own trigger definition
instead. For more information, see Create a trigger definition.

Trigger types

In your Trigger Definition [sys_pd_trigger_definition] record, you can choose a trigger type, which
determines when your trigger fires. These trigger types represent record operations that can
occur in the ServiceNow Al Platform™. The following trigger types are available in your instance
by default:

Scheduled
The playbook runs on a schedule specified by the playbook author.

When record is created

The playbook runs when a user creates a record anywhere in the ServiceNow Al
Platform.

When record is updated

The playbook runs when a user updates an existing record anywhere in the
ServiceNow Al Platform.

When record is created or updated

The playbook runs when a user creates a record or updates an existing record
anywhere in the ServiceNow Al Platform.
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() Note: Triggers only fire for record operations that are interactive, or made by users.
Triggers don't fire for non-interactive record operations. For more information, see Non-
interactive sessions &.

Details

After you add a trigger to your playbook, you can then set conditions and other options that
determine when and how your trigger fires.

Option Action

Conditions Use the condition builder to create field
conditions for when your playbook runs. See
Condition builder &.

Run this trigger on extended tables Select this option to trigger the playbook on
tables that extend from your selected table.
For example, if you enable this option and
select the Configuration Item [cmdb_ci] table,
your playbook runs when record operations
occur on the Server [cmdb_ci_server],
Computer [cmdb_ci_computer], and other
extended tables. For more information, see
Table extension and classes @&.

Trigger on unique change Select this to trigger the playbook for every
unique update to a non-system field & even
if the Aow is currently running. The system
stores a history of every change to a record
and determines whether the change is unique.
For example, if an incident record's State field
changes from In Progress to On Hold, the
playbook runs. However, if the State field then
changes back to In Progress, the playbook
doesn't run.

() Note: Playbooks that have a trigger
that runs For each unique change
can produce recursions when run
in a non-interactive session. When
such playbooks make a change to the
trigger record, the change meets the
playbook's trigger conditions and causes
a recursion.

Design considerations

Refer to these design considerations when working with triggers:
Create unique filter conditions for record triggers on the same table

To prevent playbooks from overwriting each other, create unique filter conditions for
each playbook that runs on the same table. If multiple playbooks on the same table
have the same filter, there is no way to know the order in which the playbooks will
run.

Avoid duplicating triggers used in Workflow Studio Aows

© 2026 ServiceNow, Inc. All rights reserved. 62
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


https://www.servicenow.com/docs/access?context=c_NonInteractiveSessions&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_NonInteractiveSessions&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_NonInteractiveSessions&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_NonInteractiveSessions&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US
https://www.servicenow.com/docs/access?context=table-extension-and-classes&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=table-extension-and-classes&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=table-extension-and-classes&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_GlobalDefaultFields&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_GlobalDefaultFields&version=australia&pubname=australia-platform-administration&ft:locale=en-US
https://www.servicenow.com/docs/access?context=r_GlobalDefaultFields&version=australia&pubname=australia-platform-administration&ft:locale=en-US

servicenow.

Playbooks triggers do not override Workflow Studio triggers. For both applications,
when the trigger conditions are met, the automated processes run.

Ignore records added or updated by import and update sets
Record triggers ignore records that were added or updated by applying an update
set or importing an XML file. These operations apply to the entire application or
table instead of an individual record.
Create a trigger definition

Define the type of trigger that determines when to start running your playbook.

Before you begin

« Make sure to set your current application to the application that you want your playbook to run
in. For more information, see Application picker &.

« Role required: admin, playbook.admin, or pd_trigger_author

Procedure

1. Navigate to All > Process Automation > Process Automation Administration > Trigger
Definitions.

2. In the context header, click New.

3. On the Trigger Definition form, in the Label field, enter any label for your trigger definition.
This label appears as a trigger option when you Create a playbook.

4. Next to the Trigger Type field, click the lookup using list icon ( ™).

5. In the Trigger Types list, select a trigger type to use for your trigger definition.
Options include:

Record Created

The playbook runs when a user creates a record anywhere in the ServiceNow Al
Platform.

Record Updated

The playbook runs when a user updates an existing record anywhere in the
ServiceNow Al Platform.

Record Created or Updated

The playbook runs when a user creates a record or updates an existing record
anywhere in the ServiceNow Al Platform.

6. Click Next to go on to the next step.

7. In the Table list, select a table whose record operations you want to trigger your playbook.

8. Under Condition, use the condition builder & to add field conditions for when you want to
trigger your playbook.

9. To trigger your playbook for tables that extend your selected table, select the Run On
Extended check box.
For more information, see Table extension and classes @.

10. Click Update to finish creating your trigger definition.

Result
Your trigger definition is added to the Trigger Definition [sys_pd_trigger_definition] table. You can
now select your preset trigger when you Create a playbook.
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Add and configure a trigger in a playbook
Begin building your playbook by adding and configuring the trigger.

Before you begin
Role required: playbook.admin or pd_author

Review Triggers.

Create a trigger definition if needed.

About this task

You can add one or multiple triggers to your playbook. The triggers can either be record based
or scheduled. Record based triggers start your playbook when a record is created, updated, or
both. The scheduled triggers give you the option to run the playbook at the time you need. You
can also add an existing trigger that matches the conditions for your playbook.

Note: You can create up to 10 triggers of any type. It can be record-based triggers,
scheduled triggers, or a combination of both.

Procedure
1. Navigate to All > Process Automation > WorkHow Studio > Playbooks.

2. Open the playbook that you want to configure or create a playbook.
3. On the left sidebar, select Triggers ( % ).

O Note: You can't open triggers until the parent table is specified for the playbook. To
specify a parent table, edit Start in the diagram view, or open the More actions menu

('1') and select Properties.

Exam ple p I aYbOOK © Inactive

\ Triggers Add trigger v
= % B T
~ @ Record based triggers ®
»I'Record created W
& Created or updated 0]
~ @ Scheduled triggers ®
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If triggers are already added to the playbook, the Triggers screen displays a list of the
associated triggers. You can edit, delete, or add a trigger.

4, Select an existing trigger to edit, or add a trigger.

Trigger type Actions

Record based Go to Add trigger > Record based and select
when you want the playbook to run:

o When record is created
o When record is updated

o When record is created or updated

If you want to specify a different table for

the trigger than the parent table, use dot-
walking to specify the relation between the
two tables. You can choose to run your trigger
on Table extension and classes & or start you
trigger only on unique change of records.
After you specify the Conditions that should
start your playbook, select Save and close.

If you want to use a trigger that has all the
conditions you need for your playbook, select
Choose existing playbook trigger. Then,
choose an existing trigger from the list and
select Save and close.

Scheduled a. Select Add trigger > Scheduled.

b. Specify the scheduling details and the
conditions for the trigger and select Save
and close.

For more information about scheduling a

trigger, see Create a scheduled trigger for

Playbook

Result

The trigger is configured.

What to do next
Add and configure your stages.

Create a scheduled trigger for Playbook
Create a scheduled trigger that starts your playbook at the required time and interval. You can
schedule a trigger in any time zone, with or without an end date for the schedule.

Before you begin
Role required: playbook.admin or pd_author

Procedure
1. Navigate to All > Process Automation > WorkHow Studio > Playbooks.
2. Open the playbook that you want to configure or create a playbook.
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3. On the sidebar, select Triggers ( ¥ ).

O Note: You can't open triggers until the parent table is specified for the playbook. To
specify a parent table, edit Start in the diagram view, or open the More actions menu

([l]) and select Properties.

Exa m ple pl aybOOk @ Inactive

 Triggers
= % & 1
~ [ Record based triggers [0
I Record created W
& Created or updated 0]
®

A @ Scheduled triggers

If triggers are already added to the playbook, the Triggers screen displays a list of the
associated triggers. You can edit, delete, or add a trigger.

4. Select Add trigger > Scheduled.
5. Specify the scheduling details.

a. Select the Time zone in which you want to schedule the trigger.

b. Specify the Start date and time for the trigger.
The date and time is as per the selected time zone.

c. Use the Repeat and Every fields to define the schedule for the trigger.

Description

Runs every day or at your chosen interval of
days. For example, everyday, every 2 days,
every 3 days and so on.

Daily
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Weekly

Monthly

Yearly
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Description

Runs every week or at your chosen interval
of weeks. For example, every 2, 3, or 10
weeks.

Repeat * Every %
[ Weekly - \ 1 ] Weekis)
Days of the week x

s8-8

End *

|‘ No end date v

Select on which days of the week you
want the trigger to run. For example, every
Monday, Wednesday, and Friday.

Runs every month or at your chosen interval

of months, for example, every 2, 3, or 24
months.

Repeat % Every *

Monthly - 1 | Month(s)

on %k

® Fixedday (O Relative weekday
1 -

End %

No end date -

Select on which day of the month you want
the trigger to run:

* Fixed day, for example, on the first day of
the month.

* Relative weekday, for example, every first
Monday of the month.

Runs every year in the selected month.

Repeat *x Every %
[Yearly - ] [January hd
on %

® Fixedday (O Relative weekday

K -
End %
No end date - ]

Select on which day of the month you want
the trigger to run:
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Option Description

* Fixed day, for example, on the first day of
the month.

* Relative weekday, for example, every
fourth Friday of the month.

Time interval Runs at a specific time interval. Specify the
interval in hh :mm: ss format. For example,
you can create a trigger that runs every 47
hours and 30 minutes (47:30:00).

Does not repeat Runs only once at the specified date and
time.

d. If you want to end the schedule and stop the trigger from running after a certain date, from
End, select On this day.

e. To end the schedule, specify an end Date and time.

6. Optional: Specify the conditions for the trigger to run.
Use the Conditions tab to add a condition when the playbook should run. You can also limit
the number of records to be processed, up to 1000, and sort the records by a field.

7. Select Save and close.

Result
Your scheduled trigger is created.

Related topics

Triggers

Stages and activities

In Playbook, an activity represents one step in your overall business process. You can sequence
many activities together in the stages of your process.

Stages

Group activities by the stages of your business process, and sequence activities in an

order that makes sense for your cross-enterprise workflow. A stage is made up of many
sequenced activities that are grouped in a logical way. In the Playbooks Board view of the design
environment, you can add a stage to your playbook by clicking + Add stage. In the Diagram view,
select the + icon on connectors (lines) to add a stage.

Activities

In Playbooks, an activity represents one step in your overall business process. In the system, an
activity is one instance of an activity definition. For more information on activity instances and
activity definitions, see the Playbook Experience and activity definitions.

Adding an activity to your playbook

In the Playbooks Board view of the design environment, select + Add activity to open the activity
picker. In the Diagram view, select the + icon on connectors (lines) to open the activity picker.
In the activity picker, you can search for an activity to add or select one from the list of Common
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Activities. To choose an activity for a custom application, first select the application and then
select the activity from the resulting list within the picker.

Additionally, you can add an activity just using an automation asset.

If there isn't an activity that fits your use case, you can create your own activity definition to add
to the activity picker. For more information, see create an activity definition.

Interactive and Non-Interactive activities

Activity categories include:
Interactive Activities

When an interactive activity runs, it prompts a user for input in your playbook as it
runs. For more information, see Interactive activities.

Non-Interactive Activities

When a non-interactive activity runs, it runs entirely behind-the-scenes and
requires no user input. For more information, see Non-Interactive activities.

Optional Activities
An optional activity can be inserted by agents and fulfillers during a playbook run.
For more information, see Optional activities.

Stage and activity details

When you select an activity, the side panel should open. Under the Details tab of the side panel,
you can add names, descriptions, and start rules to the stages and activities in your playbook.
Click the show or hide additional options button to show or hide additional properties for your
currently selected stage or activity. The basic details for each stage and activity include:

Label
You can enter a display name for your stage or activity. This name appears during
playbook runtime.

() Note: Keep your stage and activity names brief, as the system truncates long
names.
Description

Optionally, enter a description for your activity or stage. This description only
appears within Playbooks and isn't visible during playbook runtime.

Start Rule

Under Schedule > Start Rule, select a start rule for when your stage should start
running:

« When process starts: Your stage starts running as soon as the playbook starts.

« After specific stages: Your stage starts running after specified stage(s) have
finished running.

Under Schedule > Start Rule, select a start rule for when your activity should start
running:

« When stage starts: Your activity starts running as soon as its stage starts running.
Your stage starts running when your playbook is triggered.

« After specific activities: Your activity starts running after specified activities have
finished running.

© 2026 ServiceNow, Inc. All rights reserved.

ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries. 69
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Run condition

Conditions that must be met to run an activity or stage. You can use data from prior
activities to build conditions.

Activity inputs

Under the Automation tab of the side panel, each activity has inputs you can configure:

» To change default inputs and outputs for the activity, open and edit the source flow in Workflow
Studio by selecting the Open link icon (‘E,‘) next to the Automation field.

For more information on how to work with the default inputs and outputs for activities in
Playbooks, see Create an action as an activity automation plan.

e Note: You must have the appropriate user roles to access Workflow Studio and
Workflow Studio. For more information, see User access to Workflow Studio flows.

« Inputs are data that you provide so that the activity runs and performs its function
appropriately. For example, a Record activity that notifies a customer of an application
rejection will have message inputs for the email address, subject, body, and more.

« Expected Outputs are displayed at the bottom of the Automation tab.
Creating static and dynamic values for activity inputs

You can add dynamic data to an activity input. Click the data pill picker icon (‘i,‘) and navigate,
or dot-walk, to the data pill whose dynamic value you want to use when your activity runs. You
can select dynamic data from fields in the input record. If your activity has a start rule of After
specific activities, you can also select dynamic data from the outputs of other activities in your
playbook. For more information on dot-walking to related fields and records on the ServiceNow Al
Platform, see selecting fields on related tables using dot-walking &.

@ Note: You can dot-walk to fields in a Reference but not in a Document ID or Sys ID.

The inputs for interactive activities typically provide data that renders in a playbook for an agent
to interact with. The inputs for non-interactive activities can render in a playbook but don't
require any user input in order to run. For more information, see Interactive activities and Non-
Interactive activities.

Design considerations

Refer to these design considerations when working with stages and activities:

Keep ServiceNow Al Platform state models in mind when designing your playbook
Some record types already have state models that describe their life cycle. Use
any existing state model as a template for the design of your playbook. For more
information, see State Management &.

Add and configure a stage in a playbook
Add and configure a stage in your playbook.

Before you begin
Role required: playbook.admin or pd_author

Review Stages and activities.
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Procedure
1. Add a stage.

S ™ S

Diagram

Board

a. Select the + icon after the trigger to add the
first stage in your playbook.

b. In the mini-picker, select the dotted square

icon. -

In Board view, click + Add stage.

Your new stage appears, and the Stage properties panel opens.

2, Fill in the following fields.
a. Provide the basic details of the stage.

Required inputs

Label

Description

Run condition

Start Rule

Enter a unique, user-facing name for your
stage. This name appears to agents and
fulfillers during runtime of your playbook.

Optionally, enter some descriptive details
about your stage.

After the stage starts, the stage runs only if
specific conditions are met.

Choose when you want your stage to start
running. Options include:

= When playbook starts: Your stage starts
running as soon as the playbook starts.

= After specific stages: Your stage starts
running after specified stage(s) have
finished running.

b. Optional: Show additional options in the activity for even more granular control.

A Warning: Changing the advanced property fields of an activity can potentially break
your automation. Make sure you understand how the playbook and its activities flow

before you make changes.

N ™ S

Display order
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Description

Specify a duration of time to wait before run

Start with delay ning an stage whose start rule and conditions
have been met. For more information, see
Start with delay input properties.

3. Under the Runtime permissions tab, add sets of users, user groups, user criteria and roles,
and define whether they can add optional activities to the stage or restart the stage and its
activities.

4, Click Save and close to finish adding the stage to your playbook.
You can continue to add more stages to your playbook and fill in fields as described in the

previous steps. In the Board view, use the Stage actions menu : to add stages between
existing stages.
Stages are created.

What to do next
Add and configure your activities.

Activity definitions

Activity definitions describe how the activities in your playbook get the data that they need when
your playbook runs.

Activity definitions provide default configurations and values for your activities so that they
can run properly when your playbook is triggered. Each activity definition contains some basic
configuration details, as well as an automation plan and activity experience.

The Activity Definition [sys_pd_activity_definition] table lists the definitions for the activities that

you can add to a playbook in Workflow Studio. To access these activity definitions, navigate to
Process Automation > Process Automation Administration > Activity Definitions.

Fields

Each activity definition record has these basic fields:

Field Description

Label Name of the activity to display to users in
Workfow Studio.
Table Name of the table whose records the activity

can access as inputs. Typically, this table is
either the Task [task] or Global [global] table.

Application Application scope that the activity can run in.

Accessible From Options include:

« All application scopes - Users can access
this activity from any application scope.

« This application scope only - Users can
access this activity from the application
scope that you specify in the Application
field only.
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Description
Description Optional description for the activity.
Required Roles A list of user roles that are allowed to access

activities that use this activity definition.

Automation plan

Each activity definition has an automation plan. The automation plan for an activity definition
specifies:

« The Workfow Studio flow or action, which drives the activity's automation

« The activity's inputs, which are the data that the activity needs to run your playbook

Activity designers can configure the visibility of each activity input.
Include in standard modal

Hides the input from the properties panel. Playbook designers can only see the
input from the standard modal when they select the Show advanced properties
option.

Include in standard modal and configuration panel

Displays the input in the properties panel. Playbook designers can also see the
input from the standard modal when they select the Show advanced properties
option.

Admin visibility only

Hides the input from users who do not have the admin or playbook.admin roles.
Activity experience

Each activity also has an optional activity experience. The activity experience specifies

an experience type, associated record, and details for what data to render in the activity's
associated playbook card. Activity experience configurations only apply to activities that you add
to a playbook which has an associated Playbook user experience.

Experience type

An experience type defines the data, or properties, that describe how the activity
renders as a playbook card at runtime. For example, a Record experience type

tells the system that the activity can display a title, tagline, description, footer, and
service level agreement (SLA) information in the Playbook card when your activated
playbook runs. For more information, see Ul Layoults.

Associated record

The associated record defines the record whose data can render within a Playbook
card at runtime. The associated record is dynamic, which means that it changes
frequently as the playbook progresses. Because of this dynamic nature, you may

want to use the data pill picker (‘i.‘) to map the associated record to output record
data within the underlying subfow or action specified in the automation plan.

Data to render in the Playbook card

You can specify the data to render in the Playbook card in the sections under the
Associated Record section. To add dynamic data to fields that render in this user-

facing view, use the data pill picker & next to a data field and navigate, or dot-walk,
to the appropriate data pill. The data pill should point to data within the subflow or
action specified in the activity definition's automation plan.
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() Note: An activity experience contains many sections where you can specify
the data to appear within the Playbook card. These sections vary depending
on the experience type that you select. For example, a Record experience type
has Details, Form, Attachments, and Features sections, while a Knowledge
experience type has Knowledge, Details, and Features sections. For more
information, see Ul Layoults.

Actions to render in the Playbook card

You can specify the Playbook actions that you want to render in an activity's
Playbook card using the Playbook Experience Action Assignment Map related list. A
Playbook action displays as a button in the Playbook card's footer. Playbook actions
can run server scripts, dispatch client actions, or render Ul components. For more
information.

To add a Playbook action to your activity definition, select New in the Playbook
Experience Action Assignment Map related list. Then, choose a Playbook action
from the Action Assignment list. Next, choose a Playbook user experience that you
want the Playbook action to appear in from the Playbook Experience list, and then
click Submit.

Design considerations

Refer to these design considerations when working with activity definitions:
Avoid calling triggered Workfow Studio Aows in an activity's automation plan

To prevent unintentionally running a flow outside of Playbooks, you can use only
subflows or actions in activity automation plans. Alternatively, you can set the flow's
trigger to only run if not already running. For more information, see Workflow Studio
flow trigger types.

Specify default input values in your activity definitions

Preconfiguring default input values for your activity definitions reduces the time and
complexity needed for a playbook owner to create a playbook.

Create an activity definition

Specify the action or subflow you want an activity to run. Configure the inputs you want playbook
designers to set when adding the activity to a playbook. Select the experience you want end
users to have when the activity runs.

Before you begin

« Create a Workflow Studio subfow or action that you want to use as the automation plan for
your activity. For example, see Create an action as an activity automation plan.

» Make sure to set your current application to the application that you want your activity to run in.
For more information, see Application picker @.

« Role required: admin, playbook.admin, or pd_content_author

Procedure
1. To start creating a new activity definition, do one of the following:

o Navigate to Process Automation > Process Automation Administration > Activity
Definitions. Then in the context header, click New.

o Follow the steps to Create a playbook. Then in the Playbooks activity design space, click
Add an activity > Create a new activity.
The Activity Definition form view appears.
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2, Fill in the Activity Definition form fields.

Enter a unique name for your activity.

Label This name appears in the playbook in both
the Workflow Studio Playbooks builder as
well as during playbook runtime.

Select a table whose records the activity can
access as inputs. When adding inputs to your
activity in the Workflow Studio Playbooks
builder, you can dot-walk to dynamic record
data from this table. See Dot-walking to data
Table G T
@ Note: The table specified for a play
book's triggering input record overrides
the activity definition table at design
time. See Triggers

Optionally, enter some descriptive details

Description about your activity.

Choose one of the following options:

o All application scopes - You can add this
activity to a playbook in any application

Accessible From scope.

o This application scope only - You can on
ly add this activity to playbooks within the
same application scope specified in the Ap
plication field.

Add roles that are allowed to access activities
that use this activity definition.

Required Roles

Required Roles

Select target record Q, |

@ Note: Users who can view the play
book but who do not have the required
role to access activities with this activity
definition will have a read-only view of
these activities.
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3. Under the Automation Plan section next to the Flow or Action field, click the lookup

documents using list icon ( a ).
The Select the document screen appears.

4, In the Table Name list, select one of the following options:
o To use a Workflow Studio subflow to automate your activity, select Flow.
o To use a Workflow Studio action to automate your activity, select Action Type.

(] Note: You can only use published actions or subflows for an activity definition's
automation plan.

5. Next to the Document field, click the lookup documents using list icon (™).
The Flows or Action Types screen appears.

6. From the list, select the subAow or action that you want to use to automate your activity.
7. Select OK.

8. From the list, select an Ul Layout for the properties and components that you want your activity
to use when it renders in a user-facing view of your playbook.
For more information, see Ul Layoults.

9. Click Submit to save and create your activity definition record.
The Activity Definitions list view appears.

10. Under the Label column in the list, select your activity definition.
The Activity Definition form view appears.

11. Select the Automation Plan section.
The system displays the available variables for the action or subfAow. The Workflow Studio
Playbooks builder displays a variable for each action or subflow input.

12. For each variable, configure the default value you want each variable to have.
Leave a variable blank when you want a playbook designer to configure the value when adding
the activity to a playbook.

13. For each variable, select where it is visible.

Only displays the variable as an input from

Include in standard modal the Advanced properties modal.

Displays the variable as an input in the prop
erties panel and the Advanced properties
modal.

Include in standard modal and configura
tion panel

Only displays the variable as an input from
Admin visibility only the Advanced properties modal to users that
have the admin or playbook.admin roles.

Playbook designers can only set values for variables that they have access to.
14. Select the Activity Experience tab.
15. Next to the Ul Layout field, select the list icon (™ ).
The Activity Ul Layouts list appears.
16. Select the Ul Layout you want to use.
17. Right-click in the header of the activity definition, and select Save.
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18. Under the Associated Record section, select values for the Associated table and Associated
record fields.
These values are typically Record and Table Name outputs for the Workflow Studio subfow
or action specified in your activity's automation plan. For example, you can click the data pill

picker icon (‘g‘) next to the Associated record field and dot-walk to the Table Name output by
selecting VL > Add Comment > Outputs > task > Approval.

The system associates a record with your activity so that, when the activity runs, it knows
which record's data to output.

— Activity Definition -
=~ Add Comment & = Update
¥ Label ‘AddCcmmen( | Application  Global 0}
Table ‘G|Db3| [global] A | 3 Accessible From ‘ All application scopes V|
Required Roles | & | playbook.write
Description
Automation Plan | Activity Experience
Ul Layout | Record | Q | 0]
L3
Associated Record v
Associated table | --None - v ‘ |flj |
[ Show as additional property for admins only v
Associated record  (empty) Q ‘ ‘@’ ‘
‘ Show as additional property for admins only "‘
Experience Status Table | Flow Data[sys_flow_data] = ‘ | ® |
[Show as additional property for admins anly v
Experience Status Record Q ‘ ‘ ® ‘

[ Show as additional property for admins only |

19. If you want to set up the default activity data that renders in your playbook during runtime,
enter the values for that data in the other sections under Activity Experience.
The sections and fields that appear under Activity Experience vary depending on the Ul Layout
that you select. For more information, see Ul Layoults.

20. Click Update to finish creating your activity definition.

Resulit

You can now select your custom activity from the activity picker in the Workflow Studio Playbooks
design environment. Select the appropriate application scope for your activity to view it in the
picker.

Create an action as an activity automation plan
Create an example action to configure and run as an activity from Playbooks.

Before you begin
Role required:
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« This task requires some knowledge of creating flows in Workflow Studio environment. For more
information, see Building flows.

« This task requires some knowledge of server-side scripting. For more information, see Server-
side scripting &@.

e admin

About this task

Each activity definition requires an automation plan to run Workflow Studio content. The
automation plan tells the Workfow Studio Playbooks builder what input values to use when
running an action or subflow. An automation plan can specify static default values or can prompt
playbook owners to provide dynamic values when they add an activity to a playbook.

In this example, you create a reusable Workflow Studio action to use as an activity's automation
plan. The action you create associates a Task [task] record with a parent record.

Procedure
1. Navigate to All > Process Automation > Flow Designer.

2. In the main header, click + New > Action.
The Action Properties screen appears.

3. In the Action Properties screen, fill in the following fields:

Action

Name Enter Associate Record with
Parent.

Application Leave Global selected.

Accessible From Leave All application scopes selected.

4. Click Submit.
The Workflow Studio design environment appears.

5. Under the Action Outling, click Inputs.

6. In the Action Input header, click + Create Input, and then fill in the following fields:

Action
Label Enter Record.
Name Enter record.
Type Select Reference.Task[task]

7. In the Action Input header, click + Create Input, and then fill in the following fields:

Description
Label Enter Parent Record.
Name Enter recoxd.
Type Select Reference.Task|[task]
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8. Click the add a new step icon (‘e).
The Select Step to add screen appears.

9. Under ServiceNow Data, select the Update Record step.
The Update Record step appears in the Action Outline under Inputs.
10. In the Record field, click the data pill picker icon (‘i,‘), and then dot-walk to Inputs > Record.

11. Under Field Values, click +Add Field Value, and then select Parent from the list.

12. Next to the Parent field, click the data pill picker icon (BJ), and then dot-walk to Inputs >
Parent Record.

13. Under the Action Outline, click Outputs.
14. Under Action Output, click + Create Output, and then fill in the following fields:

Field Action

Label Enter Recoxd.
Name Enter recoxrd.
Type Select Reference.Task[task]

15. In the Action Output header, click + Create Output, and then fill in the following fields:

Action
Label Enter Parent Recozxd.
Name Enter record.
Type Select Reference.Task[task]

16. In the Action Output header, click Exit Edit Mode.

17. Next to the Record output's Value column, click the data pill picker icon (‘i,‘), and then dot-
walk to Inputs > Record

18. Next to the Parent Record output's Value column, click the data pill picker icon (EJ), and then
dot-walk to Inputs > Parent Record.

19. In the main header, click Save > Publish to make your action available to add to an activity
definition's automation plan.

Result
You can now add your custom Workflow Studio action to an automation plan for your custom
activity definition.

What to do next
Add your custom action to an automation plan when you Create an activity definition.

Ul Layouts

A Ul Layout describes what properties and components to use when an activity renders as a card
in a Playbook Experience.
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When creating an activity definition, you must select an Ul Layout to associate your activity
definition with. Playbooks come with the following Ul Layouts that are available in your instance
by default:

« Create Record

« Questionnaire

« Instructional

« Knowledge

o List

» Record

» Record generator

Depending on the Ul Layout associated with the activity, different sections and fields appear

under the activity definition's Activity Experience. These sections and fields let you set up the
activity data that renders during the runtime Playbook Experience.

() Note: All Ul Layouts, except for Record generator, display an Associated Record section.
For information on how to set up or edit the Associated Record section in an activity
definition, see Create an activity definition.

Create Record

If you choose the Create Record Ul Layout, the following sections appear in the Activity
Experience section for your activity definition:

Associated Record
Displays the following fields:
« Associated table
» Associated record
« Experience Status Table

« Experience Status Record

Details
Displays the following fields:
« Tagline
e Icon
« Title
« Description
« Pending State Title
» Pending State Description
» Record fields

e Footer

Form

Displays the following fields:
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e Form View
e Form fields

« Template Fields

Attachments
Displays the following fields:
o Attachment source

« Attachments read only

Features
Displays the following fields:
» Show SLA
« Show Checklist

e Is Automated

The Create Record activity that comes with the application uses this Ul Layout.

In an activity definition

In Workflow Studio, the fields are configured on the Ul Layouts tab of the side panel:

In WorkAow Studio

In a running playbook, your configurations are reflected:

In a running playbook

Questionnaire

If you choose the Questionnaire Ul Layout, the following sections appear in the Activity
Experience section for your activity definition:

Associated Record
Displays the following fields:
« Associated table
» Associated record
« Experience Status Table

« Experience Status Record

Details
Displays the following fields:
« Tagline
« Icon
« Title

« Description
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« Pending State Title
« Pending State Description
 Record fields

» Footer

Form
Displays the following fields:
« Form View

e Form fields

Attachments
Displays the following fields:
« Attachment source

« Attachments read only

Features
Displays the following fields:
» Show SLA
« Show Checklist

e Is Automated

Instructional

If you choose the Instructional Ul Layout, the following sections appear in the Activity Experience
section for your activity definition:

Associated Record
Displays the following fields:
« Associated table
« Associated record
« Experience Status Table

« Experience Status Record

Details
Displays the following fields:
« Tagline
* Icon
« Title
« Description

e Footer

Features
Displays the following field: Is Automated
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Knowledge

If you choose the Knowledge Ul Layout, the following sections appear in the Activity Experience
section for your activity definition:

Associated Record
Displays the following fields:
« Associated table
» Associated record
 Experience Status Table

« Experience Status Record

Knowledge
Displays the following fields:
« Knowledge Table

« Knowledge Record

Details
Displays the following fields:
« Title

» Footer

Features

Displays the following field: Is Automated
List

If you choose the List Ul Layout, the following sections appear in the Activity Experience section
for your activity definition:
Associated Record
Displays the following fields:
« Associated table
« Associated record
« Experience Status Table

« Experience Status Record

Details
Displays the following fields:
« Tagline
e Icon
« Title
« Description

e Record fields

List Details
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Displays the following fields:
o List Title

 Table

« List Query

« Ul View

o Columns

» Max Columns

e Row Count

Features

Displays the following field: Is Automated

Record

If you choose the Record Ul Layout, the following sections appear in the Activity Experience
section for your activity definition:

Associated Record
Displays the following fields:
« Associated table
« Associated record
« Experience Status Table

« Experience Status Record

Details
Displays the following fields:
« Tagline
« Icon
« Title
« Description
« Pending State Title
« Pending State Description
« Record fields

« Footer

Form
Displays the following fields:
« Form View

e Form fields

Attachments
Displays the following fields:
« Attachment source
o Attachments read only
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Features
Displays the following fields:
« Show SLA
« Show Checklist

e Is Automated

Record generator

Activities with a Record generator Ul Layout create a record during runtime, and redirect users
to the record. For example, in this activity, after an agent selects the Continue button, a record is
created and they are taken to that new record.

@ In Progress ® Priority <~

Provide incident details

Caller %
| David Miller ° a

Short description s

‘ The email server isn't responding ‘

If you choose the Record generator Ul Layout, the following sections appear in the Activity
Experience section for your activity definition:

« Template Fields
« Process Definition Scoped Name
« Associated Table

e Form View

Guided Decision

() Note: The Guided Decision Ul Layout is available with a subscription to App Engine or
Customer Service Management (CSM). For more information on how to enable this activity
for use in Playbooks, see Activate Playbooks for Customer Service Management (CSM).

If you choose the Guided Decision Ul Layout, the following fields appear in the Activity
Experience section for your activity definition:

e Decision Tree Execution

¢ Decision Tree

Add and configure an activity in a playbook

Add and configure an activity in your playbook.

Before you begin
Role required: playbook.admin or pd_author

Review Stages and activities.
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Procedure
1. Add an activity.

a. Select the + icon in the first stage.

b. In the mini-picker, select the square icon
U to add an activity.

Diagram c. In the activity picker, search for an activity

to add.

© Note: Select the application first,
and then the activity from the result
ing list.

a. Select + Add activity in the first stage.

b. In the activity picker, search for an activity

Board to add.

@ Note: Select the application first,
and then the activity from the result
ing list.

Your new activity appears in the stage, and the Activity properties panel appears.
2. Under the Details tab, fill in the details of your activity.

a. Provide the basic details of the activity.

Required inputs

Label Enter a unique, user-facing name for your
activity. This name appears to agents and
fulfillers during runtime of your playbook.

Description Optionally, enter some descriptive details
about your activity.

Start Rule Choose when you want your activity to start
running. Options include:

* When stage starts: Your activity starts
running as soon as its stage starts
running. Your stage starts running when
your playbook is triggered.

= After specific activities: Your activity
starts running after specified activities
have finished running.

a. Optional: Show additional options the activity for even more granular control.

arning: anging the advanced property fields of an activity can potentially brea

W. Ch the ad d ty fields of tivit tentially break
your automation. Make sure you understand how the playbook and its activities flow
before you make changes.
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Define the order in which this activity will ap

Display order pear during a playbook run.

After the activity starts, the activity runs only if

Run condition . -
specific conditions are met.

Specify a duration of time to wait before run
Start with delay ning an activity whose start rule and condi
tions have been met. For more information,
see Start with delay input properties.

Choose what this activity does when a play
book is restarted:

o Skip on restart: Skip this activity when the
run is due to a restart.

© Run always: Always run this activity, includ
ing first runs.

Restart rules

o Skip on First run: Skip this activity during
the first run.

For more information, see Configure restart

for Playbooks.

3. Open the Automation tab.
Automation, inputs, and outputs sections appear.

Automation
See or open the action, subfow, or low that drives the activity.
Inputs

Configure inputs for the action, subflow, or flow that is driving the activity. Not all
activities require user input.

Outputs
Outputs of the action, subflow, or flow that is driving the activity.

4. Under the Inputs section, define the values of the activity's inputs.

Configure inputs with a hardcoded value, or by dot-walking to a data pill & (‘i,‘) to use data
from previous activities, the playbook trigger, from the playbook parent table, or from the
playbook inputs.

9] Tip: You can use both text and multiple pills in any other rich text or HTML input fields.

5. Open the Ul Layout tab.

Depending on the Ul Layout associated with the activity, different sections and fields appear
under the activity definition's Activity Experience. These sections and fields let you set up the
activity data that renders during the runtime Playbook Experience.

Note: All Ul Layouts, except for Record generator, display an Associated Record section.
For information on how to set up or edit the Associated Record section in an activity
definition, see Create an activity definition.
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6. Optional: Specify if an Al Agent performs the activity, and how.
To learn more, see Configuring Agentic Playbooks.

7. Click Save and close to save the details of your activity.

At any point while in the Playbooks builder, you can add more activities to a stage as described

in the previous steps.

8. Optional: If the activity you want to add is not in the activity picker, create the activity

definition.

a. Under your stage, click + Add activity.
The activity picker appears.

b. Click the Create a new activity button.

c. Fill in the following fields.

Label

Accessible From

Table

Application

Description

Automation Plan

Activity Experience

Enter a unique, user-facing name for your ac
tivity. This name appears to agents and ful
fillers during runtime of your playbook.

Where the activity is accessible from. Make
the activity accessible to other applications
by setting the Accessible from field to All ap
plication scopes. Restrict access by setting
the field to This Application Scope Only.

Optionally, set to the table associated with
the activity.

Read-only field that indicates which applica
tions can use this activity.

Optionally, enter some descriptive details
about your activity.

Select the subflow or action that you want to
use to automate your activity.

Optionally, set the activity's experience type,
which helps to define how the activity renders
in user-facing views of a playbook card at run
time.

9. Click Submit to finish creating your activity definition.

Your activity is defined.

What to do next

Set up the Playbook Experience for you agents and fulfillers.

Automation Assets

Include all automation assets in the activity picker to add a subflow, flow, or action directly to your

playbook without having to create an activity definition.

Use cases

Use automation assets in your playbook if:
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« You need an activity that only requires automation.

« The activity doesn't need to be reusable.

e You don't need a Ul.

If you need a Ul or an activity that is reusable, create an activity definition.

Asset types

When adding an activity, select Include all automation assets in the activity picker to add flows,

subflows and actions.

@ Add activity

Add activity

Q Search Activities

(@ Common Activities

® Global

@' Success Dashboard Core
@' Process Automation Conter
@' Incident Management for S¢
GO Docker Spoke

@' Continuous Integration and
© ITSM Spoke

@' Omni-Experience Standard
@' Task Intelligence for Custo.

Include all automation assets

%} Automated Update Record
%5 Look Up Records

Actions

Gy Add Worknote Link to Conte
% Ask For Approval

% Associate Record to Email
% Copy Attachment

% Create Catalog Task

% Create or Update Record
@ Create Record

% Create Task

No description available.

x

Create a new activity

When adding a flow, subfow, or action, a non-usable activity definition is created behind-the-
scenes.
Start with delay input properties

Specify a duration of time to wait before running an activity or a stage whose start rule and
conditions have been met. Give users time to act during automated playbooks. Give users time to
wait for a specific date and time to complete actions.

Roles and availability

This input is available for all stages and common activities, except for the Placeholder activity.
Users with the admin, playbook.admin, pd_author, or pd_content_author can configure the
properties of this input.

Input properties

Open the activity or stage properties panel, show additional options, and enable the Start with
delay option to configure the following input properties.

Description

Duration Type Choice Option to specify how long

of duration to wait. Options
include
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Input

Wait for
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Type

Template Value

Description

« Explicit Duration: Wait for
a specific time period, such
as 5 minutes.

« Relative Duration: Wait for
a specific time period from
a selected Duration data pill
or date/time value, such as
5 minutes after the playbook
starts.

« Percentage Duration: Wait
for a specific percentage of
a time period between the
start of the activity or stage
and a specified end time,
such as 50%.

© Note: The
percentage value must
be from 0 through 100
only.

Option to set a duration
value manually or to select
a Duration data pill from the

data pill picker ™

« Explicit Duration: Wait
duration in hours, minutes,
and seconds.

« Relative Duration: Wait
duration in hours, minutes,
and seconds before or
after a specific time. Select
Relative Duration to specify
a wait duration from a
specific date.

[ ) Note: Past dates
don't affect the wait
duration.

You can enter a wait value of
up to 999 hours.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
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Input Type Description

@ Note: The actual wait
duration can vary due to
the instance processing
time. The playbook
always waits for the time
that you specify for this
field, but other work in
the queue may add to
the wait time.

Wait for Percentage Integer Percentage of time to wait
from a specified end date
before running an activity or
stage. You can manually enter
an end date or select a date/
time data pill from the data

pill picker . If you select
an end date in the past, the
wait duration is set to 0. This
field is only available when
you set the Duration Type to
Percentage Duration.

During the following schedule Reference.Schedule Schedule used to calculate an

[cmn_schedule] end date that occurs during
your hours of operation. For
example, the calculated end
date for a 10-hour duration
that occurs during a 8-5
weekdays schedule will
always be one or more
business days in the future.
If you leave this field blank,
the calculated end date
does not follow a schedule.
For information on creating
schedules, see Define a
schedule &.

Optional activities

Enable your agents and fulfillers to add additional activities as they go through a playbook.

Overview

Admins enable and add optional activities in the Workflow Studio Playbooks builder, while
agents and fulfillers add and complete optional activities in Playbook Experience.

As an example, if you have a playbook for a Security Incident, a playbook admin could add an
optional activity for a virus scan. When the activity runs, the optional virus scan activity would
take the parent Security Incident record and run third-party virus scanning integrations on
Configuration Management Database (CMDB) assets associated with the parent record. The
security analyst can decide at runtime whether to run a virus scan based on their assessment of
the situation.
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The Aow of working with optional activities:
1. Turn on and add optional activities to a playbook in Workfow Studio.
2, Optional activities are configured like other activities. To see design an automated process.

3. Agents add optional activities in Playbook Experience.

Add an Optional Activity to a playbook
As a Playbooks administrator, add an optional activity to a playbook that Playbook Experience
agents and fulfillers can choose to add and complete during the playbook runtime.

Before you begin
Role required: playbook.admin or pd_author

Procedure
1. Navigate to All > Process Automation > WorkHow Studio > Playbooks.
2. Open the playbook that you want to add an optional activity to.

3. Switch to Board view.

28 Diagram view  (J8 Board view

4. In the upper right-hand corner, toggle on Optional activities.

Optional activities (0) @ ) ©

The optional activities swimlane opens.

5. Add an optional activity.
Global optional activities can be inserted by the agent or fulfiller anywhere in the playbook,
while a stage-specific optional activity can only be inserted within its specific stage.

6. Configure your activity the way that you would configure a regular activity.

Decision activities

Create and define branches with different conditions for different paths between activities.

Before you begin
Role required: playbook.admin

About this task

Add a decision activity to create a decision tree between activities so that agents in Playbook
Experience can troubleshoot if-then situations during runtime. Branches are the different paths
with different conditions that agents can follow. For example, in a credit card approval playbook:
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Servicenaw Process Automation Designer Credit Card Approval Process

» I Credit Card Approval Process @i 8 Disgram view [ Board view @) |
1. Application Review
3| Else =
1.7 Low credit score 1.8 Request
warning approval for credi...
1.1 verify Applicant
Information
2
3 12750
| 1.3 Assess Risk 1.6 Review Intake
Application
1.2 Check credit 1.5 Auto Approval
score
2| 650 @

1.4 Notify manager
regarding credit

In this example, an agent can take different actions for different credit scores during a decision
activity to assess the risk of a credit card applicant.

Decisions are also supported for stages. To learn more, see Decision stages.

Procedure

1. In Diagram view, hover on the object that you want to insert a decision activity next to, and
select the + icon to add an activity.

() Note: Decision activities can only be added in Diagram view, but can be modified and
viewed in Board view.

The mini-picker displays.

2. Select the diamond icon “ to add a decision.
A decision is added with two branches and the side panel opens for configuration.

3. Under the Details tab, fill in the following fields.

Decision details

Label Enter a unique name for your activity. This
name appears in your playbook during
runtime.

Description Optionally, enter some descriptive details

about your activity.

Start Rule Choose when you want your activity to start
running. Options include:
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o When stage starts: Your activity starts
running as soon as its stage starts running.
Your stage starts running when your
playbook is triggered.

o After specific activities: Your activity starts
running after specified activities have
finished running.

Display order Define the order in which this activity will
appear during a playbook run.

Run condition After the activity starts, the activity runs only
if specific conditions are met.

Start with delay Specify a duration of time to wait before
running an activity whose start rule and
conditions have been met. Give users a
specific amount of time to complete actions.
For more information, see Start with delay
input properties.

Restart rules Choose what this activity does when a
playbook is restarted:

o Skip on restart: Skip this activity when the
playbook run is due to a restart.

© Run always: Always run this activity,
including first runs.

o Skip on Ffirst run: Skip this activity during
the first run.
For more information, see Restart a playbook.

4. Under the Branches tab, select your new branch to begin configuring it.
a. Give your branch a unique label.

b. Select the Add Condition button.
The condition builder & displays.
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@ Note: Branches can only be added in the side panel.

#* 1.3 Assess Risk properties

[3 Details -+ Branches

Branch processing approach @

Process any & all branches that are true

¢ Process only the first one that is true

Order Branches . Add new branch
1 = >750 W~

Branch label =

=750

This branch will execute if all conditions are met

Branch condition %

Modify condition

2 2 >650 g A

Branch label %
> 650

This branch will execute if all conditions are met

Branch condition

Modify condition

3 -+ Else Runs when all other branches are false
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c. Select or enter a field, operator, and value.

5. Add more branches as needed.
Branches can only be added via the side panel.

6. If you add two or more branches, select whether to process all branches with conditions that
are met, or just to process the first listed branch with conditions met.
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7. If you selected to Process only the first one that is true, drag and drop the branch that you
want to be evaluated to the top.

1.3 Assess Risk Properties

[2) Details T Branches

Branch processing approach &

() Process any & all branches that are true

(® Process only the first one that is true

Order Branches

':Indd new branch ::'.

i 1 T, >750 U~

Branch label
l >750

This branch will execute if all conditions are met

Branch condition

(: Modify condition)

i 2 T >HS0 U o~

Branch label %
[ > 650

This branch will execute if all conditions are met

Branch condition s

( Modify condition )

3 -3 Else Runs when all other branches are false J

Result
You've added and configured decision branches between activities.
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Decision stages

Create and define branches with different conditions for different paths between stages.

Before you begin
Role required: playbook.admin

About this task

Add a decision node between stages to determine which stage to run next, based on runtime
conditions. For example, in a recruitment playbook, you can have multiple stages for each
interview round and one disqualification stage. After each interview stage, you can add

a decision to automatically select whether to run the next interview round or proceed to
disqualification based on the completed stage.

3. Hiring Manager Review

e

1. Recruiter Review r

» o Yes
3.1 Move to Hiring
Manager Review

& El E >

1.1 Recruiter 1.2 Assess 1.3 Assess
. :

2. Qualified?

>

M Hse

Adding decision between stages help you achieve the following benefits:
Simplified authoring
Reduces the need to copy run conditions across stages.
Improved transparency
Makes branching logic more visible and easier to manage.
Enhanced runtime experience

Displays only the relevant stages to the end user, improving performance and
clarity.

Procedure
1. In Diagram view, select the + icon.

2. From the mini-picker, select the diamond icon © to add a decision.
A decision is added with two branches and the side panel opens for configuration.

3. Under the Details tab, fill in the following fields.

Decision details

Field Description

Label Enter a unique name for the decision.

Description Enter some descriptive details about the
decision.

Start Rule Choose when you want to evaluate the
decision. Options include:
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Field Description

o When playbook starts: The decision starts
running as soon as the playbook starts.

o After specific stages: The decision
starts running after specified stages have
finished running.

4. Optional: Select Show additional options to specify the following optional fields:

Additional options

Field Description

Display order When multiple stages run at the same time,
define the order in which stages appear
during a playbook run.

@ Note: In Workflow Studio, this can also
be helpful when viewing parallel stages
and activities in Diagram view.

Start with delay
(Optional) Specify a duration of time to

wait before running a stage whose start
rule and conditions have been met. For
more information, see Start with delay input
properties.

Restart rules Choose what this activity does when a
playbook is restarted:

o Skip on restart: Skip this stage when the
run is due to a restart.

° Run always: Always run this stage,
including first runs.

o Skip on first run: Skip this stage during the
first run.

For more information, see Configure restart

for Playbooks.

5. Under the Branches tab, select your new branch to begin configuring it.
a. Give your branch a unique label.

b. Select the Add Condition button.
The condition builder & displays.

c. Select or enter a field, operator, and value.

6. Add more branches as needed.
Branches can only be added via the side panel.

7. If you add two or more branches, select whether to process all branches with conditions that

are met, or just to process the first listed branch with conditions met.

© 2026 ServiceNow, Inc. All rights reserved. Q9
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.


https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US
https://www.servicenow.com/docs/access?context=c_ConditionBuilder&version=australia&pubname=australia-platform-user-interface&ft:locale=en-US

servicenow.

8. If you selected to Process only the first one that is true, drag and drop the branch that you
want to be evaluated to the top.

9. Select Save and close.

Resulit
You've added and configured decision branches between stages.

What to do next
Complete and test the playbook. For more information, see Test a playbook.

Questionnaire activity

Collects inputs from a user during a playbook run to use later in the playbook.

The questionnaire activity replaces the Collect User Data activity, but does not require you to
create a data definition. Use the questionnaire activity if:

» You don't have a table already,
» You don't need to run reports on the collected data,

« And you don't need to use the data outside of the playbook.
If you already have a table to store the collected data, use the User Form activity.

Roles and availability

This activity is available as a common activity. Users with the admin, playbook.admin, or
pd_author can add this activity to a playbook.

During a playbook run, you can use data definitions to potentially:
« Collect a shipping address, then reference the address when generating a shipping label.

« Ask the user "yes" or "no" questions, and determine subsequent activities based on the user's
responses.

Common properties
These properties are common to all to activities in Playbooks.

Open the activity properties panel and configure your activity to add values for the following
inputs. If the input value varies, use the pill-picker to show where to get the value. To learn more
about the pill-picker, see Dot-walking examples &.

Input Type Description

Label String Title to display as activity and
playbook card.

Description String Information to display about

activity usage or outcome.

Run condition Condition Builder Conditions that must be met
to run an activity or stage.
You can use data from prior
activities to build conditions.
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Input Type Description

© Note: Select Show
additional options to
see this field.

Start Rule Choice Under Schedule > Start
Rule, select a start rule for
when your stage should start
running:

» When process starts: Your
stage starts running as soon
as the playbook starts.

« After specific stages: Your
stage starts running after
specified stage(s) have
finished running.

Under Schedule > Start Rule,
select a start rule for when
your activity should start
running:

« When stage starts: Your
activity starts running as
soon as its stage starts
running. Your stage starts
running when your playbook
is triggered.

« After specific activities:
Your activity starts running
after specified activities
have finished running.

Start with delay True/False Option to wait for a duration of
time before running an activity
or stage. When enabled, this
input displays the Start with
delay input properties.

© Note: Select Show
additional options to
see this field.

Questionnaire

In the Questionnaire tab, you can:
« Add questions for agents to respond to,

« Edit existing questionnaires.

To learn more about adding or configuring questions, see Create a new questionnaire.
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Inputs

Many of these inputs are common to activities in Playbooks.

After configuring the required inputs for your activity, you can also choose to configure additional

inputs. In the side panel, select Show additional options to display these advanced inputs. For

more information, see Activity experience.

Input Type
Assignment Group for this Reference.Group
Process Step [sys_user_group]

Assigned to this Process Step Reference.User [sys_user]
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Description

Assignment group allowed to
perform this playbook activity.
If you don't set any values

for Assignment Group or
Assigned To, any user can
read and edit the collected
data. The Assignment group
and Assigned to fields limit
who has access to do so. To
specify only individual users,
use the Assigned To field. The
same users do not need to be
specified in both fields.

© Note: By default, these
fields are mapped to
the Assignment Group
and Assigned To fields
of the trigger record.
This means that users
assigned to work on
the parent record have
access to submit, view
and edit the collected
data by default.

User allowed to perform

this playbook activity. If

you don't set any values

for Assignment Group or
Assigned To, any user can
read and edit the collected
data. The Assignment group
and Assigned to fields limit
who has access to do so. To
specify only individual users,
use the Assigned To field. The
same users do not need to be
specified in both fields.
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Input Type Description

@ Note: By default, these
fields are mapped to
the Assignment Group
and Assigned To fields
of the trigger record.
This means that users
assigned to work on
the parent record have
access to submit, view
and edit the collected
data by default.

Outputs

These outputs can provide data to other activities in your playbook. You can access this data as
activity inputs when you configure your activity:

Output Type Description

Record Reference.Flow Data Reference to record
containing collected data. Use
the pill-picker to dot-walk to
Outputs > Record > Vars to
see all collected data. To learn
more about the pill-picker, see
Dot-walking examples &.

Create a questionnaire
Create and insert a new questionnaire for agents to respond to.

Before you begin
Role required: admin, playbook_admin, playbook_author, or playbook_content_author

Familiarize yourself with the questionnaire activity inputs and outpults.

Procedure

1. In diagram view, hover on the object that you want to insert a questionnaire activity next to, and
select the + icon to add an activity.
The mini-picker displays.

2. Select the questionnaire icon [insert inline icon image] to add a questionnaire.
A questionnaire activity is added and the side panel opens for configuration.

3. Under the Details tab, fill in the following fields.

Label Enter a unique name for your activity. This
name appears in your playbook during
runtime.

Description Optionally, enter some descriptive details

about your activity.
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Start Rule Choose when you want your activity to start
running. Options include:

o When stage starts: Your activity starts
running as soon as its stage starts running.
Your stage starts running when your
playbook is triggered.

o After specific activities: Your activity starts
running after specified activities have
finished running.

Display order Define the order in which this activity will
appear during a playbook run.

Run condition After the activity starts, the activity runs only
if specific conditions are met.

Start with delay Specify a duration of time to wait before
running an activity whose start rule and
conditions have been met. Give users a
specific amount of time to complete actions.
For more information, see Start with delay
input properties.

Restart rules Choose what this activity does when a
playbook is restarted:

o Skip onrestart: Skip this activity when the
playbook run is due to a restart.

© Run always: Always run this activity,
including first runs.

o Skip on First run: Skip this activity during
the first run.
For more information, see Restart a playbook.

4., Under the Questionnaire tab, select New questionnaire.

5. Add questions.

(] Note: In the canvas, hover over the activity to see additional actions to edit a
questionnaire.

Parallel branches

Add branches for activities and stages that run in parallel to another branch of activities and
stages.

Before you begin
Role required: playbook.admin or pd_author

About this task

Parallel activities create branches like decision activities. Unlike decision activities, the activities
and stages on a parallel can run on the same conditions as other branches. For example, in this
credit card approval playbook:
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Parallel activities and stages

4. Application Approved

2. Application Approval

L) — L

2.1 Application 2.2 Application 2.3 Application
Analyst Approval Liaison Approval Manager Approval

3. Application Rejected

Ll

3.1 Notify Customer
of Rejection

In this example, agents verify information or identity at the same time as when they check credit
scores. All activities and all stages will run.

Procedure

1. In Diagram view, hover on the object that you want to insert a parallel activity next to, and
select the + icon to add an activity.
The mini-picker displays.

2. Select the parallel icon * to add a parallel branch.
A parallel branch is added.

What to do next
Add and configure the stage or activity that will run at the same time as the other branches of

stages or activities.

Add dynamic inputs to an activity

Configure your activity to show a certain set of fields based on the value of another input, such
as a selected catalog item, selected decision table, or even a REST API response.

Before you begin
Role required: playbook.admin, pd_author, action_designer, flow_designer, admin

Familiarize yourself with the other Workflow Studio components. Dynamic inputs are created with
actions and subflows:

1. In the ServiceNow Al Platform, you will create a new data definition for the dynamic input fields
you want to add to an activity.

2. In Workflow Studio, you will create a data gathering action.

3. Still in Workfow Studio, you will create a subflow or another action with a dynamic input to
consume the first action. This subflow or new action creates a JSON schema that represents
the field(s) you want to add to an activity.

4. In the ServiceNow Al Platform, you will create an activity definition using the subflow or action
with the dynamic input.

Once your activity definition is created, Playbooks authors can add and configure activities with
the dynamic inputs.
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About this task
A dynamic input is an input that changes based on another input. In Workflow Studio Playbooks,
you can present multiple dynamic inputs based on another input.

Example

When a user requests catalog items, you can dynamically present a list of catalog variables
based on the selected catalog item.

1. The first input required is for the Catalog Item field.

Inputs e

Add input data that your activity can use to perform its function in your playbook. Learn more

Catalog Item>x

-

A Missing required fields

2. A user selects iPad mini in the Catalog item field.
Inputs A

Add input data that your activity can use to perform its function in your playbook. Learn more

Catalog Item>

[ipad ] z

Showing 1-2 of 2

iPad mini

iPad pro

3. Two (2) additional fields for color and storage options appear in response to the user selecting
an iPad mini as the Catalog Item.

Inputs —

Add input data that your activity can use to perform its function in your process. Learn more

Catalog Item %
[iPad mini v ]

Choose the colour x

[Space Grey v ]

Choose the storage %

64GB -
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Procedure
1. Navigate to All > WorkHow Studio and select Actions.

2, Create an action to add an input.
The input appears under the Script step > Input Variables section. The JSON under the Script
section should include the new input.

3. In the Outputs section, click Edit Outputs to make sure that the value of the Name field is
output, and that JSON is the selected in the Type drop-down field.

4. Create a subflow with the new input.
5. Navigate to All > Process Automation Administration > Activity Definitions.
6. Open or create the activity definition to add the new input to.

7. Under the Automation Plan tab, make sure the action or flow you created with the new input is
the underlying Flow or Action, and that the new input appears in the Variables section.

8. Change the visibility of the new input from Show as additional property to Always show.

9. Save your changes.
Once your activity definition is created, Playbooks authors can add and configure activities
with the dynamic inputs.

Playbook activity state mapping

Use playbook activity state mapping to override the status of a playbook card.

A playbook card's state comes from the Activity State by default. Activity states come from the
Sub Flow or Flow Action powering the activity.

Activity Definition authors can specify a records to provide the status shown in playbook cards.
This record is referred to as an Experience Status Record. It is specified within an Activity
Definition's experience properties.

Automation Plan | Activity Experience

Ul Layout @ | Record ‘ Q| ‘Z‘

Associated Record

Associated table @ | Flow Data fsys_flow_data] -] #]

[Show as additional property for admins only |

Associated record @) VL*Send Email with user input Activity>1 - Create Flow Data*>Outputs>Flow Data Record

(@]

[Show as additional property for admins only v|

Experience Status Table @ | Flow Data sys_flow_data) -] [#]

[Show as additional property for admins only v|

Experience Status Record ) | VL=Send Email with user input Activity =1 - Create Flow Data=Outputs = Flow Data Record ‘ ® |

[Show as additional property for admins only v|

Any record from any table can be used as an Experience Status Record. Default activity
definitions use sys_How_data records as their Experience Status Record.
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Activity States displayed in card view

@ Complete w

Choose Interaction Type

@ In Progress  Instructional ® Priority  ~

Simple Instruction

This is a simple instruction. Select "Mark Complete” to go to the next step

m Mark Complete

(@ Pending
Wait for Interaction assignment

This activity will become available after the previous activities are completed.

(@ Pending

User Form

This activity will become available after the previous activities are completed.

Default Activity States

Out-of-the-box Default Activity States in sys_fow_data record

Status Flow State

Pending Flow has not started

Ready Flow is

In Progress Flow is running

Complete Flow has finished

Skipped Flow was skipped due to conditions
Error Flow encountered an error
Canceled Flow was canceled

Activity states are used in the following:
« Declarative Action conditions
« Activity Override conditions
» Animations

« Card visual experience

Exceptions

Business logic doesn't always align one-to-one with the flow. The following are examples of
exceptions:
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« An agent clicks Skip on an instructional card. The flow displays as complete, but the business
logic is skipped.

« A flow may never complete if a task is waiting for input from an agent to restart a loop. The
associated task is effectively complete in this state.
Playbook activity state-mapping rules

Map playbook activity states to states from the given experience record.

SerVicenOw All  Favorites @ Home +%

Welcome to Admin Home! =

Manage, monitor, and discover all your day to day administrative actions and tools across the [ﬂétform.

Track what’s important to you

Shared admin dashboard -

Open incidents

®

=

No data available.

There is no data for the selected criteria. Update the configuration or wait for data to become

Open request items @

No data available.

There is no data for the selected criteria. Update the configuration or wait for data to become

b ]

Activity state-mapping rules are required for each Experience Status Table. These rules
determine how to update the status for an experience record whenever a playbook user updates
the state of an activity, such as when they complete an activity.

The out-of-the-box Global Playbook Experience includes default rules for the sys_flow_data and
task tables. These sets of rules are enough for most playbook activities, but additional rules can
be created for custom tables if needed.

Find the default mapping rules under the Status Mapping tab of a playbook experience.
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Status Mapping tab

Configurations (1) | Activity Overrides (6) | Playbook Activity Uls (10)

Y |Order = | Search

Playbook Experience = Global Playbook Experience
[] @  Experience Status Table
task

sys_flow_data

Experience status mapping records

Action Mapping (100) | Status Mapping (2)

@ Actions on selected rows... v | m
Experience Status Field Order = Active
o] true
100 true

1to2of 2

A Experience Status Mapping record pulls the states (Experience Status value) for the given

Experience Status Table. Map from:

» Experience Status to Activity State, or

« Activity State to Experience Status.

The Experience Status to Activity State tab controls which activity state is shown in a card for a
given experience status record value. The Activity State to Experience Status tab controls how
the experience status record is updated when a playbook user updates an activity state, such as

skipping an activity.

Bidirectional status mapping between Aows and playbook activity states

Experience Status to Activity State (8) | Activity State to Experience Status (7)

5 ‘for text * | Search

Experience Status Mapping Record = sys_flow_data
[[] @  Experience Status Record Value

ERROR

CANCELLED

IN_PROGRESS

READY

SCHEDULED

SKIPPED

COMPLETE

PENDING

@ | Actions on selected rows...

Activity Card Value
Error

Canceled

In Progress

Ready

Pending

Skipped

Complete

In Progress

1 toBof8

Experience Status to Activity State (8) | Activity State to Experience Status (7)

hTd |for text ~ | Search

Experience Status Mapping Record = sys_flow_data
[] ©  Activity Card Value

Error

Ready

Pending

Skipped

Complete

Canceled

In Progress
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@y Actions on selected rows...

Experience Status Record Value
ERROR

READY

PENDING

SKIPPED

COMPLETE

CANCELLED

IN_PROGRESS

1 to70f7
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() Note: There is always a default set of activity states, but the set of states for an experience

record depends on the table in your activity definition.

Task Status to Activity State Map and vice versa

Experience Status to Activity State (13) | Activity State to Experience Status (4)

= Y | for text + | Search | &) —_ Actions on selected rows...

Experience Status Mapping Record = task

perience us Record Value ivity Card Value
Q. Experi Status Record Val Activity Card Val

5 Skipped
0o ¢ Complete

7 Skipped

107 Complete

4 Canceled

1 In Progress

-5 In Progress

b Complete

101 In Progress

3 Complete

104 In Progress

8 Canceled

2 In Progress

1 to 13 of 13

Experience Status to Activity State (13) | Activity State to Experience Status (4)

= \Té | for text ~ | Search ) — | Actions on selected rows...

Experience Status Mapping Record = task

[[] @ Activity Card Value Experience Status Record Value
Canceled 4
Skipped 7
In Progress 2
Complete 3
1 to4of 4
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6 Note: The number values shown indicate these t_ask statuses:

Pending | -5
2| v Open|1 a
i€ Work in Progress | 2
Closed Complete | 3
Closed Incomplete | 4
Closed Skipped | 7
Assess | -4
Authorize | -3
Scheduled | -2
Implement | -1
Review | O
Closed Abandoned | 8
Skipped | 5
Resolved | 6
New | 101
Root Cause Analysis | 103
Fix in Progress | 104
Closed | 107

Approval not required | 9

Default playbook activity states will always be set.

Ready

*k Activity Card Value C)RALELG L]
In Progress
Complete
Skipped
Error

Canceled
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Playbook activity state-mapping permissions

User permissions must be assigned to allow agents to complete or skip activities in playbook
using activity state mapping.

Can Complete and Can Skip permissions in declarative action client conditions

[sys_declarative_action_assignment.list] are determined whenever an activity is fetched based
on the following conditions:

» Experience Status Record must be defined

« Users must have write access on Experience Status Record

« Activity State Mapping rule set must exist for Experience Status Table
« User must have write access on Experience Status Field for that table

« Activity State to Experience Status mapping rule must exist for that corresponding operation:

Playbook Activities

Activity State

Can Complete Complete

Skip Skipped

If the permissions are not valid, users cannot perform that operation. The corresponding
declarative actions that use the Can Complete and Can Skip client conditions will not display.

Conditions | Server Script | Confirmation Settings

Script Condition | gs.hasRale(admin’)

Client Conditions (2 [ Add Filter Condition H Add OR Clause I

All of these conditions must be met

Associated record
Associated table
Can Complete
Can Restart

Can Skip

Context ID

Experience Status Record

Experience Status Table

== value --

|Activitv State - | is not v‘l‘ Complete V| [ AND I
|Playbook Status - | is v| In Progress v| l AND l
| -- choose field -- - | oper -- value --

Record Conditions (& [l al |E]

Requires create access (2 |
Requires read access @ [
Requires write access (2

Requires delete access @ |

() Note: If a user does not have read access on the Experience Status Field of the
Experience Status Record, the default activity state will be used instead. The default
activity state is the state of the flow powering the activity.

Playbook variants

Use one playbook for multiple scenarios.

Create different variations on top of a base playbook for multiple use cases instead of

duplicating and modifying playbooks, or relying on one-time workarounds that use complex run
conditions and branching.

Consider using playbook variants if you have similar business processes that change based on
specific factors. For example:
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« Processes and requirements for different locations (regions, countries, municipalities,
organizations, etc.).

o Banking SLAs differ by region, USA is 30 days and EMEA is 45 days with potential for further
variation by country.

o Card disputes with variance by network: Visa, Mastercard, Discover, etc.
» Managing hiring flows that vary by industry, department, and job titles.
« Business processes and requirements for different users and roles.

« Business processes and requirements for different kinds of applications, such as licenses and
permits for different kinds of businesses, etc.

To get started, see Create a playbook variant.

General Guidelines
Create, run, troubleshoot, and monitor your playbook variants more effectively. Use these
guidelines to optimize the performance of your playbook variants.

Evaluate your variants

By default, the variants are evaluated at the start of the playbook, from the top down
at every level. The first variant that meets the trigger conditions will run. However,
you can choose to evaluate the variants after certain activities are complete. You
can leverage the output generated in the completed activities to decide which
variant to run. This gives you more flexibility in designing the playbook and its
variants.

Pay attention to property overrides
As you make changes to your variants, related activity configurations that are
inherited from parent variants (such as start rules or display order) may be

overridden. The overridden link and label appear next properties that are no longer
synced with the parent variant or playbook.

& Re-sync activity property

Start rule L Overridden
Define when the system will begin to process your activity. Learn more

When stage starts

e After specific activities

Starts after

3.2 Evaluate coding test x

Check all properties to ensure they are still configured as you want them. Re-sync
properties to be the same as in the parent, if needed.

Don't create variants if you want to change stage properties

Stage overrides are not currently supported in playbook variants.

Create a playbook variant

Create variations of a playbook for different use cases.
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Before you begin
Role required: admin or playbook.admin

Procedure
1. Navigate to All > WorkHow Studio.

2. Open the playbook that you want to create variant for.

3. Select the variant icon ( E ) to open the variant panel on the left.

4. Select Add a variant.

5. Fill in the following fields.

Enter a unique, user-facing name for your play
Variant name book variant. This name appears to agents
and fulfillers when this variant runs.

In the condition builder, select or enter a field,
operator, and value.

Conditions (] Note: To learn more about condition
builders, see B B ED & B B2

Add more conditions for this variant to run, as
needed.

Example
In this example, we want to create different versions of a base recruitment process playbook

for individual contributors (IC) and managers. In the condition builder, we indicate whether the
variant is for management roles or not.
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IC variant

Add a playbook variant

Variant name

L

Variant conditions

Define when a variant is used in the playbook. The playbook evaluates variant conditions after parent conditions are met. You cannot
activate the playbook with missing variant conditions.

Recruitment process demo variant condition(s)

Conditions x

Build a filter by adding conditions that contain a field, operator, and value(s).

[ Management V} I is v} [ false '] [ or H and } X

[ + New condition set |

4

Manager variant

Add a playbook variant

Variant name

Manager

Variant conditions

Define when a variant is used in the playbook. The playbook evaluates variant conditions after parent conditions are met. You cannaot
activate the playbook with missing variant conditions.

Recruitment process demo variant condition(s)

Conditions %
Build a filter by adding conditions that contain a field, operator, and value(s).

[ Management v] ll is v | { true v] l or H and l X

|' + New condition set ]

Cancel Create variant

6. Select Create variant.
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You have two new variants of the base recruitment playbook, one for ICs and one for
managers.

]

=  Pplaybook variants @

L w
Quick Find
Tz Base variant | © Create Variant |
© IC P e
L3
= Manager .

The color of the canvas border corresponds to the color of the variant that is open.

() Important: The order of your variants is important. Variants are evaluated in the order
that they are listed in the panel, from top to bottom. To learn more about reordering your
variants, see Re-order playbook variants.

7. As you make changes to your variants, make sure all activity properties are still configured as

needed.
Override properties for an activity if they should be different from the parent playbook.

{72 Override activity property

Activities that are the same as in a parent playbook are grayed out. If you change or add an
activity, it is shown in full color.

@ Note: For more general guidelines, see General Guidelines.

8. Optional: Add a child variant to a variant.

a. @ Note: You can nest child variants up to 6 levels.
Hover over the variant in the variant panel, and select the kebab menu to open the action
menu.

b. Select Add child variant.

c. Fill in the following fields.

Field Description

Variant name Enter a unique, user-facing name for your
playbook variant. This name appears to
agents and fulfillers when this variant runs.

Conditions
(Optional) In the condition builder, select

or enter a field, operator, and value. To
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Field Description

learn more about condition builders, see
Condition builder &.

Add more conditions for this variant to run,
as needed.

@ Note: Child variants automatically
inherit the conditions of the parent
variant.

Example

In this example, we want to create a child variant of the Manager variant for recruiting senior
managers and above. We add an extra condition to specify that this particular Manager child
variant runs for levels M4 to M6 manager roles.

Add a playbook variant

Variant name s

Sr. Manager +

Variant conditions
Define when a variant is used in the playbook. The playbook evaluates variant conditions after parent conditions are met. You cannot
activate the playbook with missing variant conditions.

Manager variant condition(s)

Conditions *

Build a filter by adding conditions that contain a field, operator, and value(s).

Level between v | [ics/ma(1c7ime | [or |[ and | x

+ New condition set |

9. Optional:

Follow step 8 to add a variant at the same level as another variant (a sibling variant), but
choose the Add sibling variant option instead.

s Basevariant | @CreateVariant | @ o4 gibling variant
T IC ® Add child variant
= Manager &  vrUnfavorite

@ Edit properties
W Delete
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10. Optional: Edit a playbook variant's conditions.

a. Hover over the variant in the variant panel, and select the kebab menu to open the action
menu.

b. Select Edit properties.

11. Optional: To save a variant as a favorite, see Save a playbook variant as a favorite.

What to do next

Set variant evaluation point

Set variant evaluation point

Set a point in your base playbook after which the variants are evaluated and run.

Before you begin
Role required: admin or playbook.admin

About this task

Instead of evaluating the variants at the start of your playbook, you can choose to evaluate
variants after certain activities are complete in the base playbook. For example, in a recruitment
playbook, you can run different variants such as Manager, Senior Manager, or Individual
Contributor, based on the candidate profile or interview feedback during one of the stages. This
gives you more flexibility in designing and building your playbook.

If you do not specify any evaluation point, the variants are evaluated at the start of the playbook
based on the trigger conditions.

To insert an evaluation point, make sure that:
» The playbook does not have any variant activity before the evaluation point.
« Any prior activity does not overwrite the value of the evaluation point.

« The variant condition does not refer to any activity after the point.

Procedure
1. Navigate to All > Workfow Studio.
2, Open your playbook with variants.

3. In Diagram view, select + after the activity where you want to evaluate the variants.

4. From the mini-picker, select the variants icon ( = ) to add variant evaluation point.

© 2026 ServiceNow, Inc. All rights reserved. 119
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

1. Recrulter Review
»

el

1.1 Recrulter 1.2 Assess 1.3 Assess
reviews resume qualifications management..,
» | » |

5. To move the evaluation point to a different location:
a. Select the evaluation point.

1. Recruiter Review
>

1.1 Recruiter 1.2 Assess 1.3 Assess
reviews resume qualifications management...

» >

b. Onthe Move the global variants evaluation pointdialogbox, select one of
the following.

N ™ S

Evaluate all variants at the beginning of the | Moves the evaluation point to the beginning
playbook of the playbook.

Displays a list of valid locations in the play
Evaluate children after field book and moves the evaluation point to the
selected location.

What to do next
Test the playbook to make sure that it's working as expected. See, Test a playbook
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Re-order playbook variants
Change the order in which playbook variants are evaluated.

Before you begin
Role required: admin or playbook.admin

About this task
Playbook variants are evaluated from the top down at every level. The first variant that meets

conditions will run.

Procedure
1. Navigate to All > WorkHow Studio.

2, Open the playbook with the variants that you want to re-order.

3. Select the variant icon ( E ) to open the variant panel on the left.

4. Drag and drop the variants to a new place within their level.

= Pplaybook variants

= b

Quick Find

T= Base variant | G Create Variant | o
= IC .

v T2 Manager : B

—_—
L]

T Sr"‘f Manager +

Variants cannot be moved to different levels. They can only be reordered at the sibling level.

Save a playbook variant as a favorite
Save a playbook variant as a favorite for quick reference.

Before you begin
Role required: admin or playbook.admin

Procedure
1. Navigate to All > Workfow Studio.

2. Open the playbook with the variant that you want to save as a favorite.

3. Select the variant icon ( = ) to open the variant panel on the left.

4. Hover over the variant in the variant panel, and select the kebab menu to open the action
menu.
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) Workflow Studio Recruitment process de ¢ Recruitment process de
rvbook Playbook

-
-
-
-

Recruitment process demo @i

= Pplaybook variants C

= w

Quick Find
T Base variant @ Create Variant | '@
= IC .
= Manager .

1. Rec

5. Set the variant as a Favorite.

Q Tip: You can also just search for variants in the Quick Find search bar.

Creating and managing Playbooks

Learn how to create and configure a playbook in Workflow Studio.

You can view your list of Playbooks by navigating Process Automation > Workflow Studio >
Playbooks. Opening a playbook allows you to edit it. If there are no playbooks in the list, you can
create a new one by clicking New and selecting Playbook. For more information on creating a
playbook, see create a process definition.

Playbook properties

After you create a playbook, access its properties by opening it, and selecting Properties in the
More actions menu in the upper right corner of the header. In the Additional properties modal,
you can edit the following information:
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Field Description

Label Name of the playbook to display in Workflow
Studio and in a Playbook Experience.

Description Description of what your playbook does.

Conditions Conditions that must be met to run your
playbook.

Run my trigger Option that defines how many times your
trigger can run for your playbook. Choices
include:

» Once: Triggers the playbook once for the life
of the triggering input record.

« Only if not currently running: Triggers
the playbook for every unique change if a
process execution is not currently running.

« For every update: Triggers the playbook
every time the input record is updated,
regardless of whether there has already
been or there currently are any running
process executions.

Run on extended Option to trigger your playbook when record
operations occur on tables that extend the
input table. For example, if your selected table
is the Task [task] table and you select this
option, your playbook triggers when a Problem
[problem] record is created or updated. For
more information, see Table extension and
classes &.

o Note: After you create a playbook, you can't change the trigger's input table or trigger
type.

Design considerations

Refer to these design considerations when working with playbooks:
Avoid duplicating business logic used in Workflow Studio, Workflow, and business rules

Replace separate business logic such as business rules, flows, and workflows with
a consolidated playbook. Make sure that you deactivate any external business logic
you replace to avoid duplication of effort.

Ignore records added or updated by import and update sets

Record triggers ignore records added or updated by applying an update set or
importing an XML file. These operations apply to the entire application or table
rather than an individual record.

Related topics
Designing Playbook Experience

Running Playbooks
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Create a playbook

Enable playbook owners to configure and organize multiple instances of Workflow Studio content
into an automated business process on the ServiceNow Al Platform®.

Before you begin
« Activate Playbooks for your appropriate application.

« Familiarize yourself with the tables and relationships that your application uses for the
playbook that you want to create.

« Make sure to familiarize yourself with any features that your business uses to automate
operations on the ServiceNow Al Platform, such as flows, subflows, and actions.
e Learn how to get started with ServiceNow® Process Automation.

« Role required: admin, playbook.admin, or playbook.write. To learn more about playbook
authoring access in Workflow Studio, see User access to Playbooks in Workflow Studio.

About this task

Procedure

1. Navigate to All > Workfow Studio > Playbooks.
The Workflow Studio landing page appears. Playbooks are shown by default, but you can
toggle to flows, subflows, actions, and decisions.

2. In the upper right corner, click New and select Playbook from the drop-down menu.
The Playbooks builder details screen for a new playbook opens in a new tab.

3. Fill in the following fields.

Enter a unique, user-facing name for your play
Playbook name book. This name appears to agents and ful
fillers during runtime of your playbook.

Optionally, enter some descriptive details

Description about your playbook.

Choose an application scope that you want
your playbook to run in. Selecting Global
Application lets your playbook run in any application
scope. For more information, see Application
(AQ AR~ ARAY A

The builder displays in Diagram view by default, but you can select Board view to switch
views. Switch between views anytime as you build your playbook.

2% Diagram view (]S Board view

4, Select the Start node.
The Playbook properties side panel opens.

5. Under the Details tab, update or fill in the following fields.
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Enter a unique, user-facing name for your play
Playbook name book. This name appears to agents and ful
fillers during runtime of your playbook.

Select the table that you want your trigger
records and other playbook inputs to come

from.
Parent table
@ Note: This field is required for Knowl
edge and Email activities.
Description Optionally, enter some descriptive details

about your playbook.

Limit playbook executions for each parent | Limit the number of times a playbook can run
record to for a single parent record.

Allow this playbook to be restarted during | Allow runtime users to restart the entire play
runtime book during a run.

6. Under the Inputs tab, add inputs for a playbook to launch with.
Inputs defined here are accessible throughout the playbook via dot-walking and dot notation
(e.g. inputs.inputName) and can be used in activity fields, conditions, and Ul elements.

9] Tip: Use this to trigger a playbook with APl inputs instead of trigger records.

7. Under the Runtime permissions tab, add sets of users, user groups, user criteria and roles,
and define whether they can add optional activities to the playbook, restart the playbook or its
stages and activities, or cancel the playbook during runtime.

8. Configure your trigger.

@ Note: You can create a playbook with no trigger, a single trigger, or multiple triggers.

9. Add a stage.
10. Optional: Add a decision stage.
11. Add an activity.

12. Keep adding stages and activities according to your manual playbook.
For an example of how to design an entire digitized process with Playbooks, see Create a
sample playbook.

13. Optional: If you don't see the activity you need to add in the activity picker, create an activity
definition.

14, Optional: Add a decision activity.
15. Optional: Add parallel activities.
16. Optional: Add optional activities.

17. After you've added all appropriate stages and activities to your playbook, select Activate in the
header.
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Activating your playbook publishes it so that it runs when triggered.

() Note: If you change your playbook after activating it, the system saves your changes but
deactivates your playbook. You must click Activate again to publish any new changes to
your playbook. For more information, see Playbook statuses and activation states.

Result

When your playbook's trigger conditions are met, your playbook runs. As a result, the system
creates a Process Execution record and renders user-facing configurations for Playbook
Experience. For an example of how to digitize a manual business process that renders as a
playbook, see Create a sample playbook.

What to do next
Set up the Playbook Experience for your agents and fulfillers.
Test a playbook

Verify that your playbook works as expected by running the playbook with test trigger data.
Identify and resolve all errors before activating your playbook.

Before you begin
« Create a playbook

« Role required: the admin, playbook.admin, or pd_operator roles grant users access to test
playbooks and to view process execution records.

» The Playbook Experience plugin is required to preview a playbook in runtime.

« Plugin required: the Playbook Experience (sn_playbook_exp) plugin grants users access
to test playbooks and to preview playbooks in runtime. Users need a role to view process
execution records.

About this task

Testing a playbook bypasses the normal playbook trigger to run it with the sample data

you provide. Every test you run creates or changes records on your instance. To avoid
unwanted record changes, test playbooks on a non-production instance that contains relevant
demonstration data.

Procedure

1. Navigate to All > Process Automation > WorkFHow Studio > Playbooks.
The Playbooks landing page appears.

2. Open the playbook you want to test.
The playbook details screen appears.

3. Select Test.
The system displays the Test your process modal. The contents of the modal depend on the

type of trigger record your playbook uses.
4, Select a playbook trigger record to use for testing.

() Note: Testing ignores the playbook trigger conditions. You can select any existing
record for testing. If there are no existing records to select, you can create a test record.

The playbook runs as if the selected test record met the playbook trigger conditions.

5. Optional: Create a test record.

a. In the Test your process modal, select Create a new record.
In a new browser tab, the system opens a create record form in the ServiceNow Al Platform.
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b. Enter the new record values.
The fields of a record vary depending on what table your playbook is triggered from.

c. Select Submit.
The system creates the record with the values you specified.

d. Return to the Workflow Studio browser tab with the Test your process modal open in the
Playbooks builder.

e. Close or cancel the Test your process modal.

f. Repeat steps 2-4 and select the test record you created.

6 Note: The system only displays the Create a new record option when there are no
records in the table.

6. Select Run Test.
The system runs the playbook using the record you selected as test data. When the test is

complete, the system displays options to view process execution details and a playbook
preview.

7. View the Process execution details for information about the playbook state, activities run,
and log messages produced.

() Note: This option is only visible to users with the admin, playbook.admin, pd_operator
roles.
The system opens a Process Execution form in a new tab.
8. To see the Playbook preview:
a. Select a playbook experience type.
b. Select View.
@ Note: This option is only visible on instances where the Playbook Experience plugin is
activated.
The system opens a sample playbook in a new tab.
9. Identify and resolve any errors in your playbook.
10. Update and test your playbook until it is ready for release.

What to do next
Publish your playbook to a production instance and activate it.

Enabling playbook restart
Give agents and fulfillers the ability to restart a playbook, stage, or activity.

In the Workflow Studio Playbooks builder, Playbooks administrators enable restart for Playbook
Experience agents and fulfillers. Playbooks can be restarted from the beginning, or from certain
activities or stages during runtime. Playbooks administrators also define what each activity and
stage does when an agent restarts.
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Workfow Studio

In Workflow Studio, Playbooks admins enable restart for playbooks, and define the rules for what
an activity or stage does during restart:

« Skip on restart: The stage or activity only runs during a playbook's initial run. It does not run on
restart.

(] Note: This setting is helpful if you don't want new tasks or records to be created during
a restarted run, because the original execution and resulting record is still relevant.

» Run always: The stage or activity always runs, whether during an initial or restarted run.

« Skip on first run: The stage or activity runs only on restart. It never runs during an initial run.

Playbook Experience

During runtime, agents and fulfillers can restart playbooks from the beginning, or from certain
stages or activities.
@ Note: Playbooks in an active state can be restarted:

« In Progress

Playbooks in a terminal state cannot be restarted:
« Complete
« Error

« Cancelled

Email/Exchange server is down ©

Overview Details Communicate Related records Playbook

Y i A Identification

Incident Response Demo

Restart Playbook
Identification Zor e s—==mplete

Provide incident details

‘:) Assigned to David Loo
.

Logging (Pending)

The opposite is true for activities and stages. Activities and stages must be complete orin an
error state before they can be restarted.

Stage 1

Complete

Restart Stage
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Design considerations

Follow these design considerations when configuring restart for your playbook, stages, and
activities.

Last stages and activities

Avoid setting the last stage or activity of a playbook to Skip on first run if there are
no parallel stages or activities. If the playbook is restarted before the last stage or
activity can run, the last stage or activity never runs.

Stages

Avoid grouping all activities that are configured to Skip on first run in one (1) stage.
If you do so, the stage is completely hidden the first time that it runs. The stage must
run twice to become visible.

Configure restart for Playbooks

Configure your playbook so that agents and fulfillers in Playbook Experience can restart a
playbook from the beginning, or from a specific stage or activity.

Before you begin
Role required: pd_author

When you open an existing playbook in Workflow Studio for the first time after upgrading to the
Process Automation Designer 25.1.2 ServiceNow Store app, a banner message notifies you to
enable restart for your playbook. You must enable the restart feature before you can perform the
task below.

Restart available. Enable processes to
restart from the beginning, a certain...
Show more v

[ Enable restart J X

t

This message only displays for existing playbooks. Restart is automatically enabled for new
playbooks and does not change any other features and functions.

0 Note: Once enabled, restart cannot be disabled. If you don't want agents to be able to
restart a playbook or the activities and stages in a playbook, do not perform the following
task.

Procedure

1. Enable restart for an entire playbook.

a. Navigate to All > Process Automation > Workflow Studio and select Playbooks.
The Playbooks list displays.

b. Open the playbook you want to enable restart for.
The Playbooks builder displays.

c. In the upper right-hand corner, open the More actions menu — , and select Properties.
The Additional Properties modal displays.

d. At the bottom of the General tab, check the Allow this process to be restarted during
runtime box.
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Allow this process to be restarted during runtime

Agents can now restart the whole playbook.

Note: Restart can be enabled for activities and stages even if the whole playbook
cannot be restarted.

2, Define restart rules for each stage and activity.

() Note: Restart settings for a stage do not apply to its activities. Each activity also has its
own restart settings.

a. Navigate to All > Process Automation > Workflow Studio > Playbooks.
The Playbooks list displays.

b. Open the playbook you want to configure stage or activity restart settings for.
The Playbooks builder displays.

c. Open the stage or activity you want to configure restart settings for.

Restart rules
Define how this activity runs when restarted. Activity can only restart when conditions are met.
Learn more

(® Skip on restart
(O Run always

(O Skip on first run

d. Select what you want the stage or activity to do when restarted.

T " S

The stage or activity only runs during a play
book's initial run. It never runs during a restart
ed run.

@ Note: This setting is helpful if you don't
want new tasks or records to be created
during a restarted run, because the origi
nal execution and resulting record is still
relevant.

Skip on restart

The stage or activity always runs, whether dur

Run always . e
y ing an initial or restarted run.

The stage or activity runs only during restart

Skip on first run . oo
ed runs. It never runs during an initial run.

Your restart rules are applied.
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o Restart settings are reflected in both the Diagram view and Board view of the Workflow
Studio Playbooks builder.

1. Contributing indicator configuration
P

>
R

»K

1.1 Select a primary
indicator to add o...

1.3 Configure the contributing i... :
Skip on first run
= List After 1.2

[%
o Restart buttons are added to context menus in your playbook.

Stage 1

Complete

Restart Stage

3. Optional:

To test your playbook with the restart options, select Test in the upper right-hand corner and
open the Playbook preview.

Email/Exchange server is down ©

Overview Details Communicate Related records Playbook

Incident Response Demo VvV  § A Identification
Restart Playbook
Identification Zora s—==mplete
Provide incident details
Logging (Pending)

a Assigned to David Loo
<2
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Duplicate a playbook

Make a copy of an existing playbook with the same trigger, stages, activities, and experience
configurations as the original. Edit the duplicated playbook to quickly create a working variation.
Before you begin

« Activate Playbooks for your appropriate application.

« Familiarize yourself with the tables and relationships that your application uses for the
playbook that you want to create.

« Make sure to familiarize yourself with any features that your business uses to automate
operations on the ServiceNow Al Platform, such as flows, subflows, and actions.
e Learn how to get started with ServiceNow® Process Automation.

« Role required: admin or playbook.admin

Procedure

1. Navigate to All > Process Automation > Workfow Studio > Playbooks.
The Playbooks builder appears.

2, Select the playbook you want to duplicate.

3. Check the box next to the playbook that you want to duplicate.
Only one playbook can be duplicated at a time.
The Duplicate button displays.

4. Select Duplicate.
The system makes a copy of the selected playbook and opens Duplicate playbook modal for
the new playbook.

5. Fill in the playbook properties.

opion o

Enter a unique, user-facing name for your play
Label book. This name appears during playbook run
time.

Choose an application scope that you want
your playbook to run in. Selecting Global

Application lets your playbook run in any application
scope. For more information, see Application
(AQ AR~ ARAY A

Description Optionally, enter some descriptive details
about your playbook.

Trigger type Specify what causes your trigger to fire.

The table with the record operations that you
Table want to trigger your playbook. This field can
not be edited.

6. Edit the playbook stages and activities to fit the new playbook.

7. Select Save.
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Add translations for Playbooks
Make Playbooks available in multiple languages during runtime, to support worldwide business
processes.
Before you begin
« Role required: admin or playbook.admin
« To enable custom translations for playbooks, install the 271 app version or later.
« Activate any playbooks that you want to translate.

« To learn more about translating custom content in general, see Translating custom content @&.

About this task

Ul Message records are used to translate the text in your playbooks to different languages at
runtime, similar to the way system messages are translated on the platform. To learn more about
the Message table [sys_ui_message] in general, see Message table .

The playbook text that you can create translations for are:
« Playbook Label

« Stage Label

« Activity Label

« Activity Description

« HTML and string Activity Ul Layout properties

Note: Automation inputs such as text used to create emails or records are not translated.
Only text that is shown at runtime within a Playbook Experience is translatable.

Procedure

1. Navigate to Workfow Studio, open playbook, activate playbook.
2. Open the All menu.

3. In the filter bar, type and enter sys_pd_process_definition.list.
4, Select the playbook that you want to add translations for.

5. Open the Translated Messages tab.
All of your playbook text is listed here.

6. Open a piece of text that you want to translate.
7. From the Language drop-down, select the language that you want to translate to.
8. In the Message field, enter the translation.

9. Right-click on the form header to open the context menu, and select Save.
Your translation is saved.

10. Repealt steps 1-8 to add more translations.

Resulit
When the playbook runs, the translated content appears for agents in their user session
language.
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Vista previa de Libro de tacticas

Stage

® In Progress Instructional ® Prioridad ~

Instruccion en espanol

Test

Marcar como completado

Designing Playbook Experience

After building playbooks in Workflow Studio, Playbook Experience administrators can configure
the layouts and further customize playbook functions during runtime.

There are many different ways that a Playbook Experience admin can customize the layout of a
playbook during runtime. Playbooks can be designed and customized in Ul Builder for:

« configurable workspaces

« Service Portal

« ServiceNow Mobile Platform

Once customized to your satisfaction, mobile playbooks must be embedded. There are no
additional steps needed before end users can run playbooks in configurable workspaces or
Service Portal.

Customizing the Playbook Experience

Customize the layout of your Playbook Experience with base system modular components,
templates, and more via integrated Ul Builder functionality.

Build custom experiences for your agents and fulfillers with the modular components in the
Playbook Experience apps. To speed up the development process, add the Custom Layout
Ul Controller to pages where you want presets to auto-populate inputs for the provided
components.

o Note: You can also create your own custom components with Ul Builder, but presets
cannot auto-populate custom components with data.

Components

Determine how to display these modular components in your Playbook Experience:
Playbook stage picker

The stages of a playbook can be displayed horizontally or vertically:

« The vertical orientation shows:

o

All playbooks for a parent record,

o

The stages of each playbook,
© How many activities remain to be completed in each stage, and
©o How many activities are in progress for each stage.
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In this example, a playbook named Playbook Experience Demo with stages
named Assign, Create, Review and Update is shown. The Assign stage has 2
activities left to complete, with 1in progress. The Create and Review and Update
stages don't have blue numbers next to them, so they don't have any activities
that are in progress.

Vertical stage picker

Playbook Experience D... vV ~

) Assign
2 remaining

Create

2 remaining

E, Review and Update

4 remaining

» The horizontal orientation only shows the stages of a selected playbook. To see
the activities of a stage, select the stage.

Horizontal stage picker

[ # Assign > Create Review and Update

Playbooks with more than 5 stages paginate.

(] Note: The horizontal stage picker only shows you the playbook you are in
and its stages, so you can’t navigate between playbooks unless you:
o Use a playbook template, or

o Create your own drop-down component with Ul Builder.

All playbook templates include a drop-down component to navigate
between playbooks, and is auto-populated when you select the Playbook
Picker preset.

Playbook activity picker
The activity picker is where you navigate between activities.

If you're using the vertical stage picker, turning on the activity picker means each
stage can be expanded to shows its activities.
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Activity picker when viewing stages vertically

Playbook Experience Demo VoA

") Assign N

2 remaining
& Choose Interaction Type
) Simple Instruction P

& Wait for Interaction assignment

El Create o
2 remaining

EI Review and Update o

4 remaining

If you're using the horizontal stage picker, turning on the activity picker allows you to
expand or collapse the entire list of activities for the stage you're in.

Activity picker when viewing stages horizontally
Activities ~
@ Choose Interaction Type

(#) Simple Instruction

@ Wait for Interaction assignment

To toggle the Show Stages flag flag on or off, .
Playbook activity viewer

The activity viewer is where you manage a stage's activities. You can change the
way activities are displayed in this space:
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» The Stacked view displays all activities in a stage stacked on top of each other.

Playbook stacked view
Assign

@ Complete "

Choose |Interaction Type

2 In Progress  Instructional -

# Simple Instruction

This is a simple instruction. Select "Mark Complete” to go to the next step

L comee JIETS

& Pending

Wait for Interaction assignment

This activity will become available after the previous activities are completed.

« The Focused view displays a single selected activity.

Playbook focused view
9 In Progress  Instructional

Simple Instruction

This is a simple instruction. Select "Mark Complete” to go to the next step

Mark Complete Skip

» The Guided layout
» The Wizard layout

Playbook modals

If you want the ability to cancel playbooks and add optional activities, you must
add the Playbook Modals component to your pages. If you use a template, this is
already included.
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Cancel playbook modal

Canceling Playbook Experience Demo X

Some activities can't be canceled once started. These activities will need to
finish.
Provide a reason for canceling this Playbook.

Reason for cancellation >

Enter reason here...

Add optional activity modal

Close dialog

Add activity

Select an activity here to insert within Playbook

Instruction

Optional Activity

To start setting up components for your customized Playbook Experience, see Customize a
playbook in Ul Builder.

Provided Ul Builder Bundles

If adding each component individually isn't ideal, you can also add an entire layout to a new or
existing Ul Builder template.

» Focused Vertical

» Focused Horizontal

« Stacked Vertical
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« Stacked Vertical
« Guided Decision
o Wizard

Each layout contains the following components:

« Ul controller

* Presets

o Activity viewer

« Activity picker

» Modals

« Playbook picker

« Stage picker

« Client scripts

To add a bundle to an existing or new Ul Builder page, see Add a custom layout bundle to a Ul
Builder page. If you're creating a new experience and want to add a bundle to a standard record
page, see Add a custom layout bundle to a Ul Builder standard record page.

Customize a playbook in Ul Builder

Use Ul Builder pages and modular components for custom playbook layouts to customize the
end user's Playbook Experience in a configurable workspace, Service Portal page, or mobile web

page.
Before you begin

« If you don't have a playbook to apply custom layouts to, build a playbook. To learn more, see
Building Playbooks.

« Install the latest version of the Playbook Experience and Playbook Experience Component
apps from the ServiceNow Store. See Playbook Experience apps @.

Role required: ui_builder_admin, admin

About this task

After creating a Ul Builder page, you can customize Playbook Experience pages to your needs.
Page templates include controllers that can be used with component presets, including the
playbook templates. See Bind data to Ul Builder pages using controllers (advanced feature) & for
more information.

Procedure
1. Navigate to All > Now Experience Framework > Ul Builder.

2. Open the Ul Builder experience that you want to work in, or create a new experience.
The Playbook Experience Builder experience was built for you to customize Playbook
Experience. For more information on how to create an experience, seeConfigure how users
interact with your applications in Ul Builder &

3. In your Ul Builder experience, you can:
o Create a page from scratch @,
© create a page from a Standard record template &,
o or create a page from a Playbook Experience template.
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Using a Playbook Experience template speeds up the development process, because the
Playbook Custom Layout Ul Controller and components are already added to every page,
including record generators as of version 25.2. The controller automatically populates all the
provided components with data.

(; ) Note: You can still create and add custom components when you use a template.

T First, select a template Al
Tempiates "

Theme preview page

4, If you're using a Playbook Experience template, Create your page.

a. Set up the page details.

Name The name of your page.

URL Path The URL path that users navigate to, to
access the page.

b. Review the testing parameters for your page.

table Name of the parent table for the playbook.

sysID Sys_id of the record. For a record that
doesn't exist, the value is -1.

experience The experience you want to load.

selectedPlaybook The playbook the agent or fulfiller is in.

selectedStage The stage the agent or fulfiller is in.

selectedActivity The activity the agent or fulfiller is in.

c. Set up your default page variant.

Name The name of your page variant.

Audiences The users that can see your page variant.
They can be defined by:
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* Role

= Group

* User

= Company

= Department
= Location

= Script

Conditions Conditions that determine when the page
variant is shown.

d. Open the default page variant you just created.

The new Playbook Experience layout already includes controllers and components
populated with data, but there are a few more configurations to make. To make the remaining
configurations, go to step 6.

5. If you used the Standard record template or created your page from scratch, add the Playbook
Custom Layout Ul Controller to the page.
a. From the bottom corner of your new page, select the data icon ( = )
b. Select + Add.
¢. Search for "Playbook".
d. Under Data resources, select Playbook Custom Layout Ul Controller and click Add.
e. Exit the Data resources panel.

6. Configure the Playbook Custom Layout Ul Controller you just added.

a. To allow users to create a new record in this customized Playbook Experience instead of the
standard new record form, select a test value pill in the upper left.
The test values popover opens.

b. Make sure the sysID test value is set to -1, and select Apply.
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L' Playbook Experience Builder

Experience

Standard Record Page Defaul

-,

huery | | extraParan
LVAN

& (interaction ) ( e718ad38c3931... ) |

issing test values for URL paramters

Apply test values for URL parameters to see how the
content renders with the data

Required parameters

table
interaction

(’sz?sh

EW, | @

Optional parameters

query
extraParams
VIBWS

selectedTabindex

Cancel (I:)Y

A record generator form is available when you open the preview. You should be able to test
the record generator form and confirm that new records are created.

c. You can also update the table name or any of the optional parameters:

d. Optional: If you want to hard-code the test values instead, navigate back to Data > Data
resources panel > Local data resource instances, and select Ul Controller Record Page.

e. Under the Config tab of the controller, add the Parent SysID or Parent Table.
In the test values popover, these are the sysID and table fields.

You can enter context.props.table in the Parent Table field, and context.props.sysld for the
Parent SysID field.

(; Note: Make sure whatever table or record you enter has a playbook.
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f. Add the Playbook Experience you want to use.

g. Optional: Enter values for the other fields, if needed.

Activity View Mode View mode used to render Playbook
activities in stacked or focused mode

Record Generator Query Encoded Query string to optionally override
the query provided for a record generator

Selected Playbook Context ID Optional context ID of selected playbook for
deep linking

Selected Stage Context ID Optional context ID of selected stage for
deep linking

Selected Activity Context ID Optional context ID of selected activity for
deep linking

h. Optional: In the Outputs column, you can select the values you want to hard-code.

The controller is configured and you're ready to add playbook components.

7. Add playbook components.

a. In the component tree, select the Main Tab.
The Main Tab panel opens on the right.

b. In the Main Tab panel, select + Add.
A modal asking "How do you want to build this tab?" displays.

c. Select Start from an empty container and click Next.
A Tab Settings modal displays.

d. Give your tab a name and an icon, and click Create.
The tab is added to the component tree and a blank canvas displays.

e. In the component tree, under your new tab, select + Add component and search for
"resizable".

f. Select the Resizable panes component, give it a name, and click Create.

g. In the component tree, open the new Resizable panes component you just created.
The panel for your new Resizable panes opens on the right.

h. Configure as needed, and click Save in the upper right corner.

i. To add the stage picker, find your new Resizable panescomponent in the component tree,
and select + Add component under left.

Jj- In your component tree, select the new stage picker.
The panel for your new stage picker opens on the right.
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k. Select the preset for this component from the Playbook Custom Layout Ul Controller, and
click Save in the upper right corner.

Playbook Stage Picker 1 >
ID: playbook_stage_picker_1

[ # Preset None - ]:}

Select a preset 5

O Show only presets frofh added
data resources

Q. Search presets

Playbook Stage Picker

Presets for the Playbook Stage
Picker

@ Included with the page template

Required controller &

B  Playbook Custom Layout Ul Controller

None o
Configure the component manually.

A confirmation message is displayed, and the component inputs and events under the
Events tab in the stage picker panel is auto-populated.

© 2026 ServiceNow, Inc. All rights reserved. 144
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Playbook Stage Picker 1 (& >
( | ] 1D: playbook_stage_picker_1
R — c . .
_ # Preset Playbook Stage Picker *
@ Did you know?
You've applied a preset Q1 Config 3 Styles % Events
4 This component is nested in tabs @
D8 o Go to tabs
[@_._ ] Orientation ®
W Vertical v
A preset takes care of some of the Playbook context |Ds in order (O
configuration and events for you. @data.playbook custom_layo.. 8
If you need the component to look or
behave differently, you can unlock to set Playbooks by context ID
up your own property value or apply a @data.playbook custom layo.. 8
different preset, - -
Learn more about customizing presets [ Playbook experience @
@data.playbook _custom_layo.. &
. — |
Avallapie @data.playbook custom_layo.. &8
&.an attachinent Optional activity trigger context @
l @data.playbook custom_ layo.. &
User session (@O
@data.playbook custom_layo.. &
Parent record update time (@
f@data.playbook_custom_layo.. &
Configure declarative action event mappings @

I. To add the Playbook Activity Viewer, find your Resizable panescomponent in the
component tree, and select + Add component under right.

m. Repeat steps 7j and 7k.

n. To add the Playbook Modals, find the tab you created under the Main Tab in the component
tree, and select + Add component.

0. Repealt steps 7j and 7k for the Playbook Modals.

p. Navigate back to the Playbook Stage Picker, and determine the orientation of your stage
picker.
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q. In the upper right corner, click Open to preview the playbook layout.
r. Return to Ul Builder.

s. Navigate back to your stage picker in the component tree, and determine the orientation of
your stage picker in the panel that opens on the right.

Related topics
Ul Builder &

Add a custom layout bundie to a Ul Builder page
Add playbook custom layout bundles to a new or existing Ul Builder page that you've created
from scratch.

Before you begin
Role required: admin, ui_builder_admin

About this task
Templates are page level, they are meant to be used when you create a completely new page.
Bundles are like templates that you can add to a new or an existing page.

Procedure

1. Navigate to All > Now Experience Framework > Ul Builder and select Playbook Experience
Builder.
The Playbook Experience Builder experience was built for you to customize Playbook
Experience. For more information on how to create an experience, see Configure how users
interact with your applications in Ul Builder &.

2. Select + next to Pages and variants to create a new page.

3. Select Create a new page.
The Select a template screen displays.

4, Select Create from scratch instead button at the top right.

5. Set up the page details.

Name The name of your page.

URL Path The URL path that users navigate to, to
access the page.

6. Select Continue.

7. Add the test URL parameters for your page.

Q Note: All playbooks require at least a table and sysld to be hardcoded on the controller
or provided through a URL.

table Name of the parent table for the playbook.

sysID Sys_id of the record. For a record that doesn't
exist, the value is -1.
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8. Setup your default page variant.

Name The name of your page variant.

Audiences The users that can see your page variant.
They can be defined by:

° Role

o Group

o User

o Company
o Department
o Location

o Script

Conditions Conditions that determine when the page
variant is shown.

The page and default variant are created.
9. Open your new page variant.

10. In the component tree, select + Add component under Body.
The toolbox opens.

11. Enter "bundle" in the search bar of the toolbox.
Available bundles are displayed.

12, Select the bundle you want to add to your page.

Resulit
You've added a bundle and all its components, presets, and controller to your new Ul Builder

page.

What to do next
Edit test values and controller inputs.

Add a custom layout bundle to a Ul Builder standard record page
Add playbook custom layout bundles to a new or an existing Ul Builder standard record page.

Before you begin
Role required: admin, ui_builder_admin

Procedure
1. Navigate to All > Now Experience Framework > Ul Builder.

2, In the upper right, select +Create to create a new experience.

Description

The name is used for tracking the experience
Name internally. The experience name is also visi
ble to users from the browser tab.

3. Fill in the fields for your experience.
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The URL path is the prefix that people will use
to reach your experience. It matches your ex
perience name by default. You can edit this

path now or later in Ul Builder.

URL path Supported characters include digits (0-9), let

ters (A-Z, a-z), and the following symbols: $-_!

*()I

The path can't end with a forward slash (/).

Choose the UXR Base Experience Shell.

The app shell is the wrapper of the page con

tents, which is similar to the functionality of a
App shell Ul web page. The app shell can show things like
the logo of your company, user preferences,

and the search icon. To learn more about the
app shell options, see Define Ul experiences
(AQ AN~ ARAYA]

The landing path is the prefix that people will
use to reach your experience homepage. It
matches your experience name by default.

To designate a page as the homepage, you
will need to create a page that has a matching
path.

Landing path

Only users with these assigned roles can ac
cess the experience. If you leave this field
empty, the experience is open to all logged-in
users by default.

Roles

4. Select Create.

5. In your new Ul Builder experience, select Create new page.
The Select a template screen displays.

6. Choose the Standard record template and select Use template.

7. Set up the page details.

Name The name of your page.

URL Path The URL path that users navigate to, to
access the page.

8. Select Continue.
9. Add the test URL parameters for your page.

0 Note: All playbooks require at least a table and sysld to be hardcoded on the controller
or provided through a URL.
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Required parameters

table

Name of the parent table for the playbook.

sysID

Sys_id of the record. For a record that doesn't
exist, the value is 1.

Optional parameters

query

extraParams

views

selectedTabindex

Encoded Query string to optionally override
the query provided for a record generator.

Pass additional parameters to a page.

View mode used to render Playbook activities
in stacked or focused mode.

The tab that your page opens to by default.

10. Setup your default page variant @.

Name

The name of your page variant.

Audiences

The users that can see your page variant.
They can be defined by:

° Role

o Group

o User

o Company
o Department
o Location

o Script

Conditions

Conditions that determine when the page
variant is shown.

The page and default variant are created.

11. In the success message, select Open in editor to open your new page in the UIB editor.

12. In the component tree, select the Main Tab.
The Main Tab panel opens on the right.

13. Under the Tabs section in the Config tab, select + Add.
A modal asking "How do you want to build this tab?" displays.

14. Select Start from an empty container and click Next.

A Tab Settings modal displays.

15. Give your tab a name and an icon, and click Create.
The tab is added to the component tree and a blank canvas displays.

16. In the component tree, under your new tab, select + Add component.

The toolbox opens.

17. Enter "bundle" in the search bar of the toolbox.
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Available bundles are displayed.

18. Select the bundle you want to add to your page.

Result
You've added a bundle and all its components, presets, and controller to your new Ul Builder
standard record page.

Trouble?

If the width of the bundle container is set to the min-width of the component, set the min-width
of the container to 100%.

Sizing
Width ® Min. W © Max. W ©®
[ 100 % | | 100 % | | px |

Height ©® Min.H ® Max. H ®

[ P | P | P |

What to do next
Edit test values and controller inputs.

Enable Guided Activity View
Guide end users through a playbook, step-by-step.

Before you begin
« Role required: admin or playbook.admin

« Familiarize yourself with how to begin customizing the playbook experience in Ul Builder. To
learn more, see Customizing the Playbook Experience.

About this task

Guide end users through a playbook, one activity at a time. If you have a lot of end users
encountering issues in a particular area, and you want to walk them through a series of questions
that lead to a particular Instruction activity to complete work (or even KB activity for final
instruction), consider using the Guided activity view. There are out-of-the-box playbooks that use
the Guided activity view for employee self-service requests, such as time off or benefit requests,
available through the Employee Center @.
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© Note:
The following configurations and features are not supported for the Guided activity view:

« Parallel activities
« Optional activities

» The Pending Item Visibility configuration in the Guided Self-Service
Experience playbook experience record in the Playbook Experiences list
[sys_playbook_experience.list]

() Note: This property is not relevant since there are no pending activities other than
the current activity that an end user is in during a Guided self-service playbook run.

« Stage picker components, including filters

Procedure
1. Navigate to All > Ul Builder, and open the Guided Self-Service in Employee Center
experience.
4 )

Y
Guided Self-Service EC

Exper... Guided Self-Service in Empl...
b /

2. Open the page that you want to enable the Guided activity view for.

O Guldedsansenvie ¢ Eperiances ; J— s Guided SefService In Employee Center v iWhat'snew @ Help

Guided Self-Service EC View experience settings

URL path Application scope App shell Roles

Imow/guided-help-ec/ 7 Guided Self-Service in Employee Center  UXR Base Experience Shell No roles found

Pages and variants [+)

A page is content that lives at a specific URL. When a user opens the URL, they will see a different variant of this page based on the audience, conditions, and order that you set

v Name URL path Order Audiences ® Conditions ®  Modified
v Iplaybook/{{table}}/{{sysId}} May 15, 2024 Settings
Dela!k 0 . B May 15, 2024 Editor Settings

3. Under Body in the component tree, open Playbook Activity Viewer.
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wm ® Guided Self-Service EC

} Playbook (Default) »
Experience
= A ( table )( sysid
[ Q Search J g
v @] Qverlays
=) Modals

Modeless dialogs
CJ Popovers
Iv s Body
B Playbook Modals 1
B Playbook Activity Viewer 1

+ Add component

The Playbook Activity Viewer panel opens on the right.

4. In the Playbook Activity Viewer panel, under the Configure tab, open the Activity View drop-
down and select Guided.

k) Playbook Activity Viewer 1 ®
ID: playbook_activity_viewer_1

# Preset Playbook Activity Viewer v | ®

L 8 Playbook Custom Layout 1
£ Configure @ Styles % Events

@ Component visibility %

Activity View @
[ Guided v ]
Stacked

Focused
~ Guided -
Playbook Context ID Map ®

@

playbook_custom_|... » playbooksByC... ({}) #*

Result

For an end user who is running a playbook, the result is a playbook that runs one activity at a
time. If configured, users can still restart the playbook and activities.
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ece TO! Test Guided self service | x| [B) Shared admin dashboard [Se X | @ Playbook editor | Ul Builder % | | Playbook editor | Ul Builder X TON Test Guided self service_ || [ Employee Conter Homepage™ | + o
P c m (= de1.thunder.d i help- _ex_sp_gd_help_execution/573a5eecd5f41610f877e219ddde3c77/ -4 in} a
C3 ServiceNow Managed Bookmarks [@] Okta [ 8T1k8 [@) 811 (@) devenc @ VDI [ PAD () EXV-Team Dashb.. E UTG Create ) Microsoft Copilot... B Orion - All Docum... () seismic () SNCAV2 (@ TestAutomation-B... () Nexus »

TOI Test Guided self service

Select a choid

Choice 1 Choice 2

Playbooks in Service Portal

Use playbooks to guide Service Portal users through your business processes.
Using the widget
The Portal Playbook widget adds playbooks that your Service Portal users can run.

Provide a playbook experience to your Service Portal users for a consumer grade user
experience. Requests on portals are surfaced as catalog items, including any playbooks you
make available in Service Portal. Embedding a playbook in Service Portal enables:

« Arich user interface for activities during a business process

» Guidance for long business processes

« Going back and editing any previous steps of a business process

« Saving long running playbooks for a business process and resuming at a later point
« Seamless transition for agents and teams to enter a business process

« Visibility into where you are in a business process

« Visibility on a specific user's tasks

« Single admin experience for a whole business process.

Service Portal playbooks are also supported in a mobile interface.

.
servicenow.
I # Assign > 3 Create & Review and Update v
Activities ~
© In Progress Instructional ® Priority
2 Choose Interaction Type Slmple Instruction

Simple Instruction
) This is a simple instruction. Select "Mark Complete” to go to the next step

@ Wait for Interaction assignment m ‘m‘
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Use cases

Business account onboarding

Onboarding a new or existing business customer with one or more contacts along
with onboarding the services requested such as wire transfers, treasury services.
Promote compliance and deliver a faster time to value.

Loan or mortgage application

Intake of a new credit card application or loan application for both consumers and
corporate programs. Customer needs the ability to save the application and come
back at a loter time to resume application.

Insurance claims

Policy holder submitting a new personal auto or home claim for an auto accident or
home damage via portal.

Request quote for a new policy

Business customer requesting a quote for small business insurance policy that
includes liability and commercial property insurance The customer can start filling
in the request and the agent needs the abilith to fill in the remaining on behalf of the
customer.

License request

Constituents requesting a new license such as a business license, or personal
license (fishing, driving or hunting) from a government agency via a government
portal. These applications typically vary by service and state and constituents need
to be guided through request.

Customer cases

Cases logged by users who need guidance to select the correct issue and enter all
the necessary details, such as instances, steps to reproduce, best time to contact,
etc. Enable faster case resolution.

Life cycle

The general life cycle of a Service Portal playbook can be summarized as:

« A business process administrator builds the playbook in Workflow Studio. To learn more about
building a playbook in Workflow Studio, see Building Playbooks.

« An administrator adds the playbook to a Service Portal page and customizes the playbook
runtime experience at the same time through the ServiceNow Al Platform®. To learn more
about embedding a playbook in Service Portal and further customizations in the ServiceNow Al
Platform®, see Configure a playbook for Service Portal.

« Service Portal administrators and developers customize the playbook portal page. To learn
more about using the Service Portal Designer to customize the playbook portal page, see
Customize a playbook in Service Portal.

« Service Portal end users, also called requesters, launch and run through the playbook. To learn
more about launching and running a playbook in Service Portal, see Run a playbook in Service
Portal.

Set up mappings between themes

Make sure that playbooks run as expected in your Service Portal by setting up mappings
between your Service Portal theme and the UXF theme used in Ul Builder.

Before you begin
Role required: admin, or portal admin with either snc_internal or snc_external
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About this task
The Portal Playbook widget uses a system property ux_portal_theme_to_uib_theme_mapping to
handle mappings between a Portal page theme and a UXF theme.

Procedure
1. Navigate to All > System Properties > All Properties.
2, Select New in the upper right corner.

3. Enter values for the following fields.

Specify your Service Portal property in

the name. Give your system property the
name ux_portal_theme_to_uib_theme_
mapping.[the sys ID of your service portal
theme]. For example, if you use the La Jol
Name la theme for your Service Portal, it has a sys
ID of a7a6€78277002300a6€592718a10617a
. You would enter ux_portal_
theme_to_uib_theme_map
ping.a7a6e78277002300a6e592718a10617a
as the name.

To specify the sys UX theme and sys UX
style that you want to map the Service Por
tal theme to, enter a comma-separated
string of [the sys ID for the sys UX theme],
[the sys ID of the sys UX style]. For exam
ple, if you want to map your Service Por

tal theme to the Polaris UX theme in dark
mode, the sysld for the Polaris UX theme
is 31bf91a2e07203010€03948f78ad30095,
and sys ID for the Dark sys UX style is
€09ef7ae07103010e03948f78ad3002c.
You would enter
31bf912e07203010e03948f78ad30095,
€09ef72e07103010e03948f78ad3002¢ as
the value.

Value

@ Note: The second value in this string
is always an optional sys_ux_style. The
first value is always the sys_ux_theme.

4. In the form context menu, select Save.

Resulit
The mapping between your Service Portal theme and the UXF theme is saved. Launch the
playbook in Service Portal to see your changes.

@ Note: To turn a mapping off, you must delete it.

What to do next
Embed a playbook in a Service Portal page and customize the Service Portal playbook runtime
experience in the ServiceNow Al Platform™.
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To learn more about customizing the playbook runtime experience in Service Portal, see

Configure a playbook for Service Portal.

Configure a playbook for Service Portal

Add a playbook that Service Portal users can launch and run by creating a Playbook Content

Item.

Before you begin

« Role required: admin, or portal admin

« If you don't have a playbook that you want to customize for Service Portal yet, build one in
Workfow Studio. To learn more about building a playbook in Workflow Studio, see Building

Playbooks.

« Create a record generator, if there isn't already one you want to use. To learn more about
creating a playbook record generator, see Playbook record generator.

« You may need to set up mappings between your Portal theme and the UXF theme, if they are
very different. To set up mappings between your Portal theme and the UXF theme, see Set up

mappings between themes.

About this task

In a Playbook content item, the admin specifies the URL that points to the portal page.

Procedure

Navigate to All > Playbook Experience > Playbook Content Items.

Playbook content item form view

Field Description

Name

Active

Catalogs

Category

Icon

Application

Picture
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Enter a name for the playbook.

Uncheck this box if you don't want users to be
able to run the playbook in Service Portal.

Enter the catalog that you want this playbook
to be added to. There is no default, but the
playbook is not searchable if you don't add it
to a catalog.

Enter the catalog category that you want this
playbook to be in. There is no default, but the
playbook is not searchable if you don't pick a
category for the playbook.

Upload a small image that appears next to
the name when the item is displayed in the
service catalog. Supported file types are jpg,
png, bmp, gif, and jpeg.

Choose an application scope that you

want your Service Portal playbook to run in.
Selecting Global lets your playbook run in any
application scope. For more information, see
Application scope &.

Upload an image showing the item. Supported
file types are jpg, png, bmp, gif, and jpeg.
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Field Description

Short description Enter some descriptive details about your
playbook.

Table Enter the parent table that the playbook opens
on. If not specified, defaults to the Incident
table.

Record ID Enter the parent Sys ID of the record you want

to open in the record generator table. If you
want to use the record generator, leave it as -1.
If not specified, defaults to -1.

Playbook Experience Choose the playbook experience record with
the playbook configurations that you want
for your Service Portal users. If not specified,
defaults to the Global Playbook Experience.

Playbook Experience Record Generator Choose the record generator with the
playbook that you want to show.

Portal Page Enter a Service Portal page that you want to
open the playbook in. If not specified, the
playbook is launched in the out-of-the-box
Playbook Portal page.

Title Add a title for any components that use the
title property in the Portal Playbook widget's Ul
Builder page.

Meta Add tags to the playbook item for Service

Portal home screen searches.

Trouble?

For issues that seem like process execution related, check the execution logs on the
sys_pd_context that is related to the process that was run. You can find these in the "today's
executions" module within the navigator.

For issues that are flow designer related, debug using the Alow debugger options. To learn more
about flow debugger options, see [an article linked to debugging flows].

For other issues:

« Check the instance logs around the execution time of the sys_pd_context records and see
if you can find any errors that seem related (record watchers, flow exceptions, or any other
exceptions seeming relevant).

« Make sure versions of playbook are as follows:
© now-playbook-experience version 251.4 or greater
o playbook-experience version 251.2 or greater
« Verify that you are using the out-of-the-box Portal Playbook widget.

What to do next
Customize the runtime playbook experience in the Service Portal Designer.

Portal Playbook Widget
Explore the Portal Playbook Widget.
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About the widget

The Playbook widget is an iFrame that enables administrators to specify where a playbook event
should be directed. The iFrame URL is the Ul Builder Playbooks Portal page. The widget handles
events that playbook is listening for via the Session Storage API so that it knows when to perform
an action in portal, like opening a record or list in a modal within Service Portal.

The out-of-the-box components are built for any Playbook Experience you may need for your
Service Portal users. We do not recommend directly editing the out-of-the-box Ul Builder
Playbook Portal Page, the Service Portal Playbook widget, or the Playbook Content Item.
Changing the out-of-the-box components can result in technical problems.

If, for example, you need a UXF Client Action to work for your instance of the playbook page, we
recommend cloning the playbook widget instead.

o Note: To learn more about how to clone or create your own widget instead, see
Developing custom widgets &@.

Cloning a Playbook Service Portal Widget
Navigate to All > Service Portal > Widgets and find the Playbook widget.

() Note: If you clone the Playbook widget, make sure that all out-of-the-box actions and
configuration properties are copied over to your cloned widget.

Form Fields

Name Enter a name for the cloned widget.

ID The widget ID is created automatically based
on the widget name by default, but you can
change it to whatever you want.

Description Add an optional description that provides
details for the widget does.

Application Choose an application scope that you want
your widget to run in. Selecting Global lets
your playbook run in any application scope.
For more information, see Application scope &

Public Select if your widget is public. If unchecked,
your widget is private and only authenticated
users with the snc_internal or snc_external
role can see the widget.

Roles Restrict access to the widget to certain roles.

Body HTML template Leverage the Angular JS two-way binding to
bind your controller variables to your markup.

© Danger: Only make changes to HTML
templates if you have advanced coding
knowledge and a firm understanding of
AngularJS and the platform API.
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Form Fields (continued)

Field Description

The iFrame URL is the URL of the Ul Builder
page. To learn more about the HTML template
field, see Developing custom widgets &.

A Warning: Make sure the iFrame URL of
your cloned widget is different from the
iFrame URL for the out-of-the-box widget.

CSsS Configure the widget CSS. Configuring CSS in
an actual widget affects all instances of that
widget. To learn more about the CSS field, see
Developing custom widgets &.

Server script Script the server-side logic. This is helpful
primarily with interacting with the Glide
platform through server-side APIs.

© Danger: A server script requires
knowledge of the ServiceNow API to work
with record data.

To learn more about the Server script field, see
Developing custom widgets &.

Client controller In Angular, HTML templates contain Angular-
specific elements and attributes. Angular
combines the template with information from
the model and client controller to render the
dynamic view that a user sees in the browser.
Identifier name for a reference to the controller
in the directive's scope

(%) Danger: A client script requires
knowledge of both the ServiceNow
APl and AngularJS to create a client

controller.
controllerAs The HTML template uses the controllerAs
syntax for basic binding.
Link Use a link function to directly manipulate the
DOM.

© Danger: The link function requires
knowledge of AngularJS.

To learn more about the Link field, see
Developing custom widgets &.

Has preview Select the option to enable a preview of the
widget in the Widget Editor.

Demo data Provide data when previewing the widget in
the widget editor.
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Form Fields (continued)

Field Description

Data table Select a table to use as a data source.
Fields Select fields to display as instance options.
Option schema Allows a Service Portal admin to configure

a widget. To learn more about the Option
schema field, Widget option schema @.

Docs Select a Service Portal documentation link.

Check for errors in the Ul Builder Playbook Experience Portal page config and events properties,
e.g. disable the Open Record event as a maint user.

Customize a playbook in Service Portal

Use the Service Portal Designer to customize the playbook runtime experience for Service Portal
users.

Before you begin

« Role required: admin, or portal admin with either snc_internal or snc_external

« Create a record generator if you don't want to use the default record generator or any of the

other existing record generators.

(] Note: A key difference in Service Portal is that the playbook record generator is used
instead of the record producer. The Service Portal requester enters the information for
the record generator and uses the Next or Continue declarative action to move to the next
activity.

To learn more about playbook record generators, see Playbook record generator.

Procedure

1. To edit your playbook widget in the Service Portal Designer, navigate to All > Service Portal >
Service Portal Configuration.

2. Select Page Editor.
3. Search for and select your playbook.
4, Select Edit [Playbook] (playbook) page in Designer.

5. Select the widget, and select the edit icon.

Data parameters

Playbook UIB Page URL Enter a URL for the Ul Builder page. If not
specified, this points to the default Playbook
Experience Portal page.

Open Record Widget The Sys ID for the widget to use when a user
opens a record. If not specified, the form
widget is used.

Open Record is Pop Up If enabled, shows the reference picker inside
the form.
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Field Description

Open List Widget

Extra Params

The Sys ID for the widget to use when a user
opens a list. If not specified, the Data Table
from the Instance Definition is used.

Pass arbitrary data from the widget to its Ul
Builder page.

Presentation parameters

Field
Height

Open Record Modal Title

Open Record Modal Message

Open Record Modal Buttons

Open Record Modal View

Open Record Modal Size

Open List Modal Title

Open List Modal Message

Open List Modal Buttons

Open List Modal View

Open List Modal Size
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Description

Enter the height of the playbook. If not
specified, height is set to 850px.

Add a title to the modal that a user sees
whenever they open a record. If not specified,
there is no title.

Add a message to the modal that a user sees
whenever they open a record. If not specified,
there is no message.

Add the buttons to the modal that a user sees
whenever they open a record. If not specified,
there are no buttons. Enter in JSON format.

The form view that you want to show for the
open record.

Choose the size of the modal that a user sees
whenever they open a record. Choice are:

o sm - small
° md - medium

o Ig-large
If not specified, defaults to large.

Add a title to the modal that a user sees

whenever they open a list. If not specified,
there is no title.

Add a message to the modal that a user sees
whenever they open a list. If not specified,
there is no message.

Add the buttons to the modal that a user sees
whenever they open a list. If not specified,
there are no buttons. Enter in JSON format.

The form view that you want to show for the
open list.

Choose the size of the modal that a user sees
whenever they open a list. Choice are:

o sm - small
o md - medium

o |g - large
If not specified, defaults to large.
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Field Description

Activity View Change the activity view between stacked or
focused.
Playbook Experience ID Enter the playbook experience record ID with

the playbook configurations that you want
for your Service Portal users. When nothing
is set in the URL during the playbook run,
this is the default playbook experience. If
nothing is specified here, defaults to the
Global Playbook Experience.

Open Record Modal Prevent URL Update on  Prevents the URL of a running playbook in

Submit Service Portal from updating whenever a new
record is submitted from a form in a record
modal.

Trouble?

Verify that you are using the official Playbook Widget for the Portal Page.

Run a playbook in Service Portal
Launch a playbook as a Service Portal requestor.

Before you begin
Role required: snc_internal or snc_external

About this task
Keep track of where you're at in an overall process more easily, and pause and resume the
playbook as needed.

Procedure
1. Navigate to your Service Portal instance.

2. In the home screen, search for the playbook and select it.
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servicenow.

How can we help?

How can we help? n

How can we help?

Request Something Knowledge Base Get Help
Browse the catalog for services and items you need Browse and search for articles, rate or submit Contact support to make a request, or report a
feedback problem
Current Status My Assessments and Surveys My Approvals
No assessments or surveys for you at the moment You have no pending approvals
I No system is reporting an issue
Announcements My Open Incidents
More information.
Employee Center is available to you V. Employee payroll application server is down.

INC0007001 - a day ago
Top Rated Articles

Rain is leaking on main DNS Server
Getting Around in Windows NC0000016 + a day ago

£ 2422 4

JavaScript error on hiring page of corporate website

INC0000040 - 2 day ago
Can't launch 64-bit Windows 7 virtual machine

The playbook launches.

3. Optional:
In the URL, you can apply the following properties to your playbook.

( localhost:8080/sp?id=playbook&table=incident&sys_id=-1&playbookExperienceld=98e09a560f2200102920c912d4767e1a

Property Description Example

layoutType Set the playbook to a custom layoutType=custom
layout. If not specified,
defaults to the default
(standalone) layout.

table Enter the parent table that table=incident
the playbook opens on. If
not specified, defaults to the
Incident table.

sys_id Enter the parent Sys ID of the  sys_id=-1
record you want to open in
the record generator table.
If you want to use the record
generator, leave it as 1. If
you leave it as -1, the value
changes once the record is
generated.

playbookExperienceid Enter the playbook playbookExperienceid=9809a560f220010292
experience record ID with
the playbook configurations
that you want for your
Service Portal users. If not
specified, defaults to the
Global Playbook Experience,
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Property Description Example

which has a record ID of
9809a560f2200102920c912d4767e1a.

4, As you go through the playbook, you can open records and lists in a modal without needing to
leave Service Portal, such as when you view a Knowledge Base article or a user record via the
information icon.

servicenow - (5]
 Assign > # Create > & Review and Update \g
Activities ~
© In Progress ® Priority
© Automated Interaction child record ... What are phishing scams and how can | avoid them?
© Show Knowledge Article Q Assigned to Abel Tuter

Phishing explained Phishing Explained Phishing scams are typically fraudulent email messages appearing to come from
legitimate enterprises (e.g., your company, your Internet service provider, your bank). These messages usually direct.

Updated 2022-12-05 20:46:33 - 90 views

Mark Complete [Skip

Trouble?

Errors

Error Description

404: The page you are looking for could not be The table or sysld is missing from the URL or
found the URL is incorrect.

Configuration Error The process cannot be found by the playbook.
For example the table is interaction, but the
Sys ID does not exists for this table.

There are not playbooks available There is a valid record for the table, but the
record does not satisfy the conditions to show
the playbook. For example an interaction
record might need to be of type Chat and start
with the short description of PLAYBOOK: to
kick off a playbook.

No Activities Available Here are not activities to view for this particular
stage of playbook. Activities can be hidden
based on user role or Run Conditions from the
process.
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Errors (continued)

No filtered results

Description

When using the playbook filter, no results can
be shown for a particular stage.

For client-side issues, check local browser console.logs which might show a runtime issue using

the browser's inspector.

Configure a playbook for ServiceNow

Configuring a playbook for ServiceNow

Before you begin
Role required: admin

Procedure

®

®

mobile

mobile is exactly the same as in a configurable
workspace, but with an additional step for embedding the playbook.

1. Navigate to All > Workspace Experience > Actions & Components > Related Items or

Contextual Side Panel.
2. Click New.
3. On the form, fill in the fields.

Action Assignment form

Field Description

Action label

Action name

Implemented as

Specify Ul component

Icon

Application

Workspace

Table

View

Active
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Label of the Related Item or Contextual Side
panel tab.

Unique name for your item. This name can be
overridden.

Select Ul Component.

Ul component associated with the action.
Enter now-playbook-experience.

Icon that is displayed in the Contextual side
panel to differentiate from other components.

@ Note: This field is available for the
Contextual Side Panel only.

Application for the action assignment.

Option to limit a Related Item or Contextual
Side Panel to a specific Workspace. For
example, Agent Workspace or HR Workspace.

Select the table you want to show the Related
Item or Contextual Side Panel on.

Field to only display a Playbook when this
Form View is selected on the parent record.

Option to activate the action assignment.

Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.
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Field Description

Order

Tooltip

Description

Integer that determines the precedence of
this action in relation to matching actions
with the same name. The lower the number,
the more likely it is to be selected against
other actions. The typical practice is to

use numbers that are in the hundreds. For
example, 100, 200, 300, or 400.

Message that's displayed when your mouse
points to the Related Item tab or Contextual
Side Panel icon.

Description for the action assignment.

This description is displayed in the Action
Assignment list and provides context on the
form.

4, Click the Advanced View related link.
5. Click the Component Attributes tab.
6. On the form, fill in the fields.

Component Attributes form

Attribute name

playbookExperienceld

parentSysld

parentTable

compactMode

recordGeneratorQuery

isNewParentRecord

Description

Associated Playbook experience ID.
Copy and paste the sys_id of a Playbook
Experience record.

@ Note: If no Playbook experience
ID is provided, the global Playbook
experience is used by default.

Associated parent sys_id. Enter{ {sysId}}
to automatically take the parentSysld of the
record that you're viewing.

Associated parent table. Enter { {table}}
to automatically take the parentSysld of the
record that you're viewing.

Option to display a Playbook in compact
mode. Typically set to true for Contextual Side
Panel and false for Related Item.

Not currently supported in Agent Workspace.

Setto { {isNewRecord}}.

() Note: Select a different Ul Component if the attributes are missing from your form.
Change the Ul Component back to now-playbook-experience and the attributes will

appear.

7. Select Update.
8. Click the Conditions tab.
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9. On the form, fill in the fields.

Conditions form

Field Description

Script Condition Script condition for the
action assignment. Enter
sn_playbook.PlaybookExperience.parentRecor!
The script condition enables you to show a
Playbook only when the record has triggered
a process execution.

Client Conditions Choose conditions to limit collisions based
on your use case.

Record Conditions Choose conditions to limit collisions based
on your use case.

Required Roles Roles to limit Playbook access.
Requires create access Option to require create access.
Requires read access Option to require read access.
Requires write access Option to require write access.
Requires delete access Option to require delete access.
10. Select Update.
Result

The playbook is configured for ServiceNow® mobile.

What to do next
Embed your playbook in ServiceNow® mobile. To learn more, see

®

Embed a playbook in ServiceNow ™~ mobile

Embed a playbook in ServiceNow® mobile by creating a screen in Mobile App Builder.

Before you begin
Role required: admin

If you haven't configured your playbook for ServiceNow®

playbook for ServiceNow mobile.

mobile in Ul Builder yet, see Configure a

Procedure
Create a playbook screen

1. Navigate to All > System Mobile > Mobile App Builder.

2. Search for and select the scope of the application that you want to create a screen for.

© 2026 ServiceNow, Inc. All rights reserved. 167
ServiceNow, the ServiceNow logo, Now, and other ServiceNow marks are trademarks and/or registered trademarks of ServiceNow, Inc., in the United States and/or other countries.
Other company names, product names, and logos may be trademarks of the respective companies with which they are associated.



servicenow.

Welcome to Mobile App Builder

Edit your in-app experience
Application scopes
Name
Al Search For Next Experience
Access Analyzer
Action Status
Active Directory
Admin Center
Adoption Blueprint for Technology Excellence
Advanced Work Assignment for CSM
Agent Assist Recommendation
Agent Workspace
App Engine Notifications

Application Common Configuration

3. Navigate to Screens.

[ Search application scopes

Q)

Short Description
Configuration Application For Al Search Next Experience

Portal for admins to analyze users access to resources

Central application to manage common admin tasks

Adoption Blueprint for Technology Excellence content p...

Created by

admin

admin

admin

admin

tectonic

admin

admin

admin

admin

admin

admin

Q) @

Menu O Screens
& Mobile app configs These are the foundation of a mobile app experience. Within a screen, you can use unique screen
A Mobile notifications capabilities to deliver different user experiences.
[Search
O Screens
Name & Type Updated on

@ Cards &icons
¥ Functions
€ Data

Q_ All mobile records

4. To create new screen, select New.

5. In the Create a screen modal, select Mobile Web.
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| 4

Create a screen

Select a screen type to start

Calendar

Input form

Map

Chart

Launcher

Mobile web

The form for a new mobile web screen appears.

Servicenaw Mobile App Builder

@ D New mobile web

Mobile web screen
Now Platform configuration

| New mobile web A A

Mobile web screen

MOBILE WEB SCREEN @

0 New mobile web

A mobile web screen opens a URL within the mobile app experience. You
can use a URL that goes to somewhere in your ServiceNow instance (like a
knowledge article) or to a page outside of your instance.

Properties

Name *
[ New mobile web )|

Description

Icon
If you intend to use this screen in a legacy icon section, you should populate an icon.

Name Application scope

Screen Settings

Fetch type
(prefetch ~)

URL %

( )

A URL s required.

(D Hide screen name

(I Check Access Control List (ACL)

6. Give your mobile web screen a name and description.

7. Choose an icon for your mobile web screen.

8. Under Screen Settings, enter the URL of your mobile playbook.
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Custom map

List

Record

% AgentWorkspace  ( @What'snew | ( @ Help

Mobile interface preview

This is how a browser screen appears in the mobile app experience. It

will show whichever website you connect to it.

{Back New web screen =z e
@

servicenow. Q

The simplicity your company
craves

Digital workflows optimize how things get
‘done for any business, from Wonko's
Chocolate Factory to yours.
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Properties
Name *

Playbook Mobile

Description
£
lcon
MName Application scope
MS icon-Mail-Solid Meabile Card Builder O

Screen Settings

Fetch type
Prefetch -

URL
/now/playbook/layouts/params/table/inc

(> Hide screen name

© Important: The web_controller_spinner=on parameter is important to include for
proper loading behavior on mobile.

Example
/now/playbook-mobile/playbook/interaction/-1/params/view/stages?
web_controller_spinner=on

9. Optional: If you have any roles you want to limit this screen to, or any other configurations you
would like to learn more about, see Configure a mobile web screen &.

10. Save the screen.
Your mobile web screen is configured for your playbook.

Configure the Mobile Agent

11. Navigate back to the scope level by selecting the home icon (@).

12, Select Mobile app configs.
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